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INTRODUCTION – SEAGATE CRYSTAL REPORTS 8 

The key design goal for Seagate Crystal Reports 8 is to make it easy to use and make it accessible to many users simultaneously. 
This document describes the major features that have been added to Seagate Crystal Reports 8. The first section, “New Features in a Glance”, is an outline of the major features from the end user’s benefits point of view. The second section is a detailed description of each of the features, categorized by component within Seagate Crystal Reports. Following is a Developers’ Tools section that describes the enhancements in the Report Integration Controls for Visual InterDev, the Crystal Report Print Engine API and the Report Designer Component. 

There are two appendices: Appendix A is on the Formula Language of Seagate Crystal Reports 8, which includes a comparison between the new Basic syntax and the Crystal syntax, and a detailed description of the new functions, operators and control structures added to the Formula Language. Appendix B is a detailed description of the changes and enhancements in the Crystal Report Print Engine API.

Legal Notices & Disclaimer

Microsoft, Visual InterDev, ActiveX, Windows, Windows NT, Office 2000, Windows 2000 and Visual Basic are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

Java is either a registered trademark or trademark of Sun Microsystems Inc. in the United States and/or other countries.

Adobe and Acrobat are trademarks of Adobe Systems Incorporated.

Netscape is a registered trademark of Netscape Communications Corporation in the United States and other countries.

NEW FEATURES AT A GLANCE

The following outlines the major features of Seagate Crystal Reports 8:

Significant Performance Improvement

This release of Seagate Crystal Reports has the capacity to handle larger data sets much more efficiently. You will notice major improvements to report performance in all areas of processing – from opening and refreshing to formatting and saving your reports. 

For example, opening reports with saved data is significantly faster; you can begin viewing the first page of a report even before the entire report has been loaded. Other areas such as formatting (e.g., when going to the last page), refreshing and saving reports are also faster. This is attributed by more efficient SQL expressions, less redundant data returned from the database server, and data decompression. 

With a new file format in Seagate Crystal Reports 8, report files and temporary files are now much lighter weight. For backward compatibility, you may also choose to save a report in version 7 format.

Enhanced Web-based Reporting

This version of Seagate Crystal Reports enhances its reporting capability on the Web. A few of these enhancements include:

Real-time Reporting

Viewing reports on the Web emphasizes performance in real time. Multithreading in the Crystal Report Viewer for ActiveX, for instance, improves response time when viewing large reports.

Improved Printing

With the new Netscape® plugin for Microsoft ActiveX®, you can now use the Crystal Report Viewer for ActiveX on a Netscape browser and achieve close to WYSIWYG quality when printing.

Report Integration Controls

The Report Integration Controls for Microsoft® Visual InterDev® 6.0 is a major overhaul from its predecessor Design Time Control for Visual InterDev. You can now develop Web applications that host Crystal reports and allow end-users to view, print and export these reports in a Crystal Report Viewer for Java™ or ActiveX.

Web Folders

If you are running Microsoft Windows® 9x or Windows NT® with Microsoft Office 2000®, or if you are running Windows 2000®, you may store, open, update and save reports directly to a Web Folder on a Web server. You no longer have to download reports, edit them locally and upload them to the Web server. 

Boosted Reporting Power

Reporting capability has been boosted with measures included below:

Formula Language Augmentation

The Formula Language has been augmented with a new syntax, Basic syntax, which is a Microsoft Visual Basic® Script-like language. If you are new to Seagate Crystal Reports and are familiar with Visual Basic, you will find this new syntax very easy to learn. If you have been using Crystal syntax, you will also be able to benefit from the many useful new functions, operators and control structures that have been added to both Crystal and Basic syntaxes.

OLAP and Cross-tab Enhancements

Creating and formatting OLAP grids and cross-tabs is more robust with conditional formatting and grouping with page dimensions, and is easier with the addition of new grid formatting options and sample grid styles that you can apply as templates.

Charting and Mapping

Enhancements have been applied to both charts and maps. You may now create charts and maps based on running totals and OLAP grids. Charts and maps are easier to read with detailed tool tips.

In addition, there are chart-formatting options to show amounts in chart legends, and to move and re-size various chart items. You may also chart on all records, zoom in bar and line charts, and drill down in chart legends.

Maps are now easier to use since there are a new Map Navigator to show relative location, and non-polygon maps that show points (e.g., cities) with graduated symbols.  You can now resolve differences in geographical names between a map and the data, and can map on specified order grouping and running totals. Maps are loaded faster than before too.

Access and Excel Add-in’s

Using the Access Add-in and Excel Add-in, you may now create reports from an Access database and Excel worksheet respectively, and when the data is changed, you can refresh the reports and have them updated.

Hierarchical Grouping

You may now use hierarchical grouping to arrange data in a report to show hierarchical relationships in your data. In essence, you still have all the elements in the hierarchy in the same table, but the relationships in the hierarchy are now also displayed. This is useful, for instance, in reporting off a Human Resources database to show the hierarchy within a company.

Subreports

Various enhancements to subreport linking have made subreports more versatile. You may now create in a report a hyperlink to another Crystal report, which is essentially an on-demand subreport. Data refresh for an on-demand subreport is efficiently managed such that data is only retrieved from the server on drilling down of the subreport.  

Other improvements include that when you create a subreport, you can specify it as an on-demand subreport. You also have the option to update a subreport upon loading of the main report. This will be convenient when the same report is inserted as a subreport in a number of different reports, as any changes to the former can be reflected in each of the latter upon loading of the corresponding main report.

Export

You may now export a report to Adobe™ Acrobat™ Portable Document Format (PDF).

Support for RTF and HTML Data

You may now include RTF or HTML data in string or memo fields in your reports, and these fields will be interpreted and displayed appropriately with respect to specifications for the font, size, style, color and paragraph. 

UI & Usability Enhancements

There are a number of features that improve immensely the usability of the Crystal Report Designer. Among them is a range of features that support formatting text for the international market. 

The more prominent new features are outlined below.

International Formatting

This set of enhancements applies to all languages supported by Seagate Crystal Reports including English, but is in particular geared toward the Japanese market. You may now format text vertically, use fractional point font size, use different fonts conditionally, indent lines, control line and character spacing, format dates in a way typical to Japanese, and insert new shapes into reports conventionally used in Japanese for specific purposes.

Accounting Conventions

You now have an option to format number and currency fields using common accounting conventions, regarding the display of the negative symbol, currency symbol, zero value and reversing the sign of numbers (for debits and credits).

Data Explorer

When you create a report or do a set location, you now use the new Data Explorer to manage your database connections. The Data Explorer provides an integrated tree view of all data sources available to you. 

Within the Data Explorer, there are also Current Connections, Favorite and History data sources that make connecting to a commonly used data source more convenient.

Field Explorer

The new Field Explorer provides a unified interface to insert, modify and delete all types of fields (including database, formula, SQL expression, parameter, group name, special and running total fields) in a report. In particular for database fields, it provides a clear tree view of displaying tables and database fields that are available to the report.

Displaying Names of Tables and Database Fields

You may now display table names alphabetically by name, description or both. You may also choose to display database fields alphabetically.

Select Distinct and Browse Distinct

You now have an option to select only unique records from a table, and browse a larger set of unique records as well.

Group Name Formula

You may now choose to use a database field or a Group Name Formula to name a group. This name should be able to better identify a grouping and will appear in the group tree and in the group header. 

Opening and Saving Reports to Personalized Folders

You may now open and save reports to the Desktop and personalized folders that your operating system supports: History, Personal, Favorites and Web folders.

Displaying Preview and Properties on File Open

When opening a report, you may now have the option to preview the first page of a report and view its properties in the file open dialog box.

Autosaving Reports

You now have an option to have your report saved automatically after a specified interval of time.

More Image Formats

More types of formats are supported for blob fields, including JPEG, PNG and TIFF.

String Search

In both the Design and Preview Tabs, you may now search for strings in text objects, field objects, subreports, cross-tabs and OLAP grids.

Selecting and Formatting Multiple Objects

You may now select more than one object at a time and carry out operations like move, align, size, cut, copy and paste. (Some conditions apply. Please see section “Selecting Multiple Objects” below for more details.)

Developers’ Tools

Developers’ tools such as the Report Integration Controls for Visual InterDev, Report Designer Component and Crystal Report Print Engine API have been enhanced to complement upgrades to the Crystal Report Designer. 

In addition, there are new features to the Report Designer Component that include: 

· unbound fields that are inserted into a report at design time and bound to a database field at runtime, thus allowing more customization at runtime,

· ability to create a report based on a command in a Microsoft Visual Basic Data Environment, and

· report variables that can manage the status of a field that changes upon repeated firing of certain events.

Detailed Description

The following section describes the new features in detail, categorized by component. 

REAL-TIME REPORTING

Real-time reporting allows you to process and view reports immediately. This is particularly important in Web scenarios. To be able to load the first page of a report quickly, improvements have been made in record processing, page generation and report loading. 

Record Processing

More record processing and grouping is offloaded to the server. These measures reduce the time and the volume of selected data to return from the server.

There is support for the SQL clause, SELECT DISTINCT, that allows you to select unique records from a database more efficiently. For more information on SELECT DISTINCT, please refer to the section “SQL Databases” below.

Page Generation

Most reports with summaries, charts, maps and OLAP grids are now generated with one pass of all the records. Opening reports with large group trees, images or high total page counts is also significantly faster.

Ad-hoc changes such as formatting text, editing group tree, re-selecting and re-sorting records can be completed more quickly.

Report Loading

Several measures have been implemented to speed up report loading, including loading and decompressing records in batches, and loading drivers on-demand. Consequently, a user can begin viewing as soon as that portion of the data has been loaded

VERSION 7 COMPATIBILITY

As the format of saved data has been changed in Seagate Crystal Reports 8, you now have the option to keep Version 7 reports with data in Version 7 format, or save them in the current Seagate Crystal Reports 8 format. You can also export reports to Version 7 format.

Save As Crystal Reports 7 Format

Saving report in Crystal Reports 7 format is accessible via the File | Save As… menu item. The Save As dialog box provides choices of saving a report as “Crystal Reports” format (i.e., current Seagate Crystal Reports 8 format), or “Crystal Reports (version 7.0)” format.

[image: image162.png]sovers [ 23 Gereratumness EEEEE

ceount Statement ot T Procuct Cataog ot
alrce Sheet ot 5ales With Geographic Map it
ustome Profie.pt Sales With DnDemand Sub 1ot
Sales With DnDemand Sub21pt
World Sales Repat ot

Employes Frofie.pt
mployes Sales pt

inancial Statemenpt
came Statement ot
wentory CiossTab.pt
wenton it

aiing Labelpt

der Packing Listipt

Fiename:  [Balance Sheetint

o T |





Note that when you save a Version 8 report in Version 7 format, or when you modify and save a report of any other version in Version 7 format, features that are not available in Version 7 will no longer be supported.

Export to Crystal Reports 7 Format

You now have an option to export a report to Crystal Reports 7 format. 
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Note that this export option is only available when exporting from the main report. It is not available when exporting from a subreport.

To be consistent with this change in the Crystal Report Designer, the Report Designer Component and the Crystal Report Print Engine (CRPE) API have also been enhanced to support saving a report in and exporting a report to Crystal Reports 7 format. Please refer to the corresponding sections below for more information.

Text Object Formatting Compatibility

In Seagate Crystal Reports 5, 6 and 7, text objects were not displayed or printed with the exact font size that the user had specified, but instead, with a smaller font size. The situation has been improved significantly in this release: text objects are displayed and printed with the exact font size that the user has specified, and are WYSIWYG. 

However, depending on how a report has been formatted, comparing a report being run on earlier versions of Seagate Crystal Reports and on the current release, it may appear different, with respect to line breaks and spacing within text objects. All this is because the font size used to display and print text objects is now exact and different from that used in previous versions.

Nonetheless, in order to preserve in this release the line breaks and spacing in text objects of earlier reports as much as possible, there is now an option under Options | Reporting, named "7.0 Text Compatibility". 

[image: image2.png]Checkthis to formattext objects in earlier
reports with & compatible fot

NewRepat |
Feparing

=]
DetaScace Dfauts

When eading data
Dateine ik
€ Convert to Sting
€ ConventoDae
Ko DateTime T2

™ Convert NULL Field Value o Defauit
™ COUNT Number of Records First

7. Save Data With Repott
I™ Discard Saved Data When Loading Repotts
©

Save Summaiiss With Report
¥ 2.0 Teit Compatabilty

™ Suppress Prnting i No Reecords Selected
T~ Show AllHeaders on Dil Down
I™ Autosave Reports Afer [§

¥ More Report Engine Eror Messages

Cystal Syritar ~] Formua Langusge

Minutes.

Datsbase |

Warn|f More Thar:[500

caws |

Fods | Fos |

[

Cancel Help





This option automatically adjusts the font size of text objects in reports created in version 5, 6 or 7 of Seagate Crystal Reports, to be compatible with that displayed under that earlier version, and at the same time, remaining WYSIWYG.

This option is checked by default. If a user turns this option off for a report created with version 5, 6 or 7, the user may notice that lines within a text object break earlier than in the earlier release, and spacing within the object may be upset. 

With the option checked, occasionally, lines within a text object may still break at a different location than in an earlier version, but the formatting will not be significantly altered and no text should be missed.

INTERNATIONAL FORMATTING SUPPORT

There are extensive enhancements to support formatting in foreign languages; special focus has been placed on the Japanese language.

Text Rotation

You can now use text rotation to format text vertically in a report.

Formatting with Text Rotation

You can now format string fields, memo fields and text objects with text rotation. 

In the Common tab of the Format Editor for a string field, memo field or a text object, you may rotate text by selecting from the Text Rotation drop down list:

· text rotation of 90 degrees: direction of text is bottom to top, left to right, and

· text rotation of 270 degrees: direction of text is top to bottom, right to left.

Note: 

· Text rotation of 0 degree implies horizontal formatting from left to right. 

· Also, when you choose to rotate text for an object, the Can Grow option is automatically disabled.

· As before, if text (in a string field, memo field or text object) that is formatted horizontally spans over the edge of the page, there is no wrapping applied to the text and the portion of the text of each line beyond the edge of the page will not be displayed. The same treatment is applied to rotating text. If the text when formatted horizontally spans more than one page lengthwise, and you change to rotate the text, a portion of the text that falls beyond the bottom edge of the page will not be displayed.

· You may not rotate text that is not formatted in a True Type font or printer font. Examples of such fonts are Modern, Roman and System. You may identify these fonts in the Font tab of the Format Editor; these fonts do not have a printer or a [image: image3.png]


 symbol displayed next to them.

Example 1: Select text rotation of 90 degrees
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Example 2: Select text rotation of 270 degrees
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Miscellaneous Support for Text Rotation

You may now export a report with text rotation to current Crystal Reports format and Crystal Reports 7.0 format. Rotated text can also be displayed in the Crystal Report Viewers for HTML, Java and ActiveX, and is supported in the CRPE API and the RDC. Please refer to corresponding sections below for further information.

Line Indentation

Previously, you were able to specify indentation for a paragraph in a text object. Now, this has been extended to allow you to control indentation for lines in string fields, memo fields and text objects. (Note: a line following a carriage return is the first line of a new paragraph.) The unit of measurement (i.e., inch or cm.) that is used depends on what you have specified through the Windows Control Panel.

Suppose you have selected through the Control Panel the U.S. measurement system.  First, you select the field or object, then select Format Text | Paragraph Formatting, which will display the new Paragraph Formatting tab of the Format Editor. There, you may specify a number of inches to:

· indent the first line of a paragraph, 

· left-indent every line in a paragraph, or 

· right-indent every line in a paragraph. 

Only indentation values within the width of the field or object are allowed. Note that you may apply indentation to all the paragraphs in an object by selecting the entire object, or to only the paragraph that the cursor is currently at.
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For example, if the width of a text object is 3 inches, and you specify for each paragraph in this text object:

· 0.5 inch for first line indent,

· 0.5 inch for left-indent, and

· 0.5 inch for right-indent, 

then,

· the first line of each paragraph will be indented 1 inch from the left, 0.5 inch from the right, with text occupying 1.5 inches, and

· all other lines in the same paragraph will be indented 0.5 inch from the left, 0.5 inch from the right, with text occupying 2.0 inches.

Line and Character Spacing

You can now control spacing between lines and spacing between characters for string fields, memo fields and text objects. 

This is particularly useful in the Japanese language since characters do not necessarily require the same spacing. You can now format Japanese characters in full width and in half width by specifying the font size and character spacing.

You can control spacing between lines in the new Paragraph Formatting tab of the Format Editor, by specifying it as a multiple of the font size:
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or as an exact number of points:
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You can control spacing between characters in the Font tab of the Format Editor, by specifying the value n each character “occupies”, n being defined as the distance in number of points measured from the beginning of one character to the next. Specifying n as 0 will format characters as they should be formatted depending on the font. Specifying  n as greater than zero will format each character to occupy a fixed width of n points. 

For example, if you specify a 12-point font to have a character spacing of 12, then each of the characters will remain as 12-point font, but occupies a space of 12 points wide.  As another example, specifying a 10-point font to have a character spacing of 5 points will cause the characters to overlap one another. Note that changing the character spacing does not change the size of the font; it only changes the spacing between two adjacent characters.
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Import for Text Objects

You may now import a text object from an existing file; this feature is particularly useful if you would like to insert text that has already been formatted.
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Interpreting  Data Pre-formatted in HTML & RTF 

You may now insert into a report a string or memo field that has data pre-formatted in Rich Text Format or HTML. The Crystal Report Designer will extract any information about the font, size, style, color and paragraph and display the data with the specified attributes.

First, select a string or a memo field that contains data formatted as HTML or RTF. Then, select Format | Paragraph Formatting, which will display the new Paragraph Formatting tab of the Format Editor.  Under “Text interpretation”, you may select:

· “none” to interpret the string or memo field as if it contains plain text,

· “RTF Text” to interpret the string or memo field as if it contains Rich Text Format data, and

· “HTML Text” to interpret the string or memo field as if it contains HTML data.
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Conditional Fonts

You may now change the font, style and size of a string field or memo field based on a condition, e.g., the value of a parameter, or the value of some field. This facilitates displaying flexibly fonts of different languages on the same report. 

You may specify such conditions when you right-click on a string or memo field, select Change Font and click the formula button to the right of each of the properties font, style or size.
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New Shapes

You may now insert boxes with rounded corners into your report. By sizing and formatting a box, you can shape it into an ellipse or a circle. This can be applied to all languages that Seagate Crystal Reports support, and is particularly useful when formatting forms in Japanese, which often use these shapes (e.g., circles for signatures).

You may insert one of these new shapes by these steps:

Step 1: Insert a box into your report.

Step 2: Right-click on the box and select “Format Box…” from the shortcut menu.

Step 3: In the Rounding tab of the Format Editor, you can adjust with the slider the degree of roundedness for the corners of the box. By adjusting so and sizing the shape appropriately, you can in fact convert a box into an ellipse or a circle.
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Fractional Point Font Support

You may now specify a fractional point size for a database field or a text object, including the 10.5 point font which is commonly used in Japanese:

Step 1: Select a database field or a text object.

Step 2: Invoke the Format Editor, by either selecting Format | Font…, or right-clicking and selecting Change Font…

Step 3: Type in the desired fractional point to change the size of a scalable font.
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In particular, if Japanese is the default language for your machine, the 10.5 point font is the default font and is now available for selection in the drop down list of fonts.

Note that currently, you may not specify a fractional point size for all reports in general through File | Options | Fonts tab. You may only do so when formatting individual text objects or database fields.

Date Formatting for Japanese

There are special enhancements to support date and date-time formatting typical to the Japanese language. 

Day of the Week

Typically, in Japanese, the day of the week in a date or date-time field is enclosed by parentheses or square brackets. For example, you may now format a date value of “Sunday, May 3, 1998” to be displayed as “(Sunday), May 3, 1998”.

To format the day of the week with enclosures:

Step 1: Right-click on a date or date-time field and choose Format Field from the shortcut menu.

Step 2: In the new Date / Time tab of the Format Editor, select Customize. Note that you may change the style of your date format in this tab. For example, if your current date format does not display the day of the week, you can change it by selecting a style that does. Then select Customize. This will invoke the Custom Style dialog box.

[image: image15.png]Conmon| Boder] Fert Dt/ T | Hyperink |

Syle

s o S ey
31

370

37179

03701/ 1399

1-Mar

1-Mar 99

1 - Mar - 1339

01 - Mar- 1999

01 -March - 1993

Mar99

March 1339
March 01, 1399
[Wednesday, March 1, 1399
Wednesday, 1 March, 1393
3

399

Cuorizs

Sample:
Manday, March 01, 1999

[

Cancel

Help

Click this buttonto custorrize formating
for & date or date-time field




Step 3: In the custom Style dialog box, select the Date tab.

If you are using the English version of Seagate Crystal Reports 8, you will have the choices of no enclosures, the round brackets (i.e., parentheses), and the square brackets.
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If you run the Japanese version of Seagate Crystal Reports 8 on a Japanese platform, you will have the choices of:

· no enclosures,

· half width round brackets,

· half width square brackets,

· full width round brackets, and

· full width square brackets,

to enclose the day of the week in a date or date-time field.

Short and Long Eras

If you run the Japanese version of Seagate Crystal Reports 8 on a Japanese platform that supports the display of the era, and you specify the Japanese calendar, you can now display the era in either the long or the short format.

Step 1: Right-click on a date or date-time field and choose Format Field from the shortcut menu.

Step 2: In the new Date / Time tab of the Format Editor, select Customize. Note that you may change the style of your date format in this tab. For example, if your current date format does not display the era, you can change it by selecting a style that does. Then select Customize to further format the era. This will invoke the Custom Style dialog box.

Step 3: In the Custom Style dialog box, select the Date tab. Select the era / period type: short, long or none. 
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USER INTERFACE ENHANCEMENTS

The user interface of various components has been enhanced to improve ease of use.

Welcome Dialog Box

The Welcome dialog box has been enhanced with a new look. 
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In addition to creating a report with the Report Expert and opening an existing report by browsing your entire hard disk and network, you may:

· create a new report with a blank report – clicking on “Blank Report” will immediately invoke the Data Explorer. You may then select a data source, and / or proceed to insert fields. (Note: this option is similar to creating a custom report in Seagate Crystal reports 7);

· open an existing report by conveniently browsing your Desktop, History folder, Personal folder, Favorites folder or Web folders. (See section “Open & Save to Personalized Folders" below.) 

· open an existing report by selecting from a list of recently opened reports. Up to 9 reports are displayed.

New Report Gallery

Upon selecting from the File menu or the “New” icon to create a new report, you will invoke an improved Seagate Crystal Report Gallery. This Report Gallery allows you to create a new report with a Report Expert or by starting with a blank report. If you choose to use a particular Report Expert, the Report Gallery will display a sample image (together with a short description) of the type of report that the chosen Expert will help you create.
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Creating Reports with the Data Explorer

When creating a report, the various Report Experts now use the new Data Explorer that provides an integrated tree view of all data sources. With the Data Explorer, you may:

· create a report using one of the currently connected data sources,

· create a report based on a customized “Favorites” list of data sources (which you also maintain within the Data Explorer),

· create a report based on recently accessed “History” list of data sources (which the Data Explorer automatically maintains for you),

· create a report by connecting to an existing data source (e.g., data file residing locally, ODBC data source that has already been set up, Crystal dictionary, Crystal SQL query), or

· create a report by first creating a new connection (e.g., new ODBC data source, OLE DB File Data Link).

Tree View

When you start any one of the following Report Experts: Standard, Form Letter, Form, Cross-tab, Subreport, Mail Label, and Drill Down, and click the Database button in the Data tab, you will invoke the new Data Explorer. For example:
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The Data Explorer displays a tree view showing:

· Current Connections – data sources that you are currently connected to.

· Favorites - data sources that are commonly used and you have maintained in your Favorites list of data sources. By placing them in the same folder, you can easily connect to any one of them by clicking on it in this folder. You can add a data source to the Favorites folder by right-clicking on a data source and selecting “Add to Favorites”. You can also select a data source and click the “Add Favorite” button on the Data Explorer. You can also rename or delete a data source in this folder by right-clicking on it and selecting the respective command from the shortcut menu. 

· History - data sources that have been recently accessed from the Crystal Report Designer; up to the last 5 data sources connected will be displayed. You can connect to a data source in this folder by clicking on it.

· ODBC data sources,

· File Data Sources - data sources for standard PC databases residing locally, 

· More Data Sources - data sources accessed through OLE DB and native drivers, and

· Crystal Dictionary and SQL Query files.
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ODBC Data Sources

In the Data Explorer, you will find the tree view showing the ODBC data sources that you have already set up. These data sources include:

· User Data Sources (i.e., User DSN’s) that have been previously set up, are specific to this machine and visible only to you,

· System Data Sources (i.e., System DSN’s) that have been previously set up, are specific to this machine and visible to any one logging onto this machine, and

· File Data Sources (i.e., File DSN’s) that are file-based data sources previously set up, and are shareable among all users with access to the same database. Only File DSN’s that are located in the default directory are displayed here. 

Note: you may set the default directory of a File DSN through the Microsoft ODBC Administrator.

The options that you have with the ODBC sub-tree are:

· Create New Data Source: clicking on this option allows you to create a User DSN or a System DSN (that have always been supported in Seagate Crystal Reports 7), or a File DSN that is newly added to this release. After you have created an ODBC data source, it will appear under the ODBC sub-tree, unless it is a File DSN that is located outside the default directory.

· Connect Using File Data Source: clicking on this option allows you to connect to a File DSN that is located outside the default directory. Here, you specify the location of the File DSN you would like to connect to.

· Connect: clicking on a data source in the ODBC sub-tree allows you to connect to it. (Data sources in this sub-tree have been set up through “Create New Data Source”, except for File DSN’s that are located outside the default directory.) 
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When you connect to an ODBC data source, depending on the setup for the server, you may be required to log on (i.e., if you have Trusted Connection set up for a SQL Server, you can bypass logging on). You may then select from the sub-tree tables and / or stored procedures to add to your report.
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OLE DB Data Sources

In the Data Explorer, you will find two options under OLE DB:

· Make New Connection: this option allows you to create a Data Link (i.e., an OLE DB data source using non-file-based Data Link) to the data you want to connect to, via the Data Link Properties dialog box. For further information on creating a Data Link, you can refer to the online help provided for this dialog box.

· Connect Using Data Link File: this option allows you to connect to an existing Data Link File (i.e., an OLE DB data source using file-based Data Link), or to create a new Data Link File, via the Select Data Link File dialog box. Further information is provided on this dialog box.

Other Data Sources

For any other type of data sources, initially you may click on it in the tree view to make a connection. For subsequent connections, you may select Make New Connection in the same sub-tree.

Shortcut Menu

You may right-click on any item in the Data Explorer tree structure to bring up a shortcut menu with the following options: 

· Add to Report – to add a table or stored procedure to your new report. This option is enabled when you right-click on a table or stored procedure.

· Add to Favorites – to add a selected data source to the Favorites folder. This option is enabled when you right-click on a data source.

· Remove from Report– to remove a table or stored procedure from the report. This option is enabled when you right-click on a table or stored procedure.

· Properties – to obtain detailed information on the selected item. This option is enabled when you right-click on a data source, a table or a stored procedure.

· Rename Favorite – to rename a data source in the Favorites folder. This option is enabled when you right-click on a data source in the Favorites folder.

· Delete Favorite – to remove a data source from the Favorites folder. This option is enabled when you right-click on a data source in the Favorites folder.

For example, if you right-click on a table, you will find:
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After adding the desired tables or stored procedures, you may proceed with the Fields tab of the Report Expert to insert fields to your new report.

Options

The Options button of the Data Explorer provides access to the same options that you can set globally through the Database tab of the Options menu. 

Open & Save to Personalized Folders

The file open, save and save as dialog boxes have been enhanced such that you may now choose to open (or save) a report by conveniently browsing the Desktop, and the personalized folders of History, Personal, Favorites and Web folders as set up by your operating system. 

If for any reason you do not have one of these folders set up on your machine, the corresponding button will not be displayed as an option. 
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Desktop

When you click Desktop, you will see the contents of folders on your Desktop, e.g., My Briefcase. You may then open a report from or save a report to the Desktop.

History, Personal & Favorites Folders

When you click the History, Personal or Favorite buttons, you will see the contents of specific folders that have been set up by your operating system. For instance, if you are running Windows NT, these folders will be set up under \WINNT\PROFILES\User name, where User name is the NT logon user name. Then, depending on the folder your are requesting:

· If you click History, typically you will see the contents of the folder Recent, which holds most recently accessed files.

· If you click Personal, typically you will see the folders History and My Pictures. 

· If you click Favorites, typically you will see the contents of the folder Favorites.

You may then open a report or save a report to the corresponding folder.

Web Folders

Web Folders are repositories on a Web server. You can place reports in a Web Folder, access them and modify them directly without first having to download them to your local machine as before.

If you are running Windows 95, 98 or NT 4 and you have installed Office 2000, or if you are running Windows 2000, you can start by first adding a Web Folder through the Windows Explorer. You will be prompted for the URL for the folder on a Web server. After setting up the Web Folder, you may now access reports in that Web Folder, and save them back to the Web Folder.

Displaying Preview on Opening Report

There is now an option to save a snapshot of the first page of a report for previewing in the file open dialog box.

Saving Snapshot as Preview

You have an option to save the first page of a report so that you can preview when opening a report. To save a preview for a report:

Step 1: Create or open a report.

Step 2: Select File | Summary Info… This invokes the Document Properties dialog box.

Step 3: In the Summary tab of the Document Properties dialog box, check Save Preview Picture. This enables previewing of the first page when opening the report subsequently. 
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Step 4: Preview the report.

Step 5: Save the report.

Please note the following when using this feature:

· For security reasons, this feature is defaulted to be off for new and existing reports. If there is information on the first page of the report that you regard as confidential, you may not want to enable this feature.

· You must preview the report before a snapshot can be taken. 

· The snapshot is only updated when you preview. This means initially, if you turn on the feature in the Design Tab, but do not preview, no snapshot will be taken, and you will not be able to see any preview. Also, if you modify the report in the Design Tab (e.g., change the font color), save the report but do not preview, then the snapshot will not be updated.

· The snapshot is then saved when you save the report.

· Because the preview is saved in the report file as part of the summary information, this feature is supported in Version 8 reports, but not in any version earlier. This means, if you open a Version 7 report in Version 8, but do not convert it to Version 8 format when saving the report, you will not be able to save a preview of it.

· As the preview is saved in the report file, this may increase the size of the file significantly.

Preview in File Open Dialog Box

The Open dialog box has been enhanced to display a snapshot of the first page of a report. 

Step 1: Click on the Preview button.

Step 2: Click on a report in this dialog box. 

Step 3: If the report is preview-enabled, you will see its snapshot. 
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Displaying Properties on Opening Report

In previous versions of Seagate Crystal Reports, you have been able to enter summary information by selecting File | Summary Info… Now you can display summary information in the file open dialog box. 

Step 1: Click on the Properties button.

Step 2: Click on a report in this dialog box.

Step 3: If the report contains summary information, you will see it in the right pane.
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Tool Bars

All four toolbars (i.e., the Standard toolbar, Formatting toolbar, Analyzer toolbar and Supplementary toolbar) in the Application Window now have an updated “flattened” look.

The Open, Undo and Redo buttons now have drop-down arrows:

· Clicking the drop-down arrow for Open shows the most recently opened reports (up to 9 reports).

· Clicking the drop-down arrow for Undo or Redo shows a list of actions that you have done to the current report. 

Initially, the list shows all the actions that can be undone to the current report. You may select more than one action at once to undo or redo. As you move the cursor up or down the list, you can select and then click to undo the most recent n actions. There is virtually no limit to the number of actions that you can undo or redo to the same report.
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Group Name Formula

Previously, the group tree and the group header always displayed the values of the group field as the group name. (In other words, the group name field always had the same values as the group field.) Now, to better describe a group, you may use either:

· a database field (which can be the group field or a different field), or

· a Group Name Formula returning a string value,

to generate values for a group name field.
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You may specify values for a group name when you insert a group (in the Insert Group dialog box) or when you modify an existing group (in the Change Group Options dialog box). Both dialog boxes display the same Common tab.

Step 1: In the Common tab of the Insert Group dialog box (or the Change Group Options dialog box), click “Customize Group Name Field”.

[image: image32.png]Insert Group

o |

When the report s pinted, the records.
willbe sored and grouped by:

The secton wilbe pinted on any change
of Customer CustomerlD

|- Group Opions.

I~ Custonize Group Name Field
) Ghoose From Existin el

= Drders 0rdeilD E

S E i |
I~ Keep Group Together
I~ Repeat Gioup Headsr On Each Page

Cance

By default the group name field has the same
values s the group field. These values are
displayed in the group tree and in each group
header. Atematively. you may check this aption
to specity differentvalues for the group narme
field




Step 2: Click “Choose From Existing Field” to use the values of an appropriate database field as the group name.
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For example, you can group on the Customer ID, but display the Customer Name as the group name.
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Step 3: Or, you may click “Use a Formula as Group Name” to specify a Group Name Formula that will return string values as the group name.
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For example, you can group on the Customer ID, and use the following Group Name Formula:

ToText ({Customer.CustomerID}) + " : " + {Customer.CustomerName}

to display both the Customer ID and Customer Name as the group name.
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Note that you may not include a field that is evaluated at runtime, such as a running total field, summary field or another group name field, in a Group Name Formula.

Displaying Tables by Name or Description

Previously, you had the option to display database fields by name, description or both. Now you have the additional option to display tables by name, description or both as well. You can set these options in the Database tab of the Options menu.
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The default option is to display fields and tables by name only.

Displaying Tables & Database Fields Alphabetically

Previously, tables were always displayed in the order that they had been inserted into the database, and database fields were always displayed in the same order as they existed in the physical table (e.g., in the Visual Linking Expert, in the Database tab of the Insert Fields dialog box).

Now, you have the option to display tables and fields in the same order as they exist in the database, or in an alphabetically ascending order. You can check this option by selecting the Options menu, Database tab, and checking “Sort Tables Alphabetically” or “Sort Fields Alphabetically” as appropriate. 

The option “Sort Tables Alphabetically” is selected by default.
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Field Explorer

You may now insert, modify or delete fields in the Design and Preview Tabs through the new Field Explorer. You invoke the Field Explorer when you select from the Insert menu to insert a database field, formula field, SQL expression field, parameter field, special field or running total field.

Tree View

Unlike the previous Insert Fields dialog box, the Field Explorer provides a tree view of database fields and special fields that you may add to your report, and formula fields, SQL expression fields, parameter fields, group name fields and running total fields that you have defined for your report. 

Fields that have been added to the report or that have been used by other fields (such as formula fields, groups, running total fields, summaries, etc) in the report will have a green check mark adjacent to them.
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Toolbar and Shortcut Menu

There is a toolbar that provides tool tips with hot-keys for each icon. You may right-click on any item in the tree view to bring up a shortcut menu. The toolbar and the shortcut menu offer these functions: 

· Insert to Report– to add a field to the report. This option is enabled when you right-click on any field displayed in the tree view. You may insert more than one field at once by selecting multiple fields (hold the Shift key while selecting more than one field), right-click, and choose Insert. 

Alternatively, to insert a single or multiple fields, you may also drag and drop the field or fields at once into the Design or Preview Tab.

· Browse Data – to browse data for a database field or formula field. This option is enabled when you right-click on a one of these fields.

For example, you can right-click on a database field. The shortcut menu will have Insert to Report and Browse Data enabled.

[image: image40.png]&) Field Explorer

NS A

5 @ Database Filds = 1. Rightclick on a
& (B Customer | database field
= Customer Cr | [nset o Fepart Erier | 2 oumay browse its data, o
3 Customer e Biowse Data civg insertitinto the report

5 Contact First

= ContactLas| | Lo/ G
= Contact Tl 1" Cilre
= Contact Pos | EETETE: £z
a LastYears §_ D2P2 ou
= Ackdesst

Hove Pasmetzlln Al
= Address? Uy o

Hoye Perameter Doy A0

2 HP CancelMenu





· New – to create a formula field, SQL expression field, parameter field or running total field. This option is enabled when you right-click on any of these fields.

· Edit - to modify an existing formula field, SQL expression field, parameter field or running total field. This option is enabled when you right-click on any of these fields.

· Rename – to modify the name of an existing formula field, SQL expression field, parameter field or running total field. This option is enabled when you right-click on any of these fields. 

Alternatively, you may modify a field name in-place by double-clicking it.

· Delete – to remove a formula field, SQL expression field, parameter field or running total field. This option is enabled when you right-click on any of these fields. You may also select multiple fields, right-click and choose Delete to remove them all at once from the report.

· Move Parameter Up (or Down) – to change the order of parameter fields on prompting. This option is enabled when you right-click on a parameter field.

For example, when you right-click on a parameter field, all the functions, except Browse Data, are enabled.
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Group Name Fields

You may insert an existing group name field displayed in the Field Explorer by right-clicking on a group name field and selecting Insert. However, unlike a formula field, parameter field or running total field, you may not create a group name field through the Field Explorer; you create a group name field when you insert a group. 

F5: Refresh Field Explorer

In most scenarios, when you are working within the Field Explorer, the box updates its display automatically. However, there are scenarios where you have the Field Explorer opened when you invoke another component, and the Field Explorer is not updated automatically. Such scenarios include:

· If you add a table through the Report Expert, the Field Explorer does not automatically display it. You should click F5 to refresh the Field Explorer.

· If you have the Field Explorer active, and then you toggle the option to display fields alphabetically (see section “Display Database Fields Alphabetically” above), you should refresh the Field Explorer to reflect your change.

Moving and Resizing Objects

When you move or resize an object, you can now see tracker grid lines aligning the object against the horizontal and vertical rulers (where necessary) to let you clearly visualize the action. 
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Selecting Multiple Objects 

Previously, you could only select lines and / or boxes simultaneously to move or format them together. 

Now you may:

· in the Design Tab, select lines or boxes with other objects such as text, field, chart, map, bitmap, OLAP grid, cross-tab and OLE objects. 

· in both Design and Preview Tabs, select multiple objects such as text, field, chart, map, bitmap, OLAP grid, cross-tab and OLE objects.

You can do so by first clicking on one object, and shift-clicking (or Ctrl-clicking) each of the other objects.

You can carry out various operations after selecting the objects. Some of the operations deal with the concept of the “main” object. In general, the last object that you select is the main object. However, after selecting all the objects, you can change the main object to another by right-clicking the desired object.

The operations available are move, align, size, cut, copy and paste. In some scenarios, certain limitations apply; they are stated below accordingly.

Move

When moving multiple objects, if the new location does not accommodate all of the selected objects, but can accommodate the main object, then the main object and those objects that can be accommodated will be moved. The other objects will remain in their original locations.

However, if the new location does not accommodate the main object, then no object will be moved.

Align

You may select multiple objects and align them based on the position of the main object:

· left, right – align objects vertically based on the left (or right) edge of the main object,

· center – align objects vertically based on the center of the main object,

· to grid – for this to work, you must have Snap To Grid selected. Then when you align selected objects to grid, each selected object will be moved vertically to snap to the horizontal grid line closest to the top edge, and horizontally to snap the vertical grid line closest to the left edge. 

· top, bottom - align objects horizontally based on the top (or bottom) edge of the main object, or

· baseline – align objects horizontally based on the baseline of the main object. The baseline of an object is the line automatically inserted underneath a field object when you insert it into a report. It is displayed when guidelines are turned on.

Only certain types of alignment are available in some scenarios. You may select multiple objects in the same section or different sections of a report and align them, with the condition that the alignment will not result in an object being moved to a different section of the report. For example, if you select an object in the report header and another object in the page header, you may align them vertically (i.e., left, center, right or to grid) but not horizontally (i.e., top, middle, bottom or baseline), as otherwise this would result in moving one of the objects to a different section.

Another limitation is that if you select a cross-tab or OLAP grid as the main object together with other objects, you can align (or resize) in the Design Tab, but not in the Preview Tab.

Size

You may select multiple objects, and size them according to:

· width – size other selected objects to be the same in width as the main object,

· height – size other selected objects to be the same in height as the main object, or

· size – size other selected objects to be the same in size as the main object. 

Sizing objects to be the same as the main in width and in height is equivalent to sizing them to be the same as the main object in size.

Note that you may not size a line or a box. 

With a cross-tab or OLAP grid, you may size other types of objects based on a cross-tab or OLAP grid as the main object in the Design Tab, but you may not size a cross-tab or OLAP grid. You may not select a cross-tab or OLAP grid with other objects and size in the Preview Tab.

Cut / Copy / Paste

After selecting the objects, you may cut , copy or paste by:

· right-clicking on the main object and selecting cut, copy or paste from the shortcut menu,

· going to the Edit menu and choosing Cut, Copy or Paste, or

· using the keyboard shortcuts: Ctrl+X or Shift+Delete for cutting, Ctrl+C or Ctrl+Insert for copying, or Ctrl+V or Shift-Insert for pasting.

Note that you may not apply these operations to OLE objects and subreports.

Undo / Redo

You may undo or redo any of the above operations.

OTHER USABILITY ENHANCEMENTS

The user interface has been further modified in these areas:

Accounting Conventions

To support conventions used in accounting, you may now control how the negative symbol, currency symbol and zero value are displayed, and reverse the sign when displaying numbers in accounting reports.

To format a number or currency field using these accounting conventions, as before, you start with the Format Editor:

Step 1: In the enhanced Number tab of the Format Editor, select from the list of Styles "Custom Style".
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Step 2: Then click the Customize button. This will invoke the new Custom Style dialog box.
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Use Accounting Format

In the Number tab of the new Custom Style dialog box, when you check the new option of “Use Accounting Format”:

· the negative symbol and its position will be determined by the Windows locale information (i.e., it will be either the minus sign or the brackets),

· the dash will be automatically chosen for “Show Zero Values as:”, i.e., zero values will be automatically displayed as dashes (‘-‘) in your report,

· the currency symbol will be fixed on the left side.

Note that changing the Windows locale settings will take effect only after you have exited and restarted the Crystal Report Designer. 

Reverse Sign

In the Number tab of the Format Editor, you may now easily reverse the sign for debit and credit amounts in financial reports by checking the new option “Reverse Sign for Display”.

Automatic Driver Conversion for Set Location

Data sources that are managed by the new Data Explorer (see “Report Expert” above) can be classified into three types:

· single table residing on a single file (i.e., .DBF files)

· multiple tables residing on a single file (i.e., .MDB files)

· SQL data sources (including files using native SQL drivers, ODBC and OLEDB drivers)

Previously, when you moved your database to a different location, Set Location only allowed you to convert a database to another data source of the same type (e.g., converting from one SQL data source to another is fine, but not to a .DBF data source). 

Set Location now uses the new Data Explorer. When you move your database to a different location, Set Location automatically converts your database to use an appropriate driver of any type of data source that you have specified. However, note the following guidelines:

· If you are moving only one table, you may use Set Location to convert it to the same type or any other type of data source.

· If you are moving more than one table, you may use Set Location to convert all of them only to the same type of data source. If you move them to a different type of server, you should use Convert Database Driver to convert them to use an appropriate driver for that type of server.

Autosave Reports

There is now an option for you to have a report saved automatically once every x minutes, x being the autosave interval you can set. This option is available in the Reporting tab of the Options menu.
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When this option is checked, the report is saved in a temporary file in your temporary directory once every x minutes, where x is the interval you have specified. The temporary file name is the name of your report file, with .RPT replaced by AUTOSAVE.RPT (e.g., MyReport.AUTOSAVE.RPT). If the report is a new report, then the temporary file is the title of the report appended by AUTOSAVE.RPT (e.g., Report1.AUTOSAVE.RPT). When you save or close a report, the temporary file is removed.

Note that autosaving takes place in idle time: if the Crystal Report Designer is busy, it may not happen after the exact autosave interval.

Default Report Directory

In previous versions of Seagate Crystal Reports, the New Report tab of the Options menu has always had a default directory for loading or saving a report. However, this value was not initialized. Now, this value is initialized depending on your operating system. For example, after Seagate Crystal Reports is first installed on Windows NT, this value is initialized to be “C:\WINNT\Profiles\<username>\Personal”, where "<username>" is the logon user ID.

As before, you have the option to set this directory.

Enhanced Browsing

Browsing has been enhanced such that:

· If you fail to connect to a database (because it is either unavailable, or password-protected), you may still browse on saved data.

· You may browse formula and SQL expression fields, by right-clicking on one of these fields and selecting “Browse Field Data…”, or by clicking “Browse Data” in the shortcut menu in the Field Explorer. (See the section “Field Explorer” above for more information.)

· You have the option to browse only unique values of a field. This option is turned on by default. (See section “Browse Distinct Records” below for more information.)

Enhanced Field Formatting

Formatting currency, number, date, time and date-time fields has been streamlined with more sample styles to choose from.

Currency Field

Now when you use the Format Editor to format a currency field, you will invoke the enhanced Number tab of the Format Editor.
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Enable Display of Currency Symbol

On the right side of the Number tab is where you can specify whether or not to display a currency symbol. If you choose so, the currency symbol will be assumed to be the one you have specified through the Control Panel. You may then further specify whether you would like to display the currency symbol in a fixed or floating position relative to the currency field value. A sample of a number will be shown at the bottom.

System Default Currency Format & Sample Styles

On the left pane of the Number tab is a list of styles you can choose to format the currency field. On the top of the list is your system’s default currency format that you have specified through the Control Panel. If you select the System Default Currency Format, you will be formatting your currency field with your system’s specifications for the following:

· the currency symbol, 

· the position of the currency symbol (i.e., fixed or floating, leading or trailing, and its relation to the negative symbol if value is negative) specified for the negative currency format,

· the negative display symbol (e.g., brackets or negative sign) specified for the negative currency format, 

· the position of the negative display symbol (i.e., leading or trailing if the negative sign has been chosen, and its relations to the currency symbol) specified for the negative currency format,

· the decimal symbol, and

· the number of decimal places after the decimal symbol.

Customized Currency Format

To further specify how the currency field is to be formatted (e.g., leading or trailing symbol) as in previous versions of Seagate Crystal Report:

Step 1: Choose the system default format or one of the sample format styles that you think is close to your requirements. 

Step 2: Click the Customize button. This will invoke the new Custom Styles dialog box.

Step 3: In the Custom Styles dialog box, use the Number tab and Currency Symbol tab to access formatting options for currency fields. You may choose to begin with the Accounting Format on the Number tab, and make further modifications as necessary. (For more information on the new Accounting Format for numbers, please refer to the section “Accounting Conventions” above.)

Step 4: Notice that after you have defined a customized format, when you return to the Format Editor, the style selected will be a new item “Custom Style”.

Note: the item Custom Style only appears in the list of styles if you have defined and selected it as the style to use for that type of field (be it a currency, number, date, time or date-time field). Subsequent to selecting it, if you choose the system or a sample style, the Custom Style will be discarded.

Number Field

Now when you use the Format Editor to format a number field, you will invoke the enhanced Number tab of the Format Editor. The Number tab is similar to that you use when formatting a currency field (see section “Currency Field” above), with the main difference being that the currency symbol is not to be displayed by default.
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System Default Number Format & Sample Styles

On the left pane of the Number tab is a list of styles you can choose to format the number field. On the top of the list is your system’s default number format that you have specified through the Control Panel. If you select the System Default Number Format, you will be formatting your number field with your system’s specifications for the following:

· negative symbol (i.e., brackets or negative sign),

· position of negative symbol (i.e., leading or trailing if negative symbol is the negative sign), and

· any leading zero.

Customized Number Format

If you do not choose the system default number format or any of the sample number formats but wish to further customize:

Step 1: Choose the system default format or one of the sample format styles that you think is close to your requirements.

Step 2: Click Customize. This will invoke the new Custom Styles dialog box. 

Step 3: In the Number tab of the Custom Styles dialog box, you may choose to begin with the Accounting Format, and make further modifications as necessary. (For more information on the new Accounting Format for numbers, please refer to the section “Accounting Conventions” above.)

Step 4: Notice that after you have defined a customized format, when you return to the Format Editor, the style selected will be a new item “Custom Style”.

Date, Time and Date-time Fields

Now when you use the Format Editor to format a date, time or date-time field, you will invoke the enhanced Date / Time tab of the Format Editor.

System Default Formats & Sample Styles

Depending on the type of field you have selected to format, the Date Time tab of the Format Editor will display the appropriate system default formats and sample styles for that type of field. For example, when you format a date-time field, the Date / Time tab of the Format Editor will look like:
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The items at the top of the list, “System Default Long Format” and “System Default Short Format”, are default formats that you have defined through the Control Panel for your system.

Customized Format

If you do not choose any of the system default formats or sample formats but wish to further customize:

Step 1: Choose a system default format or one of the sample format styles that you think is close to your requirements.

Step 2: Click Customize. This will invoke the new Custom Styles dialog box. 

Step 3: You can make further customization using the appropriate Date/ Time, Date or Time tabs of the Custom Styles dialog box. (For more information on the new era and day of week enclosure for date and date-time fields, please refer to the section “Date Formatting for Japanese” above.)

Step 4: Notice that after you have defined a customized format, when you return to the Format Editor, the style selected will be a new item “Custom Style”.

Help for Report Experts

You may access online help through a Help button for each of the Report Experts: Standard, Form Letter, Form, Cross-tab, Subreport, Mail Label and Drill Down.

Improved Design Tab of Multi-column Report

Previously, the Design Tab of a multi-column report only showed a single column, although the Preview Tab would accurately show all the columns of the report.

Now, the Design Tab will also display all the columns. It indicates with a white shade the column that you can format, and displays the other columns with a gray shade. For example, the Design Tab of a three-column mailing label report will indicate that you may only format the left-most column, and display in a gray shade the two other columns on the right.
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Inserting Running Total

This is a shortcut for you to create a running total based on a selected database field.

Step 1: Select a database field.

Step 2: Right-click and select Insert Running Total. This will invoke the Create Running Total Field dialog box which has the running total automatically set up for the selected field.

More Image Formats

More file formats are now supported for blob fields: JPEG, PNG and TIFF.

Seagate Software Community on the Web

Through each of the new menu items, “Product Updates” and “Developer Samples”, accessible via Help | Seagate Software on the Web, you can now conveniently reach two of the most visited Web pages in the Seagate Software Community. 

By clicking “Product Updates”, you can download from the Web most up-to-date versions of:

· a product from our complete line of Seagate Crystal Reports, Seagate Info, Seagate Analysis and Seagate Holos,

· specific components including database drivers, export drivers, sample database, sample applications and sample reports, 

· product or component in the version you require including the current and previous versions,

· product or component in the language that we support, that may include English, French, Spanish, Italian, German, Portuguese and Japanese.

By clicking “Developer Samples”, you can access sample reports for different types of data sources, e.g., Lotus Domino and MS BackOffice.

String Search

You may now search for strings in text objects and field objects in both the Design and Preview Tabs. You can search for strings in cross-tabs and OLAP grids in the Design Tab, and subreports in the drill-down view. (Please note restrictions listed below.)  

To do so:

Step 1: In the Design or Preview Tab (where applicable), select Edit | Find. This will invoke the Find dialog box.

Step 2: In the new Find dialog box, specify the string to search. You may also specify the search direction, any matching criteria and whether to mark all occurrences of the string in the searched area. For example, if you invoke the Find dialog from the Design Tab:
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Note the following restrictions when you search:

· If a section is hidden and is suppressed (i.e., File | Options | ShowHiddenSections is off), then objects in it will not be searched.

· If the Show Field Names option in the Options menu is off, then all field, cross-tabs and OLAP grid objects will not be searched.

· Column and row headers of cross-tabs and OLAP grids are not searched.

In the Design Tab, you can invoke the Find dialog box and select Mark All to have all occurrences of the matching string in the report returned to you at once. This feature, however, is not available in the Preview Tab.

In the Preview Tab, you can use the Advanced Find feature to search for specific values in a database field. To do so:

Step 1: In the Preview Tab, select Edit | Find. Click the Advanced Find button. This will invoke the Search Expert.
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Step 2: If a database field has already been selected, the Search Expert defaults to search values for this field. However, if no database field has been selected, click the New button to choose a field.

The search functionality here is the same as selecting Report | Search, or the Search icon in the Standard toolbar in previous versions of Seagate Crystal Reports. This feature is not available in the Design Tab.

FORMULA LANGUAGE

The formula language in this release has been extensively enhanced and augmented with the addition of a new Visual Basic Script-like language called Basic syntax. It is an alternative language for the formula language. Most new functions, operators, control structures have been added to both Crystal and Basic syntaxes.  While existing Seagate Crystal Reports users do not have to learn this new syntax to utilize the extra capabilities, it is intended to be easy to learn and use for users already familiar with Visual Basic.

Apart from the new functions, operators and control structures available in both syntaxes, Visual Basic developers who distribute applications can benefit from the fact that Basic formulas are portable and do not require any additional DLL’s to run.

You must use the same syntax within a formula, but you may have formulas in different syntaxes in the same report. When you enter a formula (other than a selection or search formula - see note below) in the Formula Editor, you can choose either Crystal or Basic syntax as the default syntax for the formula.
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You may also set a syntax to be the default syntax for all reports in the Reporting tab of the Options menu.
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New functions available to both syntaxes include:

· financial functions,

· mathematics functions,

· programming shortcut finctions,

· type conversion functions, 

· date and time functions,

· array and string functions, and

· percentage functions.

New operators available to both syntaxes include:

· integer division,

· exponentiation, 

· eqv,

· imp, 

· xor, and

· mod.

New control structures available to both syntaxes include:

· for statement,

· do statement, and

· select … case statement.

For a more detailed description of these functions, operators and control structures, please refer to Appendix A.

Note: The two syntaxes are fundamentally equivalent, with one exception:

You can use the Select Expert to create a selection formula, the Search Expert to create a search formula, or the Formula Editor to create either of these. In the case where you use the Formula Editor to create or modify an existing selection or search formula, you may only do so in Crystal syntax.

SUMMARIES

There are various enhancements for inserting summaries, including subtotal, summary and grand total fields.

Inserting Subtotal, Summary, Grand Total 

Previously, you had to first select an appropriate database field (that could be subtotaled or summarized) before you could insert a subtotal, summary or grand total.

Now in both the Design and Preview Tabs, without first selecting any object, you can insert a subtotal, summary or grand total. In addition, when you insert a subtotal or summary field for grouped data, you now have these two options:

· to insert a subtotal or summary field for each of all groups, or

· to insert a grand total field based on the subtotal or summary field.

For example, if you want to insert a summary:

Step 1: Without first selecting any object, right-click and select Insert | Summary. This will invoke the Insert Summary dialog box.

Step 2: In the Insert Summary dialog box, select the database field that you would like to create the summary for.

Step 3: If you are creating the summary for grouped data, check the appropriate box if you want to insert a summary field for each group, or if you want to create a grand total field based on the summary field.

[image: image54.png]Checkthis ityou want & summary
created for sachof all groups.

Checkthis ityou want & grand
total based on the summary field.

o |

Inset afield which calculates the

When the report s pinted, the records.
wil be sored and grouped by:

T~ Show as a percentage of

. Group A1 Customer Customer Name £ 7

Grand Totak Sum of Ordr Amount

T Insert summany fields for all groups
T Insert grand total field

Cance

Without selecting any object you
can now insert & summary field
Here, you specify the dafabase
feldl 9 summarize on




Note that as before, if you have selected an object that cannot be summarized, then the menu item Insert | Summary will be disabled. The same applies to subtotal and grand total fields.

Percentage Summary Fields

A Percentage Summary Field allows you to express a summarizable database field based on one grouping as a fraction of the same based on a broader grouping. For example, you can use a Percentage Summary Field to show the percentage of sales in each city of a country over the total sales of the entire country. In this case, the summarizable field you have chosen is sales, and the grouping involved is the city level group over the country level group.

The summary operations that support Percentage Summary Fields are Sum, Average, Maximum, Minimum, Count and DistinctCount.

Below is a report that shows the Order Amount for each order for each customer. Customers are located in different cities of different countries. The following procedure illustrates how to create a Percentage Summary Field showing the percentage order of each city out of the entire country, for all countries. 

Step 1: Based on this report, create two groups, one based on Customer.Country (which is a level 1 grouping), and the other based on Customer.City (which is a level 2 grouping). The first page of your report should have a group heading displaying “Argentina”, followed by the group heading “Buenos Aires”.

[image: image55.png]Level 1 grouping based on
Custormer Country.

Level 2 grouping based on
Custorner City

Custorser Nexe

Aléntico
Aléntico
Aléntico
Aléntico
Aléntico
Aléntico
Aléntico
Atlintico

Ltda.
Ltda.
Ltda.
Ltda.
Ltda.
Ltda.
Ltda.
Ltda,

©
3
Is

1235
191
1,300
1,344
1351
1391
1404
1,708

Oy Ampwt

$1,64205
$3435
$592020
$224625
$1,66470
$1474115
$95.40
$52.50





With the appropriate grouping set up, you may now insert the Percentage Summary showing the % of order for each city out of the whole country, for each country in this database. You can do this all through the Insert Summary dialog box, first specifying the total order for each city (the numerator), then the total order for each country (the denominator).
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Step 2: In the Insert Summary dialog box, specify the numerator of the % to be the sum of order based on the Customer.City group (i.e., the total order for each city).

Step 3: Check the “Show as a Percentage of” checkbox for Percentage Summary field. 

This will invoke a list of possible denominators you can choose from based on the group you have chosen for the numerator, and all the other groups you have set up:

· The format of items in this list is the group name (or level), followed by the field name in the denominator. For example, 

Group #1: Sum of Order Amount.

Note that the field name in the numerator must be the same as that in the denominator; it is the group level that is different between the two.

· The group you have chosen for the numerator must be an inner level (e.g., level 2) with respect to the group for the denominator (e.g., level 1).

· There is a level 0 grouping that is automatically set up for the grand total. 

Step 4: Select a denominator from the list of eligible denominators.

Step 5: The resultant report will show a Percentage Summary of order for each city out of the entire country, for each country in the report. Excerpts of the report are displayed as below:
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In this database, there are only customers in Buenos Aires in Argentina. Hence the % summary for order amount in Buenos Aires is 100% of total order amount for the entire Argentina.
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The order amount in Burnaby in Canada is 17.76% of total order in Canada.
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The order amount in Port Coquitlam in Canada is 42.46% of total order in Canada.

:
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ADD-INS FOR ACCESS AND EXCEL

There are two new add-ins for Microsoft Access and Excel that allow you to create a report directly from Access and Excel respectively.

Access Add-in

The Access Add-in allows you to easily create a report from a table or a query in Access 97 or Access 2000 using the Seagate Crystal Report Wizard. The report is dynamically linked to the database such that after you have changed and saved a table or query (by closing it), you may refresh the report and the changes will be reflected.

The following procedure uses Access 2000 as an example. Setting up and using the Access Add-in is similar in Access 97.

Installing the Add-in

When you install Seagate Crystal Reports 8, the Access Add-in files will be placed in \Program Files\Seagate Software\Report Designer Component by default. The Access Add-in will automatically be installed onto Access, and will be loaded every time Access is started.

Creating a Report from Access

Note: currently you may create a report from Access based on only one table or one query. You may not create a report from a query with input parameters.

To create a report from a table or a query using the Seagate Crystal Report Wizard, follow these steps:

Step 1: Open a database. 

Step 2: Before you create a report from a table or query, you should save the changes you have made to it, by actually saving and closing the table or query so that the changes are written to disk. Other precautionary measures include:

· you should have opened the database that you would like to report on in shared (as opposed to exclusive) mode,

· save and close all new tables and queries, and

· close all design views for all queries and tables.

Step 3: There are several ways you can start the Seagate Crystal Report Wizard in the Database window:

· If you have selected a table or query, choose Tools | Add-Ins | Seagate Crystal Report Wizard. 

· If you have selected the Queries button but not any particular table or query, or if you have selected the Forms, Pages, Macros or Modules button, you may start the Seagate Crystal Report Wizard via Tools | Add-Ins | Seagate Crystal Report Wizard. You will be prompted to choose a table or a query in the database. 
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After selecting a table or query, clicking OK will then invoke the Wizard.
· If you have selected the Reports button:

· Click New in the Database window toolbar. This will invoke the New Report dialog box.

[image: image63.png]New Report

&\

This wizard automaticaly
creates your Crystal report,
based on the abject you
select,

Chogse the table o query where
the object’s data comes from:

[Desian view
[Report wizard
[AutoReport: Colurmar
[AutoReport: Tabuar
(Chart vizard

Label rzard

1. Selectthe Seagate Crystal Report Wizard
to create areport

2. Select atable or query to report on




· In the New Report dialog box, select Seagate Crystal Report Wizard. Select a table or query. 

Step 4: Since the same Seagate Crystal Report Wizard can be invoked from Excel, for simplicity, continue with Step 6 below under “Creating a Report from Excel” for more information on how to use the Seagate Crystal Report Wizard.

Excel Add-in

The Excel add-in allows you to select a range of cells in an Excel 97 or Excel 2000 worksheet, and create a report from Excel using the Seagate Crystal Report Wizard. You may then use the Crystal Report Viewer for ActiveX to preview the report, or launch the Crystal Report Designer or Seagate Analysis to modify the report.

The resultant report is dynamically linked to the Excel worksheet, such that modifications to the selected range in the worksheet (see Note below) will automatically be reflected in the report when you refresh in the Crystal Report Designer.

Note: report is dynamically updated when refreshing upon the following actions:

· adding a row to the selected range (but not pre-pending or appending a row to the selected range),

· deleting a row in the selected range, and 

· modifying a cell within the selected range. However, note that if you change the value of a cell from one type to a different type (e.g. changing it from a number value to a string value), depending on the type of database you are using for the data, you may not be able to reflect this change in the report. 

Dynamic update is not supported for these actions:

· pre-pending or appending a row to a selected range,

· adding or deleting a column to a selected range,

· any modification, addition or deletion to anywhere outside of the selected range.

Installing Starting the Excel Add-in

When you install Seagate Crystal Reports 8, the Excel Add-in files will be placed in \Program Files\Seagate Software\Report Designer Component by default. The Excel Add-in will automatically be installed onto Excel, and will be loaded every time Excel is started, unless you uncheck it in the Add-ins dialog box.
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Starting the Excel Add-in

You can start the Excel Add-in via: 

· the Excel Tools menu, or
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 on its own custom toolbar.

Creating a Report from Excel

After you start the Seagate Crystal Report Wizard, you can select a range of cells to report on:

Step 1: Save your current worksheet in Excel.

Step 2: In the Seagate Crystal Report Wizard dialog box, begin selecting a cell range from the current worksheet by clicking on the box to the left of the input field.
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Step 3: In the spreadsheet, use the mouse to select a range of cells; your selection will be automatically translated into Excel-terms in the reduced Seagate Crystal Report Wizard box. Click the box with the red arrow to the right when you are finished with the selection.
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Step 4: Alternatively, you may select all cells by clicking the button adjacent to “Expand the selected range automatically”. (The expanded range includes cells currently selected, plus those delimited by an empty row and an empty column in the worksheet.)

Step 5: Click the "Create Crystal Report" button to create a report based on the selected range of cells.

Step 6: Select fields to include in your report. (Note that if you are creating a report from Excel data, the fields shown in the Available Fields list are those in the cell range you have selected in Step 3 above. The first row of a selected range of cells in the spreadsheet is commonly field names to appear as field headings in the report. However, if the cell value is not text, then a default name will be assigned to it, e.g., F1, F2, etc.)
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Step 7: You may click Next to proceed to each of the following pages to:

· specify fields to group by, 

· specify record selection criteria,

· specify report style. 

You may click Finish at any time to save the report and view it using the Crystal Report Viewer for ActiveX. 

Step 8: If you scroll through all the dialog boxes to the last one, you may save the report and choose to:

· preview the report using the Crystal Report Viewer for ActiveX (viewing allowed only),

· modify the report using the Crystal Report Designer (viewing and modifying allowed), 

· analyze the report using Seagate Analysis (currently, only modifying allowed), or

· exit the Seagate Crystal Report Wizard.
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Spreadsheet Moved

If the spreadsheet based on which you have created a report has been moved to a new location, when you attempt to preview the report in the Crystal Report Designer, you will get an error message that the Microsoft Jet database engine cannot locate the spreadsheet.

You should perform a Set Location in the Crystal Report Designer to set up the link again between the spreadsheet in its new location and the existing report.

Step 1: Select Database | Set Location. Click the Set Location button.

Step 2: Set up a new connection to the spreadsheet using an OLE DB driver: in the Data Explorer, select More Data Sources | OLE DB | Make New connection. This will invoke the Data Link Properties dialog box.
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Step 3: In the Provider tab of the Data Link Properties dialog box, select Microsoft Jet 4.0 OLE DB Provider. Click the Next button.
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Step 4: In the Connection tab of the Data Link Properties dialog box, enter the new location of the spreadsheet.
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Step 5: In the All tab of the Data Link Properties dialog box, double-click on “Extended Properties” to edit its Property value. This will invoke the Edit Property Value dialog box. Enter “Excel 8.0” as the Property Value. Click OK.
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Step 6: Click OK to exit the Data Link Properties dialog box.

Step 7: Click Set in the Data Explorer.
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Step 8: Click Done in the Set Location dialog box. You will then be able to refresh your report to reflect any changes to the spreadsheet.

PRINTING 

Printing to printer has been enhanced to provide more printer configuration control from the Crystal Report Designer, and close to WYSIWYG output. These enhancements include:

· printing non-consecutive pages, e.g., printing pages 1, 4 to 6, 13, etc.,

· formatting text objects using printer fonts, such that printed text resembles closely what is seen on the screen in the Crystal Report Designer and in the Crystal Report Viewers, and

· better image quality in the Crystal Report Viewers.

WYSIWYG vs non-WYSIWYG Output

Previously, when viewing text objects on the screen and printing the same text objects, you always had non-WYSIWYG results. Field objects containing text (e.g., string and memo fields) were printed non-WYSIWYG as well.

Now, text objects and string and memo fields are printed with very close to WYSIWYG quality.

EXPORTING

Acrobat PDF

A Beta version of this export driver is now available for you to export a report in Adobe Acrobat’s Portable Document Format (PDF) and view it on the Acrobat Reader. (For more information on how to obtain the Beta release of this export driver, please refer to the Release Notes for up-to-date information.)

Enhanced HTML

Exporting to HTML has been enhanced. You can select to export a report in “HTML 3.2” format and view it in a browser. The exported report is now paginated.

[image: image76.png]Destination

Disk fle <

Selectthis item from the drop-down listto
exportta HTML.




HTML 4.0

You may now export a report in HTML 4.0 format. Select “HTML 4.0” in the Export dialog box. You can then display the report in a browser that supports HTML 4.0 (i.e., Internet Explorer 4 or up, or Netscape Navigator 4 or up). 

Typically, reports in HTML 4.0 are smaller in size, and when displayed in a browser that supports HTML 4.0, they are closer to what you see in the Crystal Report Designer, with respect to object positioning, font type and font size.
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SUBREPORTS

There are some enhancements on creating and linking subreports:

On-demand Subreports on Creation

Now, when you create a subreport, you can specify it to be on-demand, instead of having to format it as such at a later point. You can do so in the Subreport tab of Insert Subreport dialog box:
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Linking Subreports

Previously, after you had inserted a subreport by importing an existing report (for convenience, call this the parent report), changes to the parent report would never affect the subreport. Now, you have the option to update the subreport from its parent in the original location, automatically upon loading, or manually anytime.

Update Subreport Upon Loading

Now there is an option where you can specify to update a subreport automatically upon opening the main report. There are two places where you can set this:

· You can set this option globally through File | Options | New Reports:
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· You can also set this option specifically for a subreport that you have inserted. You can do so when you format the subreport. In the Subreport tab of the Format Editor, you may check the new option “Re-import when loading”. This option is off by default.
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Update Subreport Manually

After loading the main report and the subreport, you can update the subreport anytime by right-clicking and choosing “Re-import subreport” from the shortcut menu. The subreport will be updated immediately. Note that this menu item is not available if the subreport has been created from scratch through the Report Expert and not imported from an existing report. 
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Warning: The “Re-import subreport” command does not warn if the subreport has been modified, and cannot be undone. Retroactively if you want a subreport to return to its previous state, then you should exit the main report without saving and start again.

HYPERLINKS

You may now create a hyperlink to a Web site, e-mail address, Crystal report file or any other file. 

Linking to a Web Site or E-mail Address

Creating a Hyperlink for an Object

You may select an object (e.g., text, bitmap, chart) in a report (or subreport) to create a hyperlink to a Web site, an e-mail address or a file (note: for linking to a Crystal report file, see below):

Step 1: Select the object for which you would like to create a hyperlink.

Step 2: Choose Insert | Hyperlink. (Alternatively, you may click on the Insert Hyperlink icon, or right-click on the object, choose Format Field and go to the Hyperlink tab.) This will invoke the Format Hyperlink dialog box. 
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Step 3: In the Format Hyperlink dialog box, initially, you will find that no hyperlink has been set up. Choose one of the options under “Hyperlink type”:

· an e-mail address. If you choose this option, append an e-mail address to the prefix "mailto:" which will have been automatically inserted for you under "Hyperlink information". 

· a Website on the Internet. If you choose this option, append a Website address to the prefix "http://" which will have been automatically inserted for you under "Hyperlink information".

· a file that resides locally or on your network. This file can be any file, e.g., an HTML file, a system file, a bitmap file, etc., that your operating system supports. If you choose this option, append a file name to the prefix "file:///" which will have been automatically inserted for you under "Hyperlink information".

Step 4: As an option, you may enter a formula to send an e-mail to the specified e-mail address (or to link to the specified Web site or to open the specified file) based on a condition. Click OK.

Step 5: In the Preview Tab, when you click on the object, you will go to your e-mail program to send an e-mail to the specified address (or link to the specified Web site or open the specified file). Alternatively, you may right-click on the field and choose “Go to Hyperlink” at the bottom of the shortcut menu.

Creating a Hyperlink for a String Field Containing Web or E-mail Address

In particular, if a string field contains a Web site address or e-mail address, you may set up a hyperlink for it:

Step 1: In the Preview Tab, select a String field that contains a Web site address (or e-mail address).

Step 2: Choose Insert | Hyperlink. (Alternatively, you may click on the Insert Hyperlink icon, or right-click on the object, choose Format Field and go to the Hyperlink tab.) This will invoke the Format Hyperlink dialog box.
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Step 3: In the Format Hyperlink dialog box, choose the option “Current field value” under “Hyperlink type”. Click OK.

Step 4: In the Preview Tab, when you click on the field, you will go to the Web site (or e-mail to the provided address). Alternatively, you may right-click on the field and choose “Go to Hyperlink” at the bottom of the shortcut menu

Modifying a Hyperlink

You may modify a hyperlink to a Web site or e-mail address by:

· choosing Insert | Hyperlink,

· clicking on the Insert Hyperlink icon in the Standard toolbar, or 

· right-clicking on the object, choosing Format Field and going to the Hyperlink tab.

Linking to Another Crystal Report

When you create a hyperlink in a report to link to another report, the latter is linked to the former as an on-demand subreport. You may create a hyperlink to a subreport only from a main report. To create such a link:

Step 1: Make sure you do not have any object selected in the main report. Choose Insert | Hyperlink. (Alternatively, you may click on the Insert Hyperlink icon.)
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Step 2: In the Format Hyperlink dialog box, “Another Crystal report file” is the only option available for you to create a hyperlink to. Enter the path to the report.

Step 3: The subreport is inserted into the main report as a hyperlink. You may double-click on this link to go to the subreport. Notice that a Design Tab and a Preview Tab will be created for this subreport.

You may not create a hyperlink from one subreport to another subreport. In this case, if you have no object selected in the subreport, the Insert Hyperlink menu item and icon are both disabled.

Note that if you have created a hyperlink for an object in a report, you should Shift-click on it to select it.

CHARTS 

There are a number of enhancements in the charting component:

Zoom In / Out

You may now zoom in or out on a bar chart and a line chart, in the Preview, Analyzer and drill-down tabs. This is particularly useful if, for example, your chart contains a lot of data, or you would like to obtain more detailed information from a chart.

Zoom In

For example, to zoom in on a group in the Preview Tab:

Step 1: Right-click on a chart. In the shortcut menu, select Zoom In. Alternatively, click on the Zoom-in icon (a magnifier with a plus sign) in the Analyzer Toolbar.
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Step 2: Using the zoom in cursor (a magnifier with a plus sign), select an area of the chart. For example, if you want to zoom in on a riser in a bar chart, you should enclose the entire riser with the tracking rectangle. 
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Step 3: The zoomed-in riser forms a new chart. Note that its color is not necessarily the same as in the original chart.
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Zoom Out

To zoom out, right-click to select the chart, and choose Zoom Out in the shortcut menu. Alternatively, click on the Zoom-out icon (a magnifier with a minus sign) in the Analyzer Toolbar.
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Scope of Zoom

· You can zoom on both groups and series.

· Zooming in or out on a chart is instance-specific. For example, if you have a chart in a group header, zooming in or out will only affect that instance.

Save Zoomed Chart

To save an instance of a chart that has been zoomed in or out, you have to save the data with the report.

Format Charts

There is now a new set of options that allow you to elaborately format a chart. Select a chart in the Preview or Analyzer Tab. You can then access these new options from:

· the shortcut menu in the Preview or Analyzer Tab. There is now a new menu item "Format Chart…" that invokes a context sensitive sub-menu, listing the various formatting options available depending on the current chart type and the current Tab (i.e., Preview or Analyzer). For instance, you can find a complete set of options available when you select a series in a 3-D Riser chart in the Analyzer Tab.
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· the Analyzer Toolbar. There are 7 new icons in the Analyzer Toolbar identifying the new functions.
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Preview Tab vs. Analyzer Tab

Note that if you have specified group charts in your report, and you invoke chart formatting from the Preview Tab, except for zooming, all formatting will be applied to all instances of charts in the report. On the other hand, if you invoke chart formatting from the Analyzer Tab, then by default, all formatting will only be applied to the chart in the Analyzer. To apply changes made in the Analyzer to all instances of charts in the report, from the Analyzer shortcut menu, click "Apply changes to all charts". To revert changes in the Analyzer, click "Discard changes".

The new formatting options are briefly described as follows. For more information, please click Help and refer to the online help in the corresponding dialog boxes.

Template

This menu item is always available in the Format Chart menu invoked from the Preview or Analyzer Tab.

Clicking on the "Template…" menu item will invoke the "Choose a Chart Type…" dialog box. There are two tabs in this dialog box: Gallery and Custom. In the Gallery tab, you can choose from a set of standard chart types: area, bar, bubble, column, histogram, line, pie, scatter and surface chart types. 
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In the Custom tab, you can choose from a set of custom chart types. (Note that these custom chart types are available only if you have chosen a Complete installation of this release. If you have not, use the Seagate Crystal Report Installation Wizard to add the "Custom Charting" component.)
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In particular, the set of "User Defined" custom chart types are types that you have saved using the "Save as template…" option in the Analyzer shortcut menu.

General

This menu item is always available in the Format Chart menu invoked from the Preview or Analyzer Tab.

When you click on the "General…" menu item, you invoke the Chart Options dialog box which consists of the following tabs: General, Layout, Data Labels, Numbers, Data2 Options, Look and Display Status. Please note that some of these tabs and their content are context-sensitive, depending on the type of chart chosen and other formatting options selected. For example, the Numbers tab is activated if you have turned on data labels for the current chart.

[image: image93.png]Formatting options for data label numbers

Formating and display options Formating options for dual-axes charts,
for data labels. Options for chart look like coloring
Chartlayout options. by group or series
General formating optians for Options for shawing / hiding
the current charttype. chart objects

[ T I S I S N |

{araia)] Lavout| Dats Label | Numbers | Dats2 Optons | Look. | Disly Status |

[ —

Riser Shape: [Rectangle =

Sum of Last Yaars Sales / Country

T~ Display Series Lines
T Use Depth

Tl I o Desth ————— [T ]
e iestors = =]

e e |





Titles

This menu item is always available in the Format Chart menu invoked from the Preview or Analyzer Tab.

Clicking on the "Titles…" menu item will invoke the Titles dialog box where you can edit various titles and footnotes for the selected chart(s).
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Series

This menu item is available in the Format Chart menu when invoked from the Analyzer Tab, with a series (e.g., a bar, slice, data point, etc.) selected.

With a series in the Analyzer selected, clicking on the "Series…" menu item will invoke the Series Options dialog box where you can format the selected series, data labels and trend lines, if any. The formatting options available depend on the type of the chart.
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Grid

This menu item is available in the Format Chart menu invoked from the Preview or Analyzer Tab, if the selected chart has a grid (i.e., any chart type except for a pie or doughnut).

Clicking on the "Grid…" menu item will invoke the "Numeric Axis Grids & Scales" dialog box, where you can format chart axes, grid lines and scaling. Depending on the type of the chart, you can format up to 3 axes: data axis, group axis and series axis. Select the appropriate tab on the lower left of the dialog box to format one of these axes.
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· Data axes. You can format up to 3 data axes, the Primary Data (Y1) Axis, the Secondary Data (Y2) Axis and the X-Axis. You can choose the location of each of the axes, whether values on axes are ascending or descending, and format scaling, data axis labels, and major and minor grid lines.

· Group axis. You can choose to display groups in reverse order, format group axis labels, and major and minor grids.

· Series axis. This axis is only available for 3D riser and 3D surface charts. You can format series axis labels, and major and minor grids.

Selected Item

This menu item is available in the Format Chart menu when invoked from the Analyzer Tab, with an object in the chart or legend selected (e.g., series, title, label, grid, etc.).

With an object in the Analyzer selected, clicking on the "Selected Item…" menu item will invoke the Formatting dialog box. There are three tabs in this dialog box: Font, Line and Fill. Each of these tabs is activated depending on the type of object that has been selected in the Analyzer.

The Font tab is activated if a text object (e.g., title, footnote, label, legend text) has been selected in the Analyzer. Here, you can format the color, font, size, style, alignment, box and rotation of the object, and preview the object with the new formatting changes.
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The Line tab is activated if a line object (e.g., grid line, axis line, edge of a riser) has been selected in the Analyzer. Since an area object typically has a border, thus if an area object is selected, this tab is also activated. Here, you can format the color, style and thickness of the object, and preview the object with the new formatting changes.
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The Fill tab is activated if an area object (e.g., riser, marker, text box) has been selected in the Analyzer. Here, you can set the object to be transparent, format its color, or apply a pattern, gradient, texture or a picture to the object.
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Viewing Angle

This menu item is available in the Format Chart menu invoked from the Preview or Analyzer Tab, when the selected chart is a 3-D chart.

Clicking on the "Viewing Angle…" menu item will invoke the "Choose a Viewing Angle…" dialog box. Here you can choose from a set of pre-set angle options, or place the 3-D chart in almost all possible angles, by panning, rotating or moving the chart. You can also change the thickness and size of the grid walls. 
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Detailed Tool Tips

In the Preview and Analyzer Tabs, if you select a chart or a map, you will find tool tips showing more detailed information. For example, a tool tip for a chart that shows sales for different countries may read “USA: Sum of Customer. 1997 Sales: 3410088.85”. Similarly, a tool tip for a map for the same data may read “United States: 3410088.85”.

Legend Enhancements

There are various enhancements for formatting the legend:

Display % or Amounts in Legend

In the legend of a pie chart or doughnut chart, you may choose to display percentages as before, or, choose to display amounts, both percentages and amounts, or no values. You can do this in the Options tab of the Chart Expert. The default is to display amounts only.
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Drill-down on Legend

You may now drill-down on the legend of a chart that contains groups only (i.e., it shows a data value on the change of only one field, and it does not have any series). Specifically, you may drill-down on the marker and on the text in a legend. 

Multiple Curve Types for a Series

Now you may create more than one curve of different curve types for a series. You can do this through the Chart Editor as before, or by following these steps:

Step 1: In the Preview Tab, select a chart that you would like to format.

Step 2: Select Analyzer | Launch Analyzer to bring up the chart in the Analyzer.

Step 3: In the Analyzer, select a series for which you would like to create a curve.

Step 4: Right-click and select “Curve Fit and Stat Lines…”.
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Step 5: In the Curve Fit and Stat Lines dialog box, select the curves you would like to display for the selected series. More formatting options may be available depending on the curve you have chosen. For more information on items in this box, please refer to the online help.
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Enhanced Charting on OLAP Grids

You may now select more fields from OLAP cubes to chart on. For detailed information, please refer to the section “Mapping on OLAP Grids”.

Miscellaneous Improvements

Several other areas that have been improved include:

All 3 Data Values Shown in Bubble Charts

A bubble chart shows correlation of 3 values: the first 2 values are used as in an XY scatter chart, and the third corresponds to the size (or weight) of a data point. Now there is an option to show all three values in a bubble chart: in the Options tab of the Chart Expert:

· if you specify “Show label”, then the first two values are shown on the axes for both scatter and bubble charts, and

· if you specify “Show value”, then the third value is shown for bubble charts and nothing is shown for scatter charts.

Automatically Scale Data Axis

You now have an option to have the data axis automatically scaled. You may check this option in the Axes tab of the Chart Expert. (Note: this tab is only displayed if the selected chart is not a pie or doughnut chart.)

To illustrate this, the Axes tab for a 2-D chart (e.g., bar or line chart) has a new check box "Auto scale" as shown below:
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By default, the data axis is not scaled automatically. In this case, the data axis always starts at 0. If you have the data axis scaled automatically, depending on the data, the data axis may not start at 0.

Chart on Running Totals

You may now create a chart based on a running total field. In the Data tab of the Chart Expert, for an advanced chart (previously called a detail chart), you can select running total fields to show them in the chart.

Chart on All Records 

You now have an option to create an advanced chart for all records (an advanced chart is previously called a detail chart). In the Data tab of the Chart Expert, there is a new option  “For all records”:

· If you specify a chart placement setting of “Once per report”, then the advanced chart will show the grand totals for the selected fields.
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· If you specify to place a chart for each group, then the detail chart will show the subtotals for the selected fields.
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Data Points Identified in Scatter and Bubble Charts

In XY scatter charts and bubble charts, data points are now displayed in different colors and there is a legend that provides more information, depending on how you have set up the chart:

· If you specify that a data point is to be displayed on change of a field, then the legend will list values for the field.

· If you specify that each data point corresponds to a data record, then the legend will show the record numbers.

· If you are creating the chart for all records, then there will be only one data point and the legend will not be used.

Data Tab In Sync with Chart Type

Since XY Scatter, Bubble or Stock chart types show more than one value, in the Chart Expert, if you select any of these chart types, the layout options of Group, Cross-tab or OLAP will be disabled.

Group Layout Option Enabled Appropriately

Since group charts require at least one grouping level with one or more summary fields, only group levels with at least one summary field will be shown in the “On change of” combo box. If there is no such grouping level for the report, then the Group layout option will be disabled.

Moving and Re-sizing Miscellaneous Items

Now you may move or re-size the following items for a chart in the Analyzer:

· chart,

· title,

· subtitle,

· footnote,

· legend, 

· X axis title,

· Y1 axis title, and

· Y2 axis title.

Note that these actions cannot be undone.

New Formats for Data Points and Data Axes

Four new formats have been added to the Chart Expert to format data point values and data axis values: 1K, 1M, $1K and $1M. 

MAPS

There are a number of enhancements in the mapping component:

Detailed Tool Tips

There are now detailed tool tips for maps (and charts) in the Preview and Analyzer Tabs. Please refer to the section for charts above for more information.

Data Mismatch Resolved

A map may use geographical names that are different from those used in the data. For example, a map of France may use “Champagne-ardenne” while the data uses “Champagne Ardenne”. In this case, because of this mismatch of the geographical name between the map and the data, the map cannot display any data for “Champagne-ardenne” unless you resolve the mismatch.
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To resolve the mismatch:

Step 1: In the Analyzer Tab, right-click and select “Resolve Mismatch…” from the shortcut menu.
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The Map Region Resolver dialog box shows all the names of geographical regions that are mismatched between the map and the data. The list of names on the left pane (i.e., headings) is those used in the data, and that on the right (i.e., keywords) in the map. 

Step 2: In the Map Region Resolver dialog box, click on a heading in the left pane that you would like to resolve. You may be automatically assigned a keyword in the right pane to match. You may change this assignment, or assign one yourself, by clicking on another keyword in the right pane. 
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Step 3: If there is a match, click Assign to resolve the mismatch. The assignment will be displayed in the bottom pane. If you want to undo an assignment, you can select it, and click Remove. 
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After the mismatch in the region name between the data and the map has been resolved, the map will be able to display data for that region in the tool tip.
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Note that you can have many-to-one keyword matching as well. For example, in a map that contains the names "England", "Northern Ireland", "Scotland" and "Wales", and the database contains data for "United Kingdom", you can resolve the mismatch by mapping each of the four names to "United Kingdom".
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Upon assigning more than one region to the same keyword, if you have set summation, maximum or minimum as a summary operation, the sum of the data for the assigned regions will be displayed. If average is the summary operation used, then average will still be displayed.

Map Navigator

In the Analyzer Tab, there is a new window, the Map Navigator, that shows the relative location of the currently displayed map. When you zoom in, zoom out, or pan in the Analyzer Tab, the Analyzer displays a different portion of the map. The Map Navigator allows you to easily identify the portion of the map currently displayed in the Analyzer in relation to the full map.
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More, you can now zoom in, zoom out and pan in the Map Navigator as well. 

By decreasing the size of the tracking rectangle in the Map Navigator, you actually zoom into that portion of the map the Analyzer is currently displaying. Similarly, by increasing the size of the tracking rectangle, you zoom out of that portion of the map. As you size the tracking rectangle in the Map Navigator, the Analyzer adjusts and displays the corresponding portion of the map.

For example, in a single step, you can now pan from Canada to Australia. 
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You have an option to hide (or show) the Map Navigator, by right-clicking in the Analyzer or in the Map Navigator, and selecting Hide Map Navigator (or Show Map Navigator) from the shortcut menu. The full range of actions in the shortcut menu (i.e., Zoom In, Zoom Out, Pan, Change Map Type, Change Map Layers, Resolve Mismatch, Change the Map, Change Title, Hide / Show Map Navigator) available in the Analyzer is also available in the Map Navigator.

Mapping on OLAP Grids

You may now create maps (and charts) based on OLAP grids. Creating a map on an OLAP grid is similar to creating a chart on an OLAP grid, in that they both require selecting appropriate “fields” from the OLAP cube. The following description applies to creating both maps and charts. (“Fields” in the this context refers to either generations of a dimension, or a flattened dimension.)

To create a map based on an OLAP grid, you need to select two fields (the “By” and “Subdivided By” fields). The following example illustrates the fields that you may select to create a map:

In this example, there are four dimensions in the OLAP grid: Regions, Products, Customer Type and Time. Each of these dimensions has two generations:

· Regions: R0, R1, R2,

· Products: P0, P1, P2,

· Customer Type: C0, C1, C2,

· Time: T0, T1, T2,

where x0 is a flattened dimension, and x1, x2 are generations of a dimension.

The rows of the OLAP grid are Products and Time, and the columns are Regions and Customer Type. Products and Regions are the outermost dimensions.

You may define a map by specifying By and Subdivided By as follows (denoted by ‘Y’) :

Subdivided By
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Note:

1. If there are more than two dimensions in the OLAP grid, you may choose only the outermost dimension for the By field. 

In the above example, you may only choose Regions and Products as the By fields.

2. You may select any generation of an outermost dimension as a By field. 

In the above example, previously, you could only select generations R1 and P1 as By fields. Now you may select R2 and P2 as By fields.

3. If the By field is a flattened dimension in a row (e.g., P0), you may only select as Subdivided By field:

a. the flattened dimension of another dimension in the row (e.g., T0), or 

b. the flattened dimension of the other outermost dimension (e.g., R0).

4. The same in 3 above applies to a flattened dimension in a column. 

In the above example, if you select R0 as a By field, you may only select either C0 or P0 as the Subdivided By field.

5. If the By field is a generation in a row (e.g., P1), then you may only select as Subdivided By field:

a. a generation that is more inner, and that belongs to the same dimension (e.g., P2),

b. a generation of another dimension in the row (e.g., T1 or T2), or

c. a generation of the other outermost dimension (e.g., R1 or R2).

6. The same in 5 above applies to a generation in a column. 

In the above example, if you select R2 as a By field, you may only select P1, P2, C1 or C2 as the Subdivided By field.

Non-polygon Map

You may now create a non-polygon map that shows points (e.g., cities) with graduated symbols. For example, previously, you could only use graduated symbols to show total sales of each country in Europe; now, you can use graduated symbols to show sales of each city in Europe.
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Miscellaneous Improvements

Several other areas that have been improved include:

Changing Map

Commonly, more than one map may display overlapping geographic regions, and the same geographic names may appear in more than one map. You now have an option in the Analyzer to change to a different map that shares a similar set of geographic names. You can do so by:

Step 1: Right-clicking in the Analyzer or the Map Navigator. Select “Change Geographic Map…” from the shortcut menu. This will invoke the new Change Geographic Map dialog box.

Step 2: The Change Geographic Map dialog box displays the name of the current map, and a list of names of candidate maps that you may choose to change to.
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Creating and Loading Map is Faster

There is significant performance improvement in creating a map and opening a report that contains a map. With the latter, in particular, the performance improvement is exponential if the data is mapped on points. 

Mapping on Group with Specified Values

You may now create a map based on a specified order group. The group must use the “is one of” predicate to select the values for the group. As in creating a map for any group, you must also have at least one summary field for that group.

Mapping on Running Totals

You may now create a map based on a running total field. In the Data tab of the Map Expert, for an Advanced map (previously called a Detailed map), you can select running total fields to map their values.

OLAP GRIDS / CROSS-TABS

There are various enhancements on formatting OLAP grids and cross-tabs. The following applies to both OLAP grids and cross-tabs, unless stated explicitly. (Please note: below assumes familiarity with OLAP terminology like input members, filter, page and qualified dimensions.)

Sample Grid Styles

There are now a number of pre-defined sample grid styles from which you can choose to format your OLAP grid or cross-tab. 

OLAP Grids

You can use these sample grid styles via:

· the new Style tab of the OLAP Report Expert, 

· the new Style tab of the Insert OLAP Grid Object dialog box. 

· the new Style tab of the Format OLAP Grid Object dialog box. 

Cross-tabs

You can apply a sample grid style to a cross-tab through the Style tab of the Format Cross-Tab dialog box, when you insert or format a cross-tab.

For example, to apply one of the sample grid styles to an OLAP grid using the OLAP Report Expert:
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Step 1: In the Style tab of the OLAP Report Expert, click on a style of your choice. The style is displayed in the right pane.

Step 2: When you click the Next, Back, Design Report or Finish button, you will be prompted to confirm whether you would like to replace the current style of the grid with the one selected. By confirming so, you will lose the customization you originally have, if any.

Step 3: Click Finish to view your grid formatted in the selected style. (To compare various grid styles, you can use the Format OLAP Grid dialog, apply a style to the grid and use undo and redo in the Preview Tab. Changes carried out through the OLAP Report Expert cannot be undone.)

Note that upon returning to the Style tab, the selected style is always the “Custom” style.

Grid Formatting

Several options have been added to allow you to format OLAP grids and cross-tabs more flexibly. 

OLAP Grids

These options are available in:

· the Customize Style tab of the OLAP Report Expert, 

· the Customize Style tab of the Insert OLAP Grid Object dialog box.

· the Customize Style tab of the Format OLAP Grid Object dialog box.

The following figure shows the Customize Style tab of the OLAP Report Expert.
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Cross-tabs

Now when you format a cross-tab, you will invoke the enhanced Format Cross-tab dialog box. The new formatting options for cross-tabs are available in the Customize Style tab of this dialog box.
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The screen shots illustrated below use an OLAP grid as an example.

Row and Column Totals Placement

As in Seagate Crystal Reports 7, by default, row totals are placed at the bottom (relative to the corresponding row input member, e.g., Bicycle), and column totals are placed on the right (relative to the corresponding column input member, e.g., Europe). (Note: an input member in OLAP terminology is analogous to a field in the realm of relational databases.)
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You now have an option to place row totals on the top (relative to the corresponding row input member), and another option to place column totals on the left (relative to the corresponding column input member).
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Indent Row Labels

Previously, each label of a row input dimension always occupied a column. Now you have an option to control the exact indentation of row labels, by checking “Indent row labels” and specifying in inches the indentation for each of the row labels. The amount of indentation can be as long as two pages. When you specify an indentation, all row labels, except the label for the input member of the first level (e.g., All Products), will be indented by the same amount, with respect to the row labels of the previous level of the same dimension (e.g., in the following example, "Bicycle" and "Accessory" are each indented 0.5 inch with respect to "All Products", and "Competition" and "Hybrid" are each indented 0.5 inch with respect to "Bicycle", etc.).

For example, if you specify row totals on the top, column totals on the left, and a 0.5 inch indentation for row labels, your grid will be like:

[image: image124.png]= S| wee v | mmsn | aeemst
o wwsn | monn vwss | ozt
po— s | o | omn s
s

Alllabels of row input mermbers are inderted by 0.5 inch,
exceptior the input member in the first level (i.e., "All products”).





Format Grid Lines

You may now format grid lines bordering row labels, column labels and cells. The format options include enabling or disabling a grid line, and specifying the color, style and width of a grid line that has been enabled. The width of a grid line is measured in number of points. You may choose from a drop-down list of supported widths. Hairline is the finest width you may specify for a grid line.

For example, to format grid lines of an OLAP grid:

Step 1: In the Customize Style tab of the Format OLAP Grid Object dialog box, click the  "Format grid lines" button. This will invoke the Format Grid Lines dialog box. 
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On the top of the Format Grid Lines dialog box is a sample grid. You can format grid lines by either clicking on a grid line in the sample, or selecting from the list of sets of grid lines in the bottom left pane.

While you may not format exactly individual grid lines, you may format grid lines in sets. When you click on a grid line in the sample grid, you will find that other grid lines in the same set are automatically selected as well. Similarly, when you select a set of grid lines in the list, corresponding lines in the sample grid are highlighted.

Step 2: In the Format Grid Lines dialog box, click on a grid line in the sample grid. Notice that grid lines in the same set are highlighted as well.

Step 3: Select the color, style and width of a grid line for that set of lines. Note that if you select a dashed or dotted style for a set of grid lines, the width is set to be hairline and cannot be modified.

Also, note that the width of the following pairs of lines must be the same:

· row label horizontal lines & cells horizontal lines

· row label top border & column label bottom border

· row label bottom border & cells bottom border

· row label left border & column label right border

· column label vertical lines  & cells vertical lines

· column label left border & cells right border
For example, setting the width of row label horizontal lines to 1.5 pt will automatically set the width of cells horizontal lines to be 1.5 wide as well.

Step 4: Click Draw to display the selected grid lines in the grid, or uncheck Draw to remove those lines from the grid. By default, this option is checked for all grid lines.

Step 5: For any other set of grid lines you would like to format, repeat Steps 2 - 4. 

Step 6: Check Show Grid Lines to display grid lines that have been enabled for the entire OLAP grid. Then click OK.
Conditional Cell Formatting

You can now conditionally format a cell in OLAP grids and cross-tabs based on the value of the row or column that the cell is in. 

Alias for Formulas

To identify a row or a column in the grid, you can set up an alias for formulas for that level of dimension. For convenience in the following discussion, aliases for formulas will be simply referred to as aliases.

For example, the following illustrates an OLAP grid, with Products in the rows, and Regions in the columns. 
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If you want to identify the columns under level 1 of the Regions dimension, you can first set up an alias called “Continents”:

Step 1: In the Customize Style tab of the OLAP Report Expert, or the Customize Style tab of the Format OLAP Grid Object dialog box, select a level of a dimension.

Step 2: Enter an alias for the selected level. In this example, enter “Continents” for level 1 of the Regions dimension.
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Format Cell with GridRowColumnValue

After creating the aliases for the levels of dimensions that you need to reference, you can then format cells on condition of the values of these levels. When you are formatting cells (as fields) in the Format Editor, you can click the conditional formatting button and invoke the Format Formula Editor. There you will find the new function GridRowColumnValue that, given its alias, returns the value of a level of a dimension.

In the same example as above, suppose you want to format the font color of the total sales of individual products for all of Europe to be red, and that under North America to be blue.

In OLAP terminology, you would be saying, if GridRowColumnValue(“Continents”) returns “Europe”, then you would like the font color of the cells for each level 2 input of the Products dimension to be red, otherwise, since there are only two continents in this scenario, the font color should be blue. You can then translate this as a condition in the Format Editor to format the font color of the cells: 

Step 1: In the Preview Tab, click on the total sales for the product “Competition” (one of the level 2 inputs for Products) for all of Europe (one of the level 1 inputs for Regions). 
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You will find that cells for all level 2 inputs for Products combined with all level 1 inputs for Regions are also selected. Formatting done to one of these cells will be carried over to all other selected cells.

Step 2: Right-click on one of the selected cells. Select Format Field from the shortcut menu.
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Step 3: In the Font tab of the Format Editor, click on the Conditional Formula button for color.

Step 4: Enter a formula for the color in the Formula Editor:

if GridRowColumnValue(“Continents”) = “Europe” then red else blue

Step 5: You will see the total sales of individual products for Europe highlighted in red, and the total sales of individual products for North America highlighted in blue.
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Page & Filter Dimensions

When you specify a page dimension, you show an instance of a grid for each of the selected values of that dimension. This was previously referred to as the "on change of" dimension. When you specify a filter dimension, you choose one of its values and display all instances of the grid based on this value of the dimension. This was previously referred to as the "is equal to" dimension. Qualified dimensions in an OLAP grid are dimensions that do not appear in the rows and columns of the grid. All qualified dimensions are filter dimensions by default.

Previously, you assigned page and filter dimensions in the “Other Dim” tab of OLAP Report Expert, the Insert OLAP Grid Object dialog box and the Format OLAP Grid Object dialog box. This tab has been replaced by the new “Filter/Page” tab.
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In the Filter/Page tab, there are two panes: the left pane initially shows all the qualified dimensions as filter dimensions, with a specific value set to each of them; the right pane shows filter dimensions, which is initially empty. You can drag and drop a dimension from one pane to the other.

Filter Dimension

To specify a value for a filter dimension, click on the field picker on the left of the field.

This will invoke the “Select a Field for Dimension…” dialog box. There, as before, you can choose an input member of the dimension as a selection criterion.

Page Dimension

In this release of Seagate Crystal Reports, if you want to generate a grid on the change of the value of a dimension, you can specify this in the Filter/Page tab of the OLAP Report Expert, and the Insert or Format OLAP grid Object dialog box. However, using the OLAP Report Expert will be the easiest for novice users.

A Group for Each Selected Input Member of a Page Dimension

Before, grids were always placed in the details section when you created them. Now when you select individual input members from possibly different levels of a page dimension and create a grid for each of the selected input member, each of these grids is automatically created in its own group header section in the report. This allows you to traverse the group tree to conveniently locate a grid. It also supports creating a map or chart based on an OLAP grid (for more information on this new feature, please see the section “Mapping on OLAP Grids” above.)

Specifying a Page Dimension using the OLAP Report Expert

Individual grids corresponding to selected input members of a page dimension now appear in their own groups. You can select such input members only through the OLAP Report Expert.

Using the OLAP Report Expert, when you click on the field picker on the left of a page dimension, you will invoke the “Select Fields for Dimension…” dialog box. There, you can choose individual input members in a level of a page dimension, and create a grid for each selected input member. 

Example 1: Use the OLAP Report Expert to Specify “timemth” as a Page Dimension

For example, you would like to specify the “timemth” dimension as a page dimension. Using the OLAP Report Expert, you can choose individual input members in level 1 (e.g., Quarter 01 95, Quarter 01 96) and level 2 (e.g., Jan 95, Jan 96). You do not necessarily have to include the entire level 1 (i.e., the level for all the quarters for each year) and level 2 (i.e., all the months in each quarter) as before.
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After you click Preview Report to exit the OLAP Report Expert, you will have four instances of the grid in two groups, with two instances in each group.
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Specify only the Level of a Page Dimension through Insert OLAP Grid Object

As explained above, if you want to generate grids on the change of a dimension, or change the page dimensions for an existing grid, you should use the OLAP Report Expert.

You can use the Insert OLAP Grid Object command to insert a grid in the same group as another grid for comparison, or insert a grid into the group header section of a relational report. In both scenarios, the group field used in the group should be the same as the dimension that the inserted grid is paged on. Furthermore, because you are inserting the grid into an existing group, you may only specify a level (instead of a specific input member) of the page dimension to generate the grid for.

Example 2: Inserting an OLAP Grid into an Existing Grouping of the same Page Dimension

Based on Example 1 above, suppose you would like to compare the sales of a couple of products with those in Example 1 in the same regions for the months of Jan 95 and Jan 96. Ideally you would like to be able to insert OLAP grids showing the sales of these products adjacent to the two grids in the grouping Jan 95 and Jan 96 in Example 1.

You may do so through the Insert OLAP Grid Object command:

Step 1: In the Rows/Columns tab, define the rows and columns of the new grids as specified above 

Step 2: In the Filter/Page tab, drag and drop the dimension “timemth” from the filter dimensions pane on the left to the page dimensions pane on the right. This will invoke the ‘Link Dimension “timemth” to Relational Field’ dialog box.

Step 3: In the ‘Link Dimension “timemth” to Relational Field’ dialog box, choose level 2 of “timemth”. 
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After inserting the new grids, at level 2 (i.e., Jan 95 and Jan 96 in the group tree), you will find:
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Change the Level of a Page Dimension through Format OLAP Grid Object 

You should use the Format OLAP Grid Object command to change row, column or filter dimensions, or format the style of an existing grid. You can also use this command if you have inserted or copied and pasted a grid to a group, and subsequently you would like to change the level of the page dimension of the grid to match the level of the group.

Example 3: Changing the Level of Page Dimension of Inserted Grids

Using the grids you have set up in Example 1 above as an example, suppose you have inserted two more grids with Level 0 (i.e., Year) specified for the page dimension “timemth”, in the same grouping for Level 1 (i.e., Quarter) of the same page dimension “timemth”.

Initially after the insert, your grids will look like:
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You will then format the page dimension of the newly inserted grids, specifying Level 1, through the Format OLAP Grid Object command.
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The inserted grids will now page on the same level of grouping as the existing grids (i.e., Level 1).
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OLAP Labels

Previously, the values of qualified dimensions are displayed as field objects outside of the grid. 

Now you may display in an OLAP label the values of qualified dimensions as part of an OLAP grid. These values are displayed as text objects within an OLAP label in the Preview tab. In the Design tab, the names of these qualified dimensions are displayed as text objects within the OLAP label. 

OLAP labels only apply to OLAP grids. They are not supported in cross-tabs.

Inserting

You can insert an OLAP label through the new Labels tab of the OLAP Report Expert, the Insert OLAP Grid Object dialog box or the Format OLAP Grid Object dialog box. By default, all qualified dimensions are labeled dimensions.
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Follow these steps to insert an OLAP label:

Step 1: Choose the qualified dimensions to be included in the OLAP label. By default, all qualified dimensions are included.

Step 2: If necessary, order the qualified dimensions the way you would like them to be displayed in the OLAP label.

Objects in an OLAP label are arranged in rows, from left to right and top to bottom. You may specify how far apart to place these objects:

· Vertical Gap: the space between two rows of objects, and between the top (or bottom) border of the OLAP label and the first (or last) row of objects.

· Horizontal Gap: the space between two objects in a row, and between the left (or right) border of the OLAP label and the first (or last) object in the row.

The unit of measurement for these gaps is determined by the Regional settings you have set up in the Control Panel.

Step 3: Specify the spacing between objects in the OLAP label, and between an object and the border of the OLAP label. 

Step 4: Specify whether or not to display the OLAP label, and if so, where to display it. 

You may choose one of the following display options:

· Don't display labels: Do not display any OLAP label. Consequently, no space will be reserved for it. 

· Top: Display the OLAP label above the OLAP grid. This is the display option by default.

· Left: Display the OLAP label to the left of the OLAP grid.

Step 5: Click OK.

Other Formatting Options for an OLAP label

· After you have inserted an OLAP label, you can format it by selecting it and right-clicking on it, and then selecting “Format OLAP Grid Labels” from the shortcut menu. (Note: you should select the entire OLAP label and not an individual object in the label.)

· You may re-order objects within the OLAP label, remove or move the position of the label to the top or left of the grid through the "Format OLAP grid Labels" option. (Note: you may not do so just by selecting the OLAP label in the Design or Preview Tab. You must use the "Format OLAP grid Labels" option.)

Formatting Options for Objects within an OLAP label

· You may format objects within the OLAP label as if they are outside of an OLAP label, except that you may not move them within the OLAP label.

· If you select Suppress for an object in an OLAP label, no object will be displayed, but there will be a space reserved for it.

Synchronized Set Location for Relational Database and OLAP Cube

If you have a report that accesses both relational and OLAP databases and these databases are in the same location, setting location for one will prompt that for the other.

After you have changed the location of one type of data source (e.g., by using Set Location for a relational database), you will be prompted to change the location for the other type of data source (e.g., prompted to set OLAP cube location).

(Note: for each OLAP report, a relational database is implicitly generated in the same location as the OLAP data source. Thus when you set OLAP cube location for a report created off an OLAP data source, you are automatically prompted to set location for a relational database as well.)

SQL DATABASES

Improvements for SQL databases include the following:

Select Distinct Records

There is now an option that allows you to select only unique records from SQL tables in your database. You can toggle this option on or off for a report through the new item “Select Distinct Records” in the Database menu. 
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Alternatively, you can also set this option for the current report in the Report Options menu. By default, this option is not selected.
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Browse Distinct Records

Previously, when you browsed a field from a SQL table, you would see the unique values in the first 500 records (or up to the total number of records if there were fewer than 500). Now you have the option to browse up to the first 500 unique values of a field. That is, for instance, if the data has 2000 records and the first 500 unique values of a field occur in the first 1000 records, and you choose this option, you will be browsing the first 1000 records.

You can set this as a local option to only the current report through the Report Options menu (see figure of the Report Options menu above), or as a default option to all new reports through the Database tab of the Options menu (see figure following). By default, this option (for both the current report and new reports) is selected.
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Note that since most SQL servers do not support selecting distinct records for long data types such as memo and blob fields, selecting and browsing distinct records are not supported for such fields in the Crystal Report Designer.

SQL Query Update

There are multiple ways of specifying the SQL selection criteria for a report: 

· the Select Expert, 

· the Edit Selection Formula command, and

· the Show SQL Query command in the Database menu.

Previously, if you had manually modified the SQL query through the Show SQL Query command, your changes could be overwritten by subsequent changes made through the Select Expert or the Edit Selection Formula command.

Now you may not overwrite changes made through the Show SQL Query command. Instead you will be warned that there are two sources of selection criteria. The only way to remove the changes made through the Show SQL Query command is to use this command and hit the "Reset" key.

Now, as a result, two sources of selection criteria can exist simultaneously. The selection criteria modified in Show SQL Query will be used first and most likely sent to the server for processing. The resulting records which match the SQL query will then be passed through the 2nd set of criteria. The final records in the report will have to match both sets of criteria.

Smarter Visual Linking Expert

The Visual Linking Expert has been enhanced in the following ways:

· to show a tool tip for each link, 

· to link tables in a smarter and more efficient way, e.g., when adding table C to tables A and B that link A->B, previously B would first be checked if it links with C, but now A will first be checked,

· to give more warnings, e.g., for tables A, B and C that link A->B and C->B, a warning that there are multiple starting points will be given, and

· to use foreign key information in the following databases: Oracle and SQL Server databases accessed via native, ODBC or OLE DB drivers, Informix databases accessed via ODBC and OLE DB (through ODBC), and Access via OLE DB (using Microsoft OLE DB provider for Access).

Utilize Foreign Key Information in Database

In the Visual Linking Expert, choose:

· Link Tables by Name – to link tables in the same way as before, or

· Link Tables by Key – to link tables using any foreign key information in the data.

For example, if you link the following three tables by name, then all fields that match in name will be linked.
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You can link these tables according to their foreign key information, by clearing existing links by name, and selecting linking by key:
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ENTERPRISE RESOURCE PLANNING

There are several enhancements to support Enterprise Resource Planning (ERP).

Hierarchical Grouping

You may now use hierarchical grouping to arrange data in a report to show hierarchical relationships in the data. This is useful, for instance, in reporting off a Human Resources database to show the reporting structure within a company.

The following example illustrates a four-level hierarchy in a Human Resources database, showing supervisory relationships.

The Database

The database is an Access table showing the Employee ID, First Name and Supervisor ID for each employee (except for the owner of the company there is no Supervisor ID).
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The Hierarchical Report

Suppose you would like to generate a report showing the supervisory hierarchy in this database. Each employee will be displayed with his / her Employee ID and First Name, under the corresponding supervisor.

Step 1: Insert a group based on the Employee ID. Suppress the group header to avoid repeating the Employee ID in the group header in this case.

Step 2: In the Report menu, choose Hierarchical Grouping Options. This invokes the Hierarchical Options dialog box.
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Step 3: In the Hierarchical Options dialog box, select the appropriate group that you would like to show hierarchical relationships, and check Sort Data Hierarchically. In this example, there is only one group, the Employees.EmployeeID group. 

[image: image148.png]RS {— 1. Checkhis to enable sarting data hierarchically.
¥ St Das Hehicall

Instance ID Field

Eoo b0 | 2 Thisfield identiies each item inthe hierarchy.
ParentID Field
= Employess SupervisalD || 3. Specity field thatidentifies the parent of

- each tem inthe hierarchy.

T

| 4 Specity the amount ofindentation for

B Help each level in the hierarchy.

The leftpane is alist of all groups
inthe current report




Step 4: The Instance ID Field is the field that identifies each item in the hierarchy. Depending on the group that you have selected on the left pane, it is the field that you group on. In this example, it is the Employee ID field.

Step 5: Select a field for the Parent ID Field. The Parent ID Field is the field that identifies the hierarchical relationship for each item in the hierarchy. In this example, we specify the Supervisor ID field.

Step 6: Specify Group Indent which is the amount of indentation for each level in the hierarchy. The acceptable range is between 0 and 4 inches (or between 0 and 10.16 cm if you have specified to use metric in the Regional Settings of the Control Panel). In this example, we specify 0.5 inches.

Step 7: The resulting report is shown below. Notice that the group tree shows the supervisory relationships as well.
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WEB VIEWING

Web viewing has been enhanced with a faster, multi-threaded Crystal Report Print Engine (CRPE) on the server side. The CRPE has increased its capacity to process multiple simultaneous jobs, to meet the demands of increasing number of users with more report instances and larger reports. Now jobs that can be carried out on their own and that do not interfere with further processing are executed as separate threads.

The Crystal Report Viewers for Java and ActiveX have been enhanced for usability. The following improvements apply to both Crystal Report Viewers.

View Report Sooner

You can start viewing a report and navigating the group tree before the entire report (including the entire group tree) has been loaded. 

You can now begin viewing a report sooner even if your report requires a total page count for page numbering, as the total page count is completed and inserted properly back to read pages when the last page of the report is eventually read. The group tree is now loaded on-demand, allowing you to view even when only a partial group tree has been loaded.

Crystal Report Viewer for HTML

Enhancements for the Crystal Report Viewer for HTML include:

Text Rotation

You may display rotated text in a report in this Viewer, with the following conditions:

· The object that contains the rotated text (string field, memo or text object) must have the same fixed-size font (e.g., Courier) and font size for all the characters.

· If the font used in the object is a Latin font (e.g., English, French, Spanish, etc.), with text rotation of 90 degrees, for example, the text will run from bottom to top, left to right, and each character will be upright (and not rotated 90 degrees as in the Crystal Report Designer). The same applies if the rotation is 270 degrees: each character will appear upright and not rotated.

· If the font used in the object is a vertical font (e.g., Japanese), then with text rotation, each character will also appear in the upright position.

Close-to-Original Viewing

If you use the Crystal Report Viewer for HTML on a browser that supports Dynamic HTML capabilities, the Viewer will be able to display your report close to what you see in the Crystal Report Designer with respect to positioning of objects, font type and font size.

Crystal Report Viewer for Java

The Crystal Report Viewer for Java has been improved in the following areas:

100% Pure Java

The Crystal Report Viewer for Java is certified to be 100% Pure Java, independent of the platform you run on.

Compatible with Java Runtime Environment 

The Crystal Report Viewer for Java is compatible with Sun’s Java 2 Runtime Environment v.1.2.2, and runs consistently and reliably on both Internet Explorer and Netscape browsers.

Better Image Quality

You will find that in the Crystal Report Viewer for Java, the quality of images (e.g., charts, maps) has been enhanced.

Text Rotation

Under Java 2, you may display rotated text in reports as it is displayed in the Crystal Report Designer. 

However, under Java 1.0 and 1.1, you may display rotated text only in vertical fonts (e.g., Japanese), but not Latin fonts (e.g., English, French, Spanish, etc.).

Crystal Report Viewer for ActiveX

The Crystal Report Viewer for ActiveX has been improved in the following areas:

Higher Quality Printing from Netscape Browsers

Now you can print reports close to WYSIWYG quality on a Netscape browser using the Crystal Report Viewer for ActiveX.

To use the Crystal Report Viewer for ActiveX on a Netscape browser, you require a Netscape plug-in for ActiveX. This plug-in is automatically installed for you when you install this release of Seagate Crystal Reports. However, if you are not viewing on the same machine as where you have installed Seagate Crystal Reports, when you use the Crystal Report Viewer for ActiveX on a Netscape browser for the first time, you will be prompted to download and install the plug-in on your machine. 

Multithreading

The Crystal Report Viewer for ActiveX is now capable of processing multiple threads simultaneously. In some scenarios, you will notice marked improvement in efficiency. For example, you can now navigate in a large group tree while loading of the report continues. You can also use the page forward button repeatedly to advance to a page more quickly, with each page being downloaded in parallel with one another, rather than sequentially.

New Look for Toolbar

The toolbar for the Crystal Report Viewer for ActiveX now has a stylish flattened look. You can also customize by sizing sections of the toolbar.
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Go To Page

You can now specify a page number to go to in the report you are currently viewing.

Search

The search function has been streamlined. To search, click on the new search icon and then specify the text to search.

Help Button for Applications

There is now a Help button implemented for applications. Clicking on the Help button will fire an event to the containing application; the application should in turn display the appropriate help. This button is turned off by default.

For example, if the containing application uses HTML and runs on the Internet Explorer, do the following to turn on the Help button:

<OBJECT …>

<PARAM NAME = ”EnableHelpButton”  VALUE=1>

</OBJECT>

As another example, if the containing application uses Visual Basic, then you can turn on the Help button by setting CRViewer.EnableHelpButton to TRUE.

After turning on the Help button, the application should display the appropriate help text.

Developers’ Tools

This section describes the enhancements in the developers’ tools of Report Integration Controls for Visual InterDev, the Crystal Report Print Engine API and the Report Designer Component.

REPORT INTEGRATION CONTROLS FOR VISUAL INTERDEV

The Report Integration controls allow Web developers using Microsoft Visual InterDev 6.0 to write Web applications that generate Crystal reports hosted on either a Web Reports Server or an ASP server. End users of these applications would then view these reports using a Crystal Report Viewer running on a browser. 

Developers of these applications have control over logging on to database servers, prompting of parameters and the specification of selection formulas in these reports. Developers can choose to allow their users to view reports using the Crystal Report Viewer for Java or the Crystal Report Viewer for ActiveX. Developers can also decide which properties to enable for the end user within the Viewer (e.g., printing, exporting).

The information below is directed to the developer of Web applications using the Report Integration Controls.

Installation

The Report Integration Controls are installed by default in the folder SEAGATE SOFTWARE\SHARED\DESIGN TIME CONTROL. Initially, to set up the Report Integration Controls as Design Time Controls (DTC’s) for use in Visual InterDev 6.0:

Step 1: Right-click in the Visual InterDev Toolbox. Choose Customize Toolbox from the shortcut menu.

Step 2: In the Customize Toolbox dialog box, select the Design Time Controls tab. Check the two items ReportSource and ReportViewer.

The Report Integration Controls are comprised of the two DTC’s, ReportSource and ReportViewer. You will find that these two DTC’s are added to the Visual InterDev Toolbox. We will call them Report Source Control and Report Viewer Control below.

Adding Reports to the Current Project

A report must be first added to the current Visual InterDev project before you can apply any DTC’s to it.

Report Source

When you insert the Report Source Control into your Web application, you create an instance of the Report Source Control. Its name is ReportSourcei, where i is the i-th instance of the Report Source Control, i=1,2,3…
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When you right-click on an instance of the Report Source Control, you will invoke the Report Source Properties dialog box. 

The properties you can specify for an instance of the Report Source Control include:

· General information: In the General tab of the Report Source Properties dialog box, you may attach a report to this instance of the Report Source Control from the list of reports included in the current project.

The following is an example of the General tab if your report is hosted on an ASP server.
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· Logon information for database: In the Accounts tab of the Report Source Properties dialog box, you can specify the server and database names for each of the tables used in the attached report, and test connectivity for each of these servers after entering the logon information.

If the report is hosted on a Web Reports Server, you may leave the logon information blank, which will in turn prompt the end user to enter the logon information. If the report is hosted on an ASP server, then you must enter the logon information.

[image: image153.png]Geredl Accarts | Paraneters | Formua]

Databass Accourts

Severae Dalabase Nane Cube Nane
B Goodhye2 pubs
- Edi Cdentls
Server name: Goodbye?
Detabascname:  pubs
Subrepot name:
Cube name:
User ld oot
Bassword
oK Cacel | ooy | e

For each of the tables inthe report you may
enter logon information andtest ts
connectivity.




· Parameters: In the Parameters tab of the Report Source Properties dialog box, if the report is hosted on a Web Reports Server, you may specify whether to prompt   the end user to choose from a default list of values, or enter a value for a parameter.
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However, if the report is hosted on an ASP server, then you must choose a value for each input parameter.

· Selection formula: In the Formula tab of the Report Source Properties dialog box, you may specify your own selections formulas, or to modify existing selection formulas.
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Report Viewer 

When you insert the Report Viewer Control into your Web application, you create an instance of the Report Viewer Control. Its name is ReportVieweri, where i is the i-th instance of the Report Viewer Control, i=1,2,3…
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When you right-click on an instance of a Report Viewer Control, you will invoke the Report Viewer Properties dialog box. 

The properties you can specify for an instance of the Report Viewer Control include:

· General information: In the General tab of the Report Viewer Properties dialog box, you can select an instance of a Report Source Control and attach it to this instance of the Report Viewer Control. Upon clicking the Advanced button, you can specify a virtual path which is an alias to the directory of the Report Viewer Control.
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· Options for end users: In the Options tab of the Report Viewer Properties dialog box, you may specify for the end user:

· the Viewer to use, whether it is the Crystal Report Viewer for Java or Crystal Report Viewer for ActiveX,

· the language to use for the Crystal Report Viewer, depending on the fonts installed on the current system,

· the size of the Crystal Report Viewer,

· the ability to refresh report in the Crystal Report Viewer,

· the ability to print report in the Crystal Report Viewer,

· the ability to export report from the Crystal Report Viewer,

· the ability to search in report in the Crystal Report Viewer,

· the ability to drill down in report in the Crystal Report Viewer,

· the ability to prompt on refresh of report in the Crystal Report Viewer,

· the ability to generate group tree in the Crystal Report Viewer, and

· the ability to display group tree in the Crystal Report Viewer.
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CRYSTAL REPORT PRINT ENGINE API

The following lists the enhancements pertaining to the Crystal Report Print Engine (CRPE) API in this release of Seagate Crystal Reports 8. Where new API structures and functions are introduced or existing ones enhanced, this document only explains their semantics; you can refer to Appendix B: Changes to Crystal Report Print Engine API (CRPE API) and CRPE.H for the exact syntax.

Launch Seagate Analysis

You may now click a button on the preview window toolbar to launch Seagate Analysis and open the current report.

A new event, LaunchSeagateAnalysisEvent, has been added. If you enable the event, and the user clicks the Launch Seagate Analysis button, LaunchSeagateAnalysisEvent will be fired. The user shall then be prompted to save the file, and Seagate Analysis shall be launched with the current report opened. 

There are a number of other enhancements in the CRPE API that complement those in corresponding components of the Crystal Report Designer.

Seagate Crystal Reports 8 Enhancements

Among them, those that correspond with enhancements in this release include the following:

Basic and Crystal Syntax Support

Since the formula language supports the Basic and Crystal syntaxes, existing Formula API calls have been modified such that the function calls with SET uses the syntax specified by the user, and those with GET sets a flag that the user can later retrieve. Two new API calls, PESetFormulaSyntax and PEGetFormulaSyntax, have also been added.

Charting Enhancements

There are several enhancements for charting:

· Automatic Scaling for Axes

Please refer to the section “Automatically Scale Data Axis” above for a detailed description of this feature in the Crystal Report Designer.

In the CRPE API, there are new elements supported in the structure, PEGraphAxisInfo: dataAxisYAutoScale, dataAxisY2AutoScale, seriesAxisAutoScale. You may use the CRPE API calls, PEGetGraphAxisInfo and PESetGraphAxisInfo, to obtain or set automatic scaling for the graph axes.
· Default Titles

Now in the Crystal Report Designer, by default there are title, subtitle, footnote, X-axis title, Y-axis title and Z-axis title. In the CRPE API, you can use  PEGetGraphTextDefaultOption and PESetGraphTextDefaultOption, specifying a value PE_GTT_*  that corresponds to each of the titles, and useDefault as TRUE or FALSE.
· Legend Layout

Please refer to the section “Legend Enhancements” above for a detailed description of this feature in the Crystal Report Designer.

In the CRPE API, you may set the legendLayout element in PEGraphOptionInfo to one of  PE_GLL_*. You may use the CRPE API calls, PEGetGraphOptionInfo and PESetGraphOptionInfo, to obtain or set legend layout options.
Hierarchical Grouping 

In the Crystal Report Designer, you may now use hierarchical grouping to arrange data in a report to show hierarchical relationships in your data. (For more information on this feature in the Crystal Report Designer, please refer to the section “Hierarchical Reporting” above.)

To support hierarchical grouping, the PEGroupOptions structure, the PEGetGroupOptions and PESetGroupOptions calls in the CRPE API have been modified.

Hyperlinks & On-demand Subreports

The CRPE API has been enhanced to support hyperlinks and on-demand subreports:

· new structure elements in PETrackCursorInfo:

· short ondemandSubreportCursor - cursor to show over on-demand subreports when drilldown for the window is enabled; default is PE_TC_MAGNIFY_CURSOR; and 

· short hyperlinkCursor - cursor to show over report object that has hyperlink text; default is PE_TC_HAND_CURSOR.
· new cursor types:

· PE_TC_BACKGROUND_PROCESS_CURSOR,

· PE_TC_GRAB_HAND_CURSOR,

· PE_TC_ZOOM_IN_CURSOR,

· PE_TC_REPORT_SECTION_CURSOR, and

· PE_TC_HAND_CURSOR.

WYSIWYG Support

Users of applications using CRPE API can now view and print reports with close to WYSIWYG results. The improvement is significant in text objects and string and memo fields.

REPORT DESIGNER COMPONENT

The following lists the enhancements pertaining to the Report Designer Component in this release of Seagate Crystal Reports 8.

Unbound Fields

You can now insert an unbound field into a report at design time, and bind the field object to an actual database field at runtime. This allows more capability of customizing the report at runtime.

In the new field tree in the design view, you can choose to insert from 7 types of unbound fields: Boolean, Currency, Date, Date/Time, Number, String and Time. You can insert an unbound field at design time by selecting the type of unbound field from the field tree, then dragging and dropping it into the report.
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In the Report Designer Component runtime, you can add an unbound field object to a section using the new function, AddUnboundFieldObject, under the class, Section. 

To bind the unbound field to a database field at runtime, you can use the new method, SetUnboundFieldSource. For example:

UnboundNumber1.SetUnboundFieldSource = “{Customer.CustomerID}”

Alternatively, you may use automatic unbound field binding, based on either the field name or the type of the field value, or based on both. To do so, use the new method AutoSetUnboundFieldSource, and specify one of the constants crBMTName or crBMTNameAndValue for CRBindingMatchType.

Report Creation 

Report creation functionality has been added to the Report Designer Component. Such functionality enables building applications that include dynamic report creation at runtime. However, please note that a runtime license is required for distributing applications using this functionality. For more information on acquiring a runtime license and a complete list of objects, properties and methods supporting this functionality, please refer to the help file, Royalty Required Runtime.hlp.

The method EnableFeatures under the Application object has been deleted.

Data Environment Support for Adding Database

In the Report Designer Component, you may create a report based on a command in a VB Data Environment, which references a valid connection to a data source. When you add a database to a report, if there is a valid active Data Environment, you can choose from commands in that Data Environment.

More Events

Additional events have been added under the Report object in the Report Designer Component runtime:

BeforeFormatPage & EndFormatPage Events

The BeforeFormattingPage and EndFormattingPage events are fired before and after formatting a page respectively.

FieldMapping Event

The FieldMapping event is fired if a database is changed while verifying database.

NoData Event

The NoData event is fired when there is no data. If there is a subreport, this event is only fired for the main report. 

This is particularly useful when you need to know whether a report has data when going to run mode. If there is no data, you can decide whether to continue printing.

Report Variables

Certain events, like the OnSectionFormat event, may get fired more than once in a section. You can now declare report variables that help you maintain the status of, for example, a running total, for each firing of the event, and you may retrieve the status at some appropriate time.

To support report variables, the interface, IReport, and the methods, AddReportVariable, GetReportVariableValue and SetReportVariableValue, have been added.

Set OLE Object Location

You can set the location of an OLE object at runtime using the new method, SetOleLocation, under the ICROleObject interface. You can change an OLE object to point to different files at run time including image files. 

The existing method, SetFormattedPicture, is still supported. Note that if you use both SetFormattedPicture and SetOleLocation, SetFormattedPicture overrides SetOleLocation. 

Also note that if an OLE object is in the detail section, and for every detail record, you call SetOleLocation in OnFormat event, this will affect the performance significantly.

Show Object Names for Fields

In the design view, you may now choose to display a field using its object name that corresponds to the value of the Name property in the VB Properties Window.

You can set this option in the Layout tab of the Default Settings dialog box.
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Miscellaneous Enhancements

There are a number of other enhancements in the Report Designer Component that complement those in corresponding components of the Crystal Report Designer.

Among them, those that correspond with Seagate Crystal Reports 8 enhancements include the following:

Accounting Conventions

To support conventions used in accounting, you may now control how the negative symbol, currency symbol and zero value are displayed, and reverse the sign when displaying numbers in accounting reports. For more information of this feature in the Crystal Report Designer, please refer to the section “Accounting Conventions” under  “Other Usability Enhancements” above.

In the Report Designer Component runtime, these properties have been added to the FieldObject class: UseReverseSign and ZeroValueString.

Basic Syntax

The Report Designer Component runtime can now support both Crystal and Basic formula language syntax. Currently, the same report may contain formulas in Crystal and Basic syntax, except that if you must edit record or group selection formulas, these formulas must be in Crystal syntax. For more information on the enhancements on Crystal and Basic syntaxes, please refer to Appendix A.

The following properties have been added to the Report class:

· FormulaSyntax

· LastGetFormulaSyntax

By using these properties, you may first set the FormulaSyntax property before creating a new formula, then set the formula text. After getting a formula text, you may get the property LastGetFormulaSyntax to obtain the formula syntax.

Charting Enhancements

The following charting enhancements are carried through the Crystal Report Designer and the Report Designer Component:

· Automatically Scale Data Axis
Please refer to the section “Automatically Scale Data Axis” above for a detailed description of this feature.

In the Report Designer Component runtime, these new properties have been added under the class GraphObject: EnableAutoScaleDataAxis, EnableAutoScaleData2Axis and EnableAutoScaleSeriesAxis.

· Legend Enhancements
Please refer to the section “Legend Enhancements” above for a detailed description of this feature.

In the Report Designer Component runtime, the new enumerator type CRPieLegendLayout has been added, and the new property LegendLayout has been added under the class GraphObject.

· Chart on All Records
Please refer to the section “Chart on All Records” above for a detailed description of this feature.

· Chart on Running Totals
Please refer to the section “Chart on Running Totals” above for a detailed description of this feature.

· Default Titles for Charts
Previously, when you used the Report Expert to create a chart, there is no title unless you specify one. Now by default there are title, subtitle, footnote, X-axis title, Y-axis title and Z-axis title. 

In the Report Designer Component runtime, these properties have been added to the GraphObject class: 

· IsTitleByDefault

· IsSubTitleByDefault

· IsFootnoteByDefault

· IsXAxisTitleByDefault

· IsYAxisTitleByDefault

· IsZAxisTitleByDefault

· Font Change for Chart Elements

You may now change the font for chart elements. 

In the Report Designer Component runtime, properties have been added to the GraphObject class to change the font for these chart elements: title, subtitle, footnote, group title, data title, series title, legend, group labels, data labels and series labels.

· New Formats for Data Points and Data Axes in Charts

Four new formats have been added to the Chart Expert to format data point values and data axis values: 1K, 1M, $1K and $1M. 

In the Report Designer Component runtime, the following properties have been added to the GraphObject class:

· DataAxisNumberFormat

· Data2AxisNumberFormat

· SeriesAxisNumberFormat
Cross-tab Formatting

The enhancements in the Crystal Report Designer to format cross-tabs (e.g., predefined grid styles, formatting separate grid lines) are also available in the Report Designer Component at design time. Please refer to the section “OLAP Grids / Cross-tabs” above for a more detailed description of these features in the Crystal Report Designer.

To support multiple cell selection in a cross-tab, the Report Designer Component runtime has to be able to identify whether a field object or a text object in a cross-tab belongs to the same cross tab object (i.e., the parent of a field object or a text object in a cross tab). Two methods have been added in IDFieldObject and IDTextObject: getFieldObjectInCrossTabParent, and getTextObjectCrossTabParent. When you get a field object or a text object in a cross-tab, you can use these methods to get its parent (cross-tab object).

Data Explorer

The Report Designer Component has been enhanced to use the Data Explorer when you:

· use a Crystal Report Designer driver to create a report through the Report Expert, 

· perform a Set Location, or 

· perform an Add Database. 

For more information on the Data Explorer, please refer to the section “Creating Reports with the Data Explorer” above. 

Fractional Point Font Support

You may now specify a fractional point size for text objects and database fields, including the 10.5 point font commonly used in Japanese. To do so, select a text object or database field, and type in a fractional point size in the Font tab of the Format Editor.

Hierarchical Reporting

You may select hierarchical grouping for your report in the Report Designer Component, by right-clicking and choosing Report | Hierarchical Grouping Options. This will invoke the Change Hierarchical Options dialog box. For more information and an example of how to use this feature, please refer to the section “Hierarchical Reporting” above.

In the Report Designer Component runtime, the following properties have been added under the Area class:

· EnableHierarchicalGroupSorting

· ParentIDField

· InstanceIDField

· GroupIndent

By using these new properties, you can specify the InstanceIDField and ParentIDField to organize the group sorting tree, set the GroupIndent to affect the layout, and toggle to enable or disable hierarchical group sorting.

Hyperlinks

You may now select an object in the design view, and create a hyperlink to a Web site, e-mail address or a file. You can also create a hyperlink to a Crystal report file.

To create a hyperlink to a Web site, e-mail address or a file (note: for Crystal report file, see below), select an object (e.g., text, bitmap, chart) in the design view. Right-click, and select Format. Go to the new Hyperlink tab in the Format Editor. For further information, please refer to the section “Linking to a Web Site or E-mail Address” above.

You can create a hyperlink to another Crystal report as an on-demand subreport by having no object selected in the design view, right-click and select Insert | Hyperlink. For further information, please refer to the section “Linking to Another Crystal Report” above.

Inserting Running Total

This is a shortcut for you to create a running total based on a selected database field.

Step 1: In the design view, select a database field.

Step 2: Right-click and select Insert Running Total. This will invoke the Create Running Total Field dialog box which automatically sets up the running total for the selected field.

Inserting Subtotal, Summary, Grand Total 

Previously, you had to first select an appropriate database field (that could be subtotaled or summarized) before you could insert a subtotal, summary or grand total.

Now without selecting any object in the design view, you can insert a subtotal, summary or grand total. In addition, when you insert a subtotal or summary field for grouped data, you now have these two options:

· to insert a subtotal or summary field for each of all groups, or

· to insert a grand total field based on the subtotal or summary field.

For an example that inserts a summary, please refer to the section under “Summaries” above for the Crystal Report Designer.

Note that as before, if you are creating the summary for grouped data, and in the design view you have selected an object that cannot be summarized, then the menu item Insert | Summary will be disabled. The same applies to subtotal and grand total fields.

Optimized Group Tree Creation & Deletion

Group tree creation and deletion at runtime have been optimized, such that you can begin viewing the first page of a report or navigating its group tree before the entire report and group tree have been loaded.

Percentage Summary Fields

The Report Designer Component now supports the new Percentage Summary field. For more information on how to create a Percentage Summary field, please refer to the section “Percentage Summary Fields” above for the Crystal Report Designer.

In the Report Designer Component runtime, the following changes have been made to support Percentage Summary fields:

· added CRSTDPercentage to the enumerator type CRSummaryType,

· added the functions Add and Delete to the SummaryFieldDefinitions class.

Save As Version 7 Format

The report file format has been changed in Seagate Crystal Reports 8. Consequently, there is an option in the Crystal Report Designer to allow you to save a report in either the Version 7 or Version 8 format. Similarly, in the Report Designer Component runtime, there is a new method under the IReport interface, SaveAs, that allows you to specify file format (Version 7 or Version 8) in which you would like to save your report.

The previously used method Save is now hidden.

Save Preview Picture

In the Crystal Report Designer, you now have the option to save a snapshot of the first page of a report for previewing in the file open dialog box. (For more information about this feature in the Crystal Report Designer, please refer to the section “Displaying Preview on Opening Report” above.)

In the Report Designer Component runtime, under the IReport interface, two methods have been added: get_SavePreviewPicture and put_SavePreviewPicture. You can use get_SavePreviewPicture to get the option, and use put_SavePreviewPicture to set the option.
Select Distinct Records

You may now specify to select only unique records of a database field. In the IReport interface, EnableSelectDistinctRecords, has been added to allow you to set or get this option from the user.

For more information on selecting distinct records in the Crystal Report Designer, please refer to the section “Select Distinct Records” above.

Speed Up Loading of First Page

In the Report Designer Component runtime, you can now specify to load the first page of a report before reaching the end of the report and the total page count is computed. For reports that display the page number as Page N of M, there is a placeholder for the total page count, and when the total page count is eventually ready, it will be inserted back to each page.

To support this feature:

· In the IPageEngine interface, the property PlaceHolderOptions has been added. You may use it to specify whether you want to delay the total page count generation.

· In the IPage interface, IsMissingTotalPageCount has been added. You can use it to find out whether a page is missing the total page count

This feature is particularly useful if you use the Report Designer Component runtime to write Web servers, where the end-user can benefit from this improvement and view the first page of a large report much sooner than before.

String Search

You may now search field names (or object names if fields are displayed in these names instead) for strings. 

To search:

Step 1: In the design view, do not select any object, right-click and choose Find from the shortcut menu. This will invoke the new Find dialog box. 

Step 2: In the new Find dialog box, specify the string to search. You may also specify the search direction, and any matching criteria.
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Selecting & Formatting Cells in Cross-tabs

You may now select individual cells in a cross-tab, or select multiple cells in a cross-tab, to format and re-size them.

Text Formatting

To complement the enhancements in the Crystal Report Designer on line spacing, character spacing, text rotation and indentation for text objects and string field objects, the Report Designer Component runtime has also been enhanced in the following ways.

In the ITextObject interface for text objects, and the IFieldObject interface for string field objects, these properties and methods have been added:

· CharacterSpacing (read / write)

· LineSpacing (read)

· LineSpacingType (read)

· SetLineSpacing (method)

· TextRotationAngle (read / write)

· FirstLineIndent (read / write) - when reading , this method gets first line indent of the first paragraph; when writing, it sets first line indent for all the paragraphs.

· LeftIndent (read / write) - when reading , this method gets the left indent of the first paragraph; when writing, it sets the left indent for all the paragraphs.

· RightIndent (read / write)- when reading , this method gets the right indent of the first paragraph; when writing, it sets the right indent for all the paragraphs.

· TextFormat (read / write) – for text objects only.

For more information of these text formatting features in the Crystal Report Designer, please refer to the sections “Text Rotation”, “Line Indentation” and “Line and Character Spacing” above.

Tool Bars

As in the Crystal Report Designer, tool bars now have an updated, flattened look, and can be moved. And, in particular to the Report Designer Component, the tool bars can also be re-sized to customize to your needs.

Web Support

You may now access the Seagate Software Web page through the Report Designer Component for online registration and support, product news and updates, among other things. You can do so by right-clicking anywhere in the design view, and choose Help | Seagate Software on the Web.

For more information on the newly available Web links in the Crystal Report Designer, please refer to the section “Seagate Software Community on the Web” above.

WYSIWYG Support

Previously, printing text objects and field objects with text (e.g., string and memo fields)  always had non-WYSIWYG results. Now, these objects are printed with close to WYSIWYG quality. For more information on WYSIWYG support in the Crystal Report Designer, please refer to the section “WYSIWYG vs non- WYSIWYG Output” above.

Those enhancements that correspond with Seagate Crystal Report 7 or earlier enhancements include:

ADO Record Set

Two new methods have been added under the IDatabase interface:

· AddADOCommand (connection, command), and

· AddOLEDBSource (connection, tableName).

You may now use these methods to add an ADO table and OLEDB table respectively.

AddADOCommand also allows you to pass an ADO record set, then save and refresh the report properly.

Creating Chart Based on a Cross-tab

You may now create a chart based on a cross-tab object. The method AddGraphObject has been added one more parameter, pCrossTabObject. pCrossTabObject is optional, is a VARIANT type, and has to be a ICrossTabObject. (For crGroupGraph and crDetailGraph, this parameter is ignored.)

Exporting to Excel 7.0 and 8.0 Formats

You may now export to Excel 7.0, 7.0 Extended, 8.0 and 8.0 Extended formats from the Report Designer Component in runtime.

Now, under the IExportOptions interface, there are the new formats of:

· crEFTExcel70, 

· crEFTExcel70Tabular, 

· crEFTExcel80, and 

· crEFTExcel80Tabular. 

As well, there are these new Excel format option properties:

· ExcelTabHasColumnHeadings,

· ExcelUseWorksheetFunctions,

· ExcelConstantColumnWidth,

· ExcelAreaType,

· ExcelAreaGroupNumber, and

· ExcelUseTabularFormat.

OLAP Grid Formatting

You may now import a report with an OLAP grid, select the grid and format it. When you right-click on the grid, you can select from the shortcut menu Cut, Copy, or Format, which invokes the Format Editor with the Common and Border tabs.

Printer Setup Dialog

The Report Designer Component runtime has been enhanced with a new Printer Setup Dialog. Under the IReport interface, you can use the new method PrinterSetup.

Search Expert Support

You can now use search by formula in the Report Designer Component runtime. There is now a new method Search in the ICrystalReportSourceEx interface.
Select Expert Support for the Crystal Report Viewer

The Report Designer Component runtime now supports the end user using the Select Expert in the Crystal Report Viewer.

Selecting & Editing Embedded Fields

You may now embed a field within another, select the embedded field and edit it as if it was not embedded.

Setting Printer Duplex and Paper Source

At runtime, you may set the printer duplex and paper source for the current report. There are two new properties that can be set and retrieved: PrinterDuplex and PaperSource.
Tool Tips

There are now tool tips for objects in the design view, displaying the type, object name, field name wherever applicable.

Appendix A: Seagate Crystal Reports 8 Formula Language 

Introduction

This document compares the new Basic Syntax in Seagate Crystal Reports 8 with Crystal Syntax, lists the new features supported by Basic Syntax, and the new functions, operators and control structures added to both Basic and Crystal syntaxes.

For more detailed information on the Formula Language, please refer to the Seagate Crystal Reports 8 Online Help.

What is Basic Syntax?

Basic Syntax is similar to Visual Basic Script. It is an alternative syntax for the Formula Language in Seagate Crystal Reports 8. One of its purposes is to enhance the ease of use of the Formula Language - it allows new users familiar with Visual Basic to quickly learn and write formulas for their reports in Seagate Crystal Reports 8. 

New VB-like functions, operators and control structures have been added to both Crystal and Basic syntaxes to produce more robust and powerful formulas. Users familiar with Crystal Syntax may continue to use Crystal Syntax to benefit from these enhancements, or may choose to create new formulas in Basic Syntax. A report running in Seagate Crystal Reports 8 can use formulas written in Crystal Syntax and formulas written in the new Basic Syntax. 

Using Basic Syntax does not incur any degradation in compiling or processing time, nor does it require any additional library.

How does Basic Syntax Differ from Crystal Syntax?

	Comments

	Basic Syntax
	Crystal Syntax

	Comments begin with Rem or an apostrophe (“’”). 
	Comments begin with “//”.

	Since a comment beginning with Rem is a statement, it must either start in a new line, or be separated from the previous statement on the same line by a colon (“:”).

Comments beginning with an apostrophe may start anywhere in a line. For example:

x=1  ‘This comment is fine.

x=1  Rem This comment has an error.

x=1: Rem This would be fine.
	May begin anywhere in a line.

	Can use a line continuation character (“_”) within comment to carry on to next line.
	A comment in each line must begin with “//”.

	Line continuation

	Basic Syntax
	Crystal Syntax

	Consecutive statements can be separated by a colon, or implicitly separated by a line break.
	Consecutive statements must be separated by a semicolon (“;”).

	All statements except multi-line statements  continuing into the following line requires a line continuation character. Multi-line statements include the Do-While-Loop, Do-Until-Loop, Do-Loop-While, Do-Loop-Until, multi-line If-EndIf, Select-End Select and While-Wend.  
	A statement may take up more than one line without any line continuation character.

	Value returned from a formula

	Basic Syntax
	Crystal Syntax

	Statement-oriented. Value returned by a Basic Syntax formula is the value of the special variable, Formula. It is set in the formula, and can be set multiple times in a single formula. It should not be declared by the user.

Note that it is legitimate to have a Basic syntax formula that has Formula assigned in some but not all circumstances. Typically, in this type of formulas, you would be more interested in the side-effects such as maintaining global variables shared among formulas, than the value returned in Formula.
	Expression-oriented. The result of the final statement is the result that is returned.

	Variables

	Basic Syntax
	Crystal Syntax

	Variables must be declared before use, but type does not have to be given at declaration. In such a case, type is implied when variable is eventually assigned.
	Variables must be declared before use, and type must be specified at declaration.

	Types are same as in Crystal Syntax, but type names are similar to VB: Boolean, Number (or Double), Currency, Date, Time, DateTime, String.
	Same types as in Basic Syntax. Type names are: BooleanVar, NumberVar, CurrencyVar, DateVar, TimeVar, DateTimeVar, StringVar.

	There are range and array variables as well.
	Range and array variables are supported.

	Variable names may not exceed 254 characters, and may not have the same name as an operator, built-in function or reserved word.
	(Same as in Basic Syntax.)

	Scope is indicated by Local (or Dim), Global or Shared.
	Scope is Local, Global or Shared. If no scope is specified, Global is assumed.

	Variables of the same scope can be declared in the same statement, separated by comma.
	Each variable must be declared within its own expression.

	Global or Shared variables declared with the same name in two or more formulas are shared by these formulas. Such variables must have the same type. Setting the value to this kind of variable in one formula is reflected in the other formulas as well.
	(Same as in Basic Syntax.)

	Declaration is similar to VB. For example:

Dim x As Number

Global y As String

Global z As DateTime Range
	Declaration examples:

Local NumberVar x; 

Global StringVar y; 

Global DateTimeVar range z;

	Variables cannot be initialized at declaration.
	Variables (including array variables) can be initialized at declaration.

	Assignment is by ‘=’.
	Assignment and initialization is by ‘:=’.

	Keyword Let is optional in assignment. 

e.g., Let x=10
	No keyword as Let.

	Arrays are created using the Array function or simply the round brackets. Array indexing uses round brackets. For example:  

Dim x ()

x = Array (1,2,3)    ‘Create x by calling _

                                         'Array 

Dim y() as Number ‘Create y without _

                                        'specifying size

y = x (1)             ‘This specifies y as _

                                'an array of 1 element _

                                'whose value is x(1)

Formula = y(1)


	Array declaration and indexing use square brackets. 

e.g., NumberVar array x := [1,2,3];

	Range can be an element in an array. For example:

Dim w() As String Range

w = Array (“a” To “b”, _

           “c” To “d”, _

           “d” To “z”)
	A range can be used as an element or part of an element in an array.

	Constants

	Basic Syntax
	Crystal Syntax

	A variety of new constants have been introduced in both Basic and Crystal syntaxes.

These constants are displayed according to the context without the prefix "cr" in the functions tree. When inserted, these new constants begin with the prefix “cr”.

They include:

For formatting paragraph using a formula:

crUninterpretedText

crRTFText

crHTMLText
For formatting dates using a formula:

crDayOfWeekNotEnclosed

crDayOfWeekInParentheses

crDayOfWeekInFWParentheses

crDayOfWeekInSquareBrackets

crDayOfWeekInFWSquareBrackets
For formatting fonts using a formula:

crRegular

crBold

crItalic

crBoldItalic
These constants are available when you are conditionally formatting the font style of a database field, under the new “Font Styles” group in the Functions tree.

As date constants: 

crUseSystem

crSunday

crMonday

crTuesday

crWednesday

crThursday

crFriday

crSaturday

crFirstJan1

crFirstFourDays

crFirstFullWeek
As a math. constant:

crPi

When you are conditionally formatting the font of a database field, you may now use font constants that represent the fonts available to you, e.g., Arial, Courier. These font names are available in the function tree under “Font Names”.


	(Same as in Basic Syntax.)

	All constants begin with “cr” to identify them as constants.
	Constants in Crystal syntax that have existed in earlier versions of Seagate Crystal Reports are still supported in the same form, but a new form is also added with “cr” pre-pended to the old form. For example, Red and construed are now both supported. You are encouraged to use the new form in new formulas.

	Strings

	Basic Syntax
	Crystal Syntax

	Strings are indexed from 1, as in Crystal Syntax.
	(Same as in Basic Syntax.)

	String constants are delimited by double quotes.
	A string constant is delimited by a pair of single quotes (‘) or a pair of double quotes (“). Using the delimiting character within a string constant is supported by having it doubled.

	More on ranges

	Basic Syntax
	Crystal Syntax

	A range can be applied to a string constant. e.g., “hello” (4 to 5) returns “lo”
	Similar to Basic Syntax. 

e.g., “hello” [4 to 5] returns “lo”

	When using a range to index a string constant, negative numbers can also be used. 

e.g.,  “abcdef” (-3 to -1) returns “def”
	Similar to Basic Syntax. 

e.g.,  “abcdef” (-3 to -1) returns “def”

	More on arrays

	Basic Syntax
	Crystal Syntax

	Unlike VB, and resembling more Crystal Syntax, arrays are indexed from 1.
	Arrays are indexed from 1.

	When declaring an array variable, size and type are not necessary. However, if size of array is provided at declaration, then type must be given as well.
	When declaring an array variable, must specify type, and also, either initialize array or specify size of array.

	All array elements must be of the same type or of compatible types that can be coerced to the same type. For example:

x = Array (10, CCur("$20"), 30) can be coerced to an array of currencies ($10, $20, $30) (but not vice versa).

y = Array (10, 20, 30 to 40) can be coerced to an array of ranges (10 to 10, 20 to 20, 30 to 40).

z = Array (#1999-8-6#, _ #12:12:14PM#) can be coerced to an array of date-time type.
	(Same as in Basic Syntax.)

	An array is limited to 1000 elements.
	(Same as in Basic Syntax.)

	Each element in a string array is <= 254 characters.
	(Same as in Basic Syntax.)

	Unlike Visual Basic, only one-dimensional arrays are supported in Basic syntax.
	(Same as in Basic Syntax.)

	Fields

	Basic Syntax
	Crystal Syntax

	As in Crystal Syntax, fields must be enclosed in French brackets {}. Enter the table name to identify the database table, followed by a period, then enter the field name within that table. e.g., {customer.REGION}
	(Same as in Basic Syntax.)

	If statement

	Basic Syntax
	Crystal Syntax

	The beginning and end of an if statement have to be explicitly defined in both types of if statement, a single line if and a multi-line if. (See below.)
	Like other statements, an if statement can span across more than one line. The beginning and end of an if statement is implied by the syntax. (See below.)

	A single line if must either start and end on the same line, or use the line continuation character before each line break. Multiple statements in the then or else clause can be separated by a colon. e.g., 

1. If x=”a” Then Formula=10
2. If x=”a” Then z=10 : y=2 Else y=4 

3. If x=”a” Then _

        Formula=10 _

    Else _

        Formula=20


	There is no distinction between if statements taking up one line and those taking up more lines. However, multiple statements in the then or else statements have to be grouped by parentheses. e.g., 

If x=”a” then

    y=2

else (y=3;

         z=0)

	A multi-line if is one that takes up more than one line. An End If is necessary to mark the end of a multi-line if statement. e.g., 

If x=”a” Then

   y=2

   Formula=10

ElseIf x=”b” Then

          Formula=20

ElseIf x=”c” Then

          Formula=30

Else

          Formula=40

End If
	Nested if statement(s) is allowed in the then and else clauses. e.g.,

if x=”a” then

   (y=2;

    z=1)

else if x=”b” then

           y=3

else if x=”c” then

           y=4

else (y=5;

         z=0)

	A formula formed by an if statement sets the special variable Formula. e.g., 

If x=”a” Then _

   y=2 : Formula=10 _

Else _

   z=true : Formula=20
	The if statement is an expression and thus has a return type. Furthermore, the type returned in the then and else clause, if there is an else clause, have to be the same. e.g., 

if x=”a” then

   (y=2;

    0)

else

    (z=true;

     0)

	Function calling

	Basic Syntax
	Crystal Syntax

	A function can be called in an expression or as a statement by itself. e.g., 

1. x = Abs(y)

2. WhilePrintingRecords
	(Same as in Basic Syntax.)

	A function is called by naming it, and enclosing necessary arguments in round brackets. Alternatively, the keyword Call can be used. e.g., Call Average ({order.AMOUNT})
	A function is called by naming it, and enclosing necessary arguments in round brackets. e.g., 

Average ({order.AMOUNT})

	


New Functions

The following are new functions added to both Basic and Crystal syntaxes unless where indicated.

	Financial

Functions
	These functions work like the corresponding functions in VB and Excel. Where the two versions differ, VB is followed. (Further description can be found in the VB and Excel documentation.

	
	DDB
	DDB (cost, salvage, life, period[, factor])
Depreciation of an asset

Returns a Number specifying the depreciation of an asset for a specific time period, using the double-declining balance method or some other method as specified.

cost Number that specifies initial cost of the asset, >= 0, >= salvage.

salvage Number that specifies value of the asset at the end of its useful life, >= 0.

life Number that specifies length of useful life of the asset, >0.

period Number that specifies period for which asset depreciation is calculated, >0, <= life.

factor Optional number that specifies rate at which the balance declines. If omitted, 2 (double-declining method) is assumed. The value is >0, <= life.



	
	FV
	FV (rate, nPeriods, payment[, presentValue[, 

       type]])
Future value of an annuity

Returns a Number specifying the future value of an annuity based on periodic, fixed payments and a fixed interest rate.

rate Number that specifies interest rate per period. 

nPeriods Number that specifies the total number of payment periods in the annuity, >0. 

payment Number that specifies payment to be made each period. 

presentValue Optional Number that specifies present value (or lump sum) of a series of future payments. 

type Optional Number that specifies when payments are due. Specify 0 if payments are due at the end of the payment period, and 1 if payments are due at the beginning of the period. If omitted, 0 is assumed.



	
	IPmt
	IPmt (rate, per, nPeriods, presentValue[,

          futureValue[, type]])
Interest payments

Returns a Number specifying the interest payment for a given period of an annuity based on periodic, fixed payments and a fixed interest rate.

rate Number that specifies the interest rate per period. 

per Number that specifies the payment period in the range 1 through nPeriods. 

nPeriods Number that specifies the total number of payment periods in the annuity, >0. 

presentValue Number that specifies the present value, or value today, of a series of future payments or receipts. 

futureValue Optional Number that specifies the future value or cash balance you want after you've made the final payment. If omitted, 0 is assumed. 

type Optional Number that specifies when payments are due. Specify 0 if payments are due at the end of the payment period, and 1 if payments are due at the beginning of the period. If omitted, 0 is assumed.



	
	IRR
	IRR (values[, guess])
Internal rate of return

Returns a Number specifying the internal rate of return for a series of periodic cash flows (payments and receipts).

values Number type array that specifies cash flow values. The array must contain at least one negative value (a payment) and one positive value (a receipt). 

guess Optional Number value that is estimated to be returned by IRR. If omitted, guess is 0.1 (10 percent).



	
	MIRR
	MIRR (values, financeRate, reinvestRate)
Modified internal rate of return

Returns a Number specifying the modified internal rate of return for a series of periodic cash flows (payments and receipts).

values Number type array that specifies cash flow values. The array must contain at least one negative value (a payment) and one positive value (a receipt). 

financeRate Number that specifies the interest rate paid as the cost of financing. 

reinvestRate Number that specifies the interest rate received on gains from cash reinvestment.



	
	NPer
	NPer (rate, payment, presentValue[, futureValue[,

           type]])
Number of periods for an annuity

Returns a Number specifying the number of periods for an annuity based on periodic, fixed payments and a fixed interest rate.

rate Number that specifies the interest rate per period.  

payment Number that specifies the payment to be made each period. Payments usually contain principal and interest that doesn't change over the life of the annuity. 

presentValue Number that specifies the present value, or value today, of a series of future payments or receipts. 

futureValue Optional Number that specifies the future value or cash balance you want after you've made the final payment. If omitted, 0 is assumed. 

type Optional Number that specifies when payments are due. Specify 0 if payments are due at the end of the payment period, and 1 if payments are due at the beginning of the period.  If omitted, 0 is assumed.



	
	NPV
	NPV (rate, values)
Net present value

Returns a Number specifying the net present value of an investment based on a series of periodic cash flows (payments and receipts) and a discount rate.

rate Number that specifies the discount rate over the length of the period, expressed as a decimal. 

values Number type array that specifies cash flow values. It must contain at least one negative value (a payment) and one positive value (a receipt).



	
	Pmt
	Pmt (rate, nPeriods, presentValue[, futureValue[, 

         type]])
Payment for an annuity

Returns a Number specifying the payment for an annuity based on periodic, fixed payments and a fixed interest rate.

rate Number that specifies the interest rate per period. 

nPeriods Number that specifies the total number of payment periods in the annuity, >0. 

presentValue Number that specifies the present value (or lump sum) that a series of payments to be paid in the future is worth now. 

futureValue Optional Number that specifies the future value or cash balance you want after you've made the final payment. If omitted, 0 is assumed. 

type Optional Number that specifies when payments are due. Specify 0 if payments are due at the end of the payment period, and 1 if payments are due at the beginning of the period. If omitted, 0 is assumed.



	
	PPmt
	PPmt (rate, period, nPeriods, presentValue[, 

            futureValue[, type]])
Principal payment for an annuity

Returns a Number specifying the principal payment for a given period of an annuity based on periodic, fixed payments and a fixed interest rate.

rate Number that specifies the interest rate per period. 

period Number that specifies the payment period in the range 1 through nPeriods. 

nPeriods Number that specifies the total number of payment periods in the annuity, >0. 

presentValue Number that specifies the present value, or value today, of a series of future payments or receipts. 

futureValue Optional Number that specifies the future value or cash balance you want after you've made the final payment. If omitted, 0 is assumed. 

type Optional Number that specifies when payments are due. Specify 0 if payments are due at the end of the payment period, and 1 if payments are due at the beginning of the period. If omitted, 0 is assumed.



	
	PV
	PV (rate, nPeriods, payment[, futureValue[, 

       type]])
Present value

Returns a Number specifying the present value of an annuity based on periodic, fixed payments to be paid in the future and a fixed interest rate.

rate Number that specifies the interest rate per period. 

nPeriods Number that specifies the total number of payment periods in the annuity, >0. 

payment Number that specifies payment to be made each period.

futureValue Optional Number that specifies the future value or cash balance you want after you've made the final payment. If omitted, 0 is assumed. 

type Optional Number that specifies when payments are due. Specify 0 if payments are due at the end of the payment period, and 1 if payments are due at the beginning of the period. If omitted, 0 is assumed.



	
	Rate
	Rate (nPeriods, payment, presentValue[, 

          futureValue[, type[, guess]]])
Interest rate

Returns a Number specifying the interest rate per period for an annuity.

nPeriods Number that specifies the total number of payment periods in the annuity, >0. 

payment Number that specifies payment to be made each period.

presentValue Number that specifies the present value, or value today, of a series of future payments or receipts.

futureValue Optional Number that specifies the future value or cash balance you want after you've made the final payment. If omitted, 0 is assumed.

type Optional Number that specifies when payments are due. Specify 0 if payments are due at the end of the payment period, and 1 if payments are due at the beginning of the period. If omitted, 0 is assumed.

guess Optional Number value that is estimated to be returned by Rate. If omitted, guess is 0.1 (10 percent).



	
	SLN
	SLN (cost, salvage, life[, period] )
Straight line depreciation

Returns a Number specifying the straight-line depreciation of an asset for a single period.

cost Number that specifies the initial cost of the asset.

salvage Number that specifies the value of the asset at the end of its useful life. 

life Number that specifies the length of the useful life of the asset, not equal to 0.

period Number that specifies period for which the straight-line depreciation of an asset is calculated, <= life.



	
	SYD
	SYD (cost, salvage, life[, period])
Sum of years depreciation

Returns a Number specifying the sum-of-years' digits depreciation of an asset for a single period.

cost Number that specifies the initial cost of the asset.

salvage Number that specifies the value of the asset at the end of its useful life. 

life Number that specifies the length of the useful life of the asset, >0.

period Number that specifies the period for which asset depreciation is calculated, > 0, <= life.



	Math

Functions
	All of these, except for Pi, are taken from and behave as the corresponding functions in VB. 

	
	Atn
	Atn (number)

Returns a Number specifying the arctangent of a given number.

	
	Cos
	Cos (number)
Returns a Number specifying the cosine of an angle given in radians.

	
	Exp
	Exp (number)

Returns a Number specifying e (the base of natural logarithms) raised to a power.

	
	Fix
	Fix (number[, #places])

Truncates a number to the specified number of decimals. If #places is omitted, 0 is assumed.

	
	Int
	Int (number)
Returns the integer portion of a given number.

	
	Log
	Log (number)
Returns a Number specifying the natural log of a given number.

	
	Pi
	Pi

Returns the value of pi. (This constant is displayed as crPi in the Formula Editor.)

	
	Rnd
	Rnd [(number)]

Returns a random number, where the number argument is optional

	
	Sin
	Sin (number)
Returns a Number specifying the sine of an angle given in radians.

	
	Sgn
	Sgn (number)
Returns 1, 0 or -1indicating the sign of a given number.

	
	Sqr
	Sqr (number)

Returns a number specifying the square root of a given number.

	
	Tan
	Tan (number)
Returns a Number specifying the tangent of an angle given in radians.



	Program

Shortcut

Functions
	These functions are similar to the  corresponding functions in VB.

	
	Choose
	Choose (index, choice1[, choice2, ... [, choiceN]])
Returns a value from the list of choices based on the value of index. 

index Number that specifies the n-th choice to be chosen. It should be between 1 and the number of available choices. If it is out of bounds, Choose returns a default value. (The default value returned depends on the type of the choices. If choices are of Number type, the default value is 0. If choices are of String type, the default value is the empty string (””). If choices are of DateTime type, the default value is the Null date-time.
choice One of the choices to choose from. All choices must be of the same type or compatible types. A choice can be a range, but it may not be an array.

	
	IIF
	IIf (expression, truePart, falsePart)
Returns one of two parts, depending on the evaluation of the expression. As IIf always evaluates both truePart and falsePart before returning the result, you should watch for undesirable side effects. 

expession Expression you want to evaluate. 

truePart Value or expression returned if expression is True.

falsePart Value or expression returned if expression is False.

For example, you can insert a formula field that represents the order amount if the payment

has been made already, and is 0 otherwise.

Formula = IIF ( _

{Orders.Payment Received}, _ {Orders.Order Amount}, 0)



	
	Switch
	Switch (expr1, value1[, expr2, value2 … [, exprN,

              valueN]])
The argument list for Switch consists of pairs of expressions and values. The expressions are evaluated from left to right, and the value associated with the first expression to evaluate to True is returned. However, Switch evaluates all the expressions, even though it returns the value associated with the first expression that returns True. For this reason, be aware of possible side effects resulting from evaluating all the expressions in the argument list. Switch returns a default value if none of the expressions is True.

expr Expression to evaluate. 

value Value or expression to be returned if the corresponding expression is True.



	Type Conversion

Functions
	 

	
	CBool
	CBool (numeric)

Returns True if argument is positive or negative but not 0; returns False if argument is 0. Argument can be a Number or a Currency value.



	
	CCur
	CCur (numeric or string)

Converts and returns a Currency value given a Number, Currency or String.

Note that this function does not format the returned Currency field. if you insert directly into a report the value returned from this function, the formatting specifications for that formula field may insert the currency symbol, thousands separator, decimal separator and decimal places such that the value may appear formatted.



	
	CDbl
	CDbl (numeric or string)

Converts and returns a number given a Number, Currency or String.

Note that this function does not format the returned Number field. If you insert directly into a report the value returned from this function, the formatting specifications for that formula field may insert the thousands separator, decimal separator and decimal places such that the value may appear formatted.



	
	CStr
	CStr (x[, y[, z[, w[, q]]]]) 

Same as the ToText function in the Crystal syntax (as well as the Basic syntax). For more information on ToText, please refer to the Online Help.



	
	CDate
	CDate is synonymous with the function DateValue and Crystal function Date. It can take up different argument lists:

CDate (number) 

Converts and returns a Date given a number which is the number of days starting from December 30, 1899. Number can be positive or negative, and truncated if fractional.

CDate (string) 

Converts and returns a Date given a string; many formats are supported for the string.

CDate (dateTime)

Converts and returns a Date given a DateTime value.

CDate (YYYY, MM, DD)

Uses the given arguments to create a Date value. All arguments are of type Number.



	
	CDateTime
	CDateTime is synonymous with the function DateTimeValue and the Crystal function DateTime. It can take up different argument lists:

CDateTime (string) where string holds a date time value; many formats allowed.

CDateTime (number) where number holds the number of days since Dec. 30, 1899; can be negative or fractional. Assigns 12:00:00 AM to the time portion if number is whole.

For example, CDateTime (12.5) returns the DateTime value January 11, 12:00:00 pm., and CDateTime (-2.5) returns the DateTime value December 27, 1899, 12:00:00 pm.

CDateTime (date) uses the given date to create the date portion, assigns 12:00:00 AM for the time portion for the returned DateTime value.

CDateTime (date, time) uses the given date and time data types to create a combined DateTime value.

CDateTime (YYYY, MM, DD) uses the given arguments to create the date portion, and assigns 12:00:00 AM for the time portion for the returned DateTime value. All arguments are of type Number.

CDateTime (YYYY, MM, DD, HH, MM, SS) uses the given arguments to create a combined DateTime value. All arguments are of type Number.



	
	CTime
	CTime is synonymous with the function TimeValue and the Crystal function Time. It can take up the following argument lists:

CTime (number)

The given number is in units of 24 hours, and can be negative as well. For example, CTime (.2) and CTime (1.2) return the same value 4:48:00 am, and CTime (-.2) returns 7:12:00 pm.

CTime (string) 

Converts and returns a Time given a string that identifies a time value from 0:00:00 (12:00:00 A.M.) to 23:59:59 (11:59:59 P.M.), inclusive.

CTime (dateTime)

Converts and returns a Time given a DateTime value. 

CTime (HH, MM, SS)

Converts and returns a Time given the arguments of the hour, minute and seconds in type Number.



	Date and Time

Functions
	These functions are similar to the corresponding functions in VB. Please refer to the Microsoft VB documentation for a more detailed description.

	
	DateAdd
	DateAdd (intervalType, nIntervals, 

                 startDateTime)

Returns a DateTime value to which a specified number of time intervals have been added.

intervalType String expression specifying the interval of time to be added. Values can be:

  yyyy                        Year

  q                             Quarter (3-month period)

  m                            Month

  y                              Day of year

  d                              Day

  w                             Weekday

  ww                          Week (7-day period)

  h                             Hour

  n                             Minute

  s                              Second

nIntervals Number or numeric expression specifying the number of intervals to be added. It can be positive (to get dates in the future) or negative (to get dates in the past).

startDateTime Date value to which the interval is to be added.

e.g., DateAdd (“m”, 1, _

             DateValue(“01/31/96”)) 

    returns the date value “02/29/96”.



	
	DateDiff
	DateDiff (intervalType, startDateTime,

                endDateTime[, firstDayOfWeek])
Returns a number of time intervals between two specified dates.

intervalType String expression that is the interval of time you use to calculate the difference between startDateTime and endDateTime. Possible values can be:

  yyyy                       Year

  q                            Quarter 

  m                           Month

  y                             Day of year

  d                             Day (“y” and “d” both find the

                                          difference in days)

  w                            Number of weeks between 

                                 startDateTime and 

                                 endDateTime

  ww                          Number of firstDayOfWeek’s 

                                  between startDateTime and 

                                  endDateTime

  h                             Hour

  n                             Minute

  s                              Second

startDateTime First Date value to be used in calculating the difference.

endDateTime Second Date value to be used in calculating the difference.

firstDayOfWeek Optional constant to specify the first day of the week. If not specified, Sunday is assumed. Please refer to the “First Day of Week Constants” below for more information.

e.g., DateDiff (“w”, _

              DateValue(“13-6-99”), _ 

              DateValue (“30-6-99”), _

              Monday) returns 2.

Note that startDateTime and endDateTime are first rounded down to the form (year, quarter) and then the difference is taken. Thus, DateDiff ("q", #3/31/1999#, #4/1/1999#) = 1 and DateDiff ("q", #1/1/1999#, #3/31/1999#) = 0. The first 2 dates are in different quarters even though they are only 1 day apart whereas the second 2 dates are in the same quarter even though they are almost 3 months apart.



	
	DatePart
	DatePart (intervalType, inputDateTime[, 

                 firstDayOfWeek[, firstWeekOfYear]])

Returns a Number that specifies a given part of a given date.

intervalType String expression that specifies the part of a date to be returned. Possible values can be:

  yyyy                      Extracts the year

  q                           Quarter (the result is 1, 2, 3 or 4)

  m                          Month (the result is from 1 to 12)

  y                            Day of year (1 to 365 or 366 in 

                                                     leap year)

  d                            Day part of the date (1 to 31)

  w                           Day of week (1 to 7 depending 

                                                  on firstDayOfWeek)

  ww                         Week of year (1 to 53 with         

                                     firstDayOfWeek and 

                                     firstWeekOfYear  

                                     determining the exact days

                                     of the first calendar week of 

                                     the year)

  h                             Extracts the hour part of given 

                                     DateTime (0 to 23)

  n                             Minute part (0 to 59)

  s                              Second part (0 to 59)

inputDateTime DateTime value to be evaluated.

firstDayOfWeek Optional constant to specify the first day of the week. If not specified, Sunday is assumed. Please refer to the “First Day of Week Constants” below for more information.

firstWeekOfYear Optional constant to specify the first week of the year. If not specified, the first week is assumed to be the one in which Jan. 1 occurs. Please refer to the “First Week of Year Constants” below for more information.

e.g., DatePart (“d”, _

              CDateTime(“15-6-99”)) 

        returns 15.



	
	DateTimeValue
	DateTimeValue is synonymous with the function cDateTime and the Crystal function DateTime. It can take up different argument lists:

DateTimeValue (number)

Returns a DateTime value given a number that specifies the number of days from December 30, 1899. Number can be negative and fractional. Assigns 12:00:00 AM for the time portion if number is integral.

DateTimeValue (string)

Returns a DateTime value given a string that specifies a date and time; various formats of the string supported.

e.g., DateTimeValue (“01/02/99 12:12pm”) interprets the given string according to the order for month, day, and year specified in the Short Date format for the system (e.g., in Regional Settings for Windows NT), and returns a DateTime value in the same Short Date format.

DateTimeValue (date, time)

Returns a DateTime value given a date and a time value.

DateTimeValue (date)

Returns a DateTime value given a date value, assigning 12:00:00 AM for the time portion for the returned DateTime value.

DateTimeValue (YYYY, MM, DD)

Returns a DateTime value given numeric arguments for the year, month and day. Assigns 12:00:00 AM for the time portion for the returned DateTime value.

DateTimeValue (YYYY, MM, DD, HH, MM, SS)

Returns a DateTime value given numeric arguments for the year, month, day, hour, minute and second.



	
	DateSerial
	DateSerial (year, month, day)

Returns a Date value for the specified year, month and date, expressed as Number values or numeric expressions.

For example, DateSerial (1999, 6, 15) and DateSerial (1999, 12 - 6, 30 -15) both specify the same date of June 15, 1999.

As another example, a formula giving the date of the last day of the month for the date field {Orders.Order Date}, can be stated as follows.

Notice the use of the line continuation character (space underscore) to continue the statement

over several lines.

formula = DateSerial ( _

    Year ({Orders.Order Date}), _

    Month ({Orders.Order Date}) + 1, _

    1 - 1)



	
	DateValue
	DateValue is synonymous with the function cDate and the Crystal function Date. It takes up different argument lists:

DateValue (string)

Returns a Date value given a string that represents a date from January 1, 100 through December 30, 9999.

e.g., DateValue (“Dec 31, 1999”) returns the date value for Dec. 31, 1999.

DateValue (number)

Returns a date value given a number of days starting from December 30, 1899. Number can be positive or negative, and truncated if fractional.

DateValue (dateTime)

Returns the date portion of a given DateTime value.

DateValue (YYYY, MM, DD)

Returns a date value given numeric arguments of the year, month and day.



	
	DayOfWeek
	DayOfWeek (date, firstDayOfWeek)

This is a new overload for the existing function DayOfWeek. It returns a Number constant indicating the day of the week, given a date and the first day of the week that you are assuming. Please refer to the “First Day of Week Constants” below for more information.

For example, since Sept. 20, 1999 is a Monday, DayOfWeek (#9-22-1999#, crMonday) will return 3 whereas DayOfWeek (#9-22-1999#, crSunday) will return 4.



	
	IsDate
	IsDate (string or number)
Returns True if given string or number is a date expression or can be recognized as a valid date. Returns False otherwise. A valid date is any date between January 1, 100 through December 30, 9999.

If the given argument is a string, it can be of many forms as long as it can be recognized as a valid date. If the argument is a number, it can be positive, negative, or fractional, and is interpreted as a number of days since December 30, 1899.

For example, IsDate (“Jan. 1, 1999”) returns True.

As another example, IsDate (100) is True too since the number 100 is interpreted as 100 days from Dec. 30, 1899, which is April 9, 1900.



	
	IsDateTime
	IsDateTime (string or number)

Returns True if given string or number is a DateTime expression, or can be recognized as a DateTime value. Returns False otherwise.

If the given argument is a string, it can be of many forms as long as it can be recognized as a valid date. If the argument is a number, it can be positive, negative, or fractional, and is interpreted as a number of days since December 30, 1899.



	
	IsTime
	IsTime (string or number)

Returns True if given string or number is a Time expression, or can be recognized as a Time value. Returns False otherwise.

If the argument is a number, it can be positive, negative, or fractional. It is interpreted as units of 24 hours.



	
	MonthName
	MonthName (month[, abbreviate])

Returns a string name for the specified month.

e.g., MonthName (4) returns “April”

abbreviate Optional Boolean value that indicates if the weekday name is to be abbreviated. If omitted, the default is False.



	
	Timer
	Timer ()

Returns the number of seconds elapsed since midnight.



	
	TimeSerial
	TimeSerial (HH, MM, SS)

Returns a Time value specifying the time for a specific hour, minute and second.

HH Number or numeric expression of value between 0 (12:00 am) and 23 (11:00 pm) inclusive, specifying the hour.

MM Number or numeric expression of value specifying the number of minutes. 

SS Number or numeric expression of value specifying the number of seconds.

e.g., TimeSerial (3, 45, 0) and TimeSerial (12 - 8, -15, 0) both return the same time 3:45:00 am.



	
	TimeValue
	TimeValue is synonymous with the function CTime and the Crystal function Time. It can take up the following argument lists:

TimeValue (number)

The given number is in units of 24 hours, and can be negative as well. For example, TimeValue (.2) and TimeValue (1.2) return the same value 4:48:00 am, and TimeValue (-.2) returns 7:12:00 pm.

TimeValue (string)

Returns a Time value that represents the time, given a string expression specifying a time from 0:00:00 (12:00:00 A.M.) to 23:59:59 (11:59:59 P.M.), inclusive.

e.g., TimeValue(“1:30pm”),

    TimeValue(“13:30”) 

TimeValue (dateTime)

Returns the time portion of a given DateTime value. 

TimeValue (HH, MM, SS)

Returns a time value given numeric arguments of the hour, minute and seconds.



	
	WeekDay
	WeekDay (date[, firstDayOfWeek])

Returns the nth day of the week given a Date or DateTime value. Optionally you may specify the day for the first day of the week. If not specified, Sunday is assumed.

date Date or DateTime value for which a numeric designation for the day of the week is to be returned.

firstDayOfWeek Optional Number indicating the first day of the week. Please refer to the “First Day of Week Constants” below for more information.



	
	WeekdayName
	WeekdayName (weekday[, abbreviate[, 

                            firstDayOfWeek]])
Returns a String indicating the specified day of the week.

weekday The numeric designation for the day of the week. Numeric value of each day depends on setting of the firstDayOfWeek setting.

abbreviate Optional Boolean value that indicates if the weekday name is to be abbreviated. If omitted, the default is False.

firstDayOfWeek Optional Number indicating the first day of the week. Please refer to the “First Day of Week Constants” below for more information.

e.g., WeekdayName (3, Monday) returns 

        “Wednesday”.



	
	There are also constants which can be used as parameters in some of the functions above. They are similar to the VB constants which are named with the prefix “vb”. They are listed under “First Day of Week Constants” in the Functions tree in the Formula Editor, without the prefix "cr". In the Formula Editor, they are displayed with the prefix.

	
	crSunday
	1

	
	crMonday
	2

	
	crTuesday
	3

	
	crWednesday
	4

	
	crThursday
	5

	
	crFriday
	6

	
	crSaturday
	7

	
	crUseSystem
	0 (implying NLS API setting)

	
	There are also constants which can be used as parameters in some of the functions above. They are similar to the VB constants which are named with the prefix “vb”. They are listed under “First Week of Year Constants” in the Functions tree in the Formula Editor, without the prefix "cr". They are displayed with the prefix in the Formula Editor.

	
	crFirstJan1
	1

	
	crFirstFourDays
	2

	
	crFirstFullWeek
	3

	
	crUseSystem
	0 (implying NLS API setting)

	Array & String

Functions
	 These functions are similar to the corresponding functions in VB. Please refer to the Microsoft VB documentation for a more detailed description

	
	Array
	Array (x,…)

Returns an array of values. The argument list is a comma-delimited list of values that are assigned to the elements of the array. The maximum number of elements is 1000. Unlike VB, you may not have 0 number of elements.

This is a Basic syntax function only as Array is a keyword in Crystal syntax.

Refer to the section “More on Arrays” above for more information on the possible types of array elements.



	
	Filter
	Filter (inputStrings, searchString[, include[,

           compare]])

Searches an array of strings for a specified string, and returns the string as an array.

inputStrings Array of strings to be searched.

searchString String to search for.

include Optional. Boolean value indicating whether to return substrings that include or exclude match. If include is True, Filter returns the subset of the array that contains match as a substring. If include is False, Filter returns the subset of the array that does not contain match as a substring.
compare Optional. Numeric value indicating the kind of string comparison to use:

0 Performs a case-sensitive

                             comparison.

1 Performs a case-insensitive 

                             comparison.

If omitted, a case-sensitive comparison is performed.



	
	InStrRev
	InStrRev (inputString, findString[, 

                 startPosition[,compare]])

Returns the position of the first occurrence of one string within another, starting from the end of the string.

inputString String expression being searched.

findString String expression being searched for.

startPosition Optional. Numeric expression that sets the starting position for each search. If omitted, –1 is used, which means that the search begins at the last character position.

compare Optional. Numeric value indicating the kind of comparison to use when evaluating substrings:

 0                           Performs a case-sensitive

                             comparison.

 1                           Performs a case-insensitive 

                             comparison.

If omitted, a case-sensitive comparison is performed.



	
	IsNumeric
	IsNumeric (str)

Returns True if specified string is all numeric, False otherwise.



	
	Join
	Join (list[, delimiter])

Returns a String created by joining a number of substrings contained in an array.

list Array containing substrings to be joined.

delimiter Optional. String character used to separate the substrings in the returned string. If omitted, the space character (" ") is used. If delimiter is a zero-length string (""), all items in the list are concatenated with no delimiters.



	
	LCase
	LCase (str)

Converts the given string to all lower case and returns it.



	
	Len
	Len (str)

Returns a Number indicating the length of the given string.



	
	LTrim
	LTrim (str)

Removes all spaces stored to the left of the given string and returns it. This is typically used when the given string is a text field stored right-justified in the database.



	
	MakeArray
	MakeArray (x[, y…])

Creates an array, initializes it with the given array elements and returns it. The number of array elements can be any number between 1 and 1000.

The following example creates and initializes and array x with four numbers, 1, 10, 100, 1000: NumberVar Array x := MakeArray (1,10,

                     100, 1000);
This function is to be used in Crystal syntax. In Basic syntax, the function to use is Array.



	
	Replace
	Replace (inputString, findString, replaceString[, 

                startPosition[, count[, compare]]])

Returns a string in which a specified substring has been replaced with another substring a specified number of times.

inputString String containing substring to replace.
findString Substring being searched for.
replaceString Replacement substring.
startPosition Optional. Position within inputString where substring search is to begin. If omitted, 1 is assumed.
count Optional. Number of substring substitutions to perform. If omitted, the default value is –1, which means make all possible substitutions.
compare Optional. Numeric value indicating the kind of comparison to use when evaluating substrings:

 0                           Performs a case-sensitive

                             comparison.

 1                           Performs a case-insensitive 

                             comparison.

If omitted, a case-sensitive comparison is performed. 

Note that the returned value of the Replace function is a string, with substitutions made, that begins at the position specified by startPosition and concludes at the end of the inputString string. It is not a copy of the original string from start to finish.



	
	RTrim
	RTrim (str)

Removes all spaces to the right of the given string and returns it. This is typically used when the given string is a text field stored left-justified in the database.



	
	Split
	Split (inputString[, delimiter[, count[, compare]]])

Returns an array containing a specified number of substrings.

inputString String expression containing substrings and delimiters. If inputString is a zero-length string(""), Split returns an empty array, that is, an array with no elements and no data.
delimiter Optional. String character used to identify substring limits. If omitted, the space character (" ") is assumed to be the delimiter. If delimiter is a zero-length string, a single-element array containing the entire inputString string is returned.
count Optional. Number of substrings to be returned; –1 indicates that all substrings are returned.
compare Optional. Numeric value indicating the kind of comparison to use when evaluating substrings:

 0                           Performs a case-sensitive

                             comparison.

 1                           Performs a case-insensitive 

                             comparison.

If omitted, a case-sensitive comparison is performed.


	
	StrReverse
	StrReverse (inputString)

Returns a string in which the character order of a specified string is reversed. 

inputString String whose characters are to be reversed. If inputString is a zero-length string (""), a zero-length string is returned.



	
	UBound
	UBound (array)

Returns a Number containing the largest available subscript for the given array. Note that subscripts start at 1 for both Basic and Crystal syntax, and not 0 as in Visual Basic.

array Name of given array. (Note that unlike Visual Basic, only one-dimensional arrays are supported in Basic syntax.)



	
	UCase
	UCase (str)

Converts the given string to all upper case and returns it.



	Percentage Functions 


	These functions are intended to support the new Percentage Summary fields in Seagate Crystal Reports 8. They are not based on any Visual Basic functions.

Since they have the same overloads, only PercentOfSum is described in detail. The only difference is that for PercentOfSum, PercentOfAverage, PercentOfMaximum and PercentOfMinimum the argument "fld" has to be a number or currency field whereas for PercentOfCount and PercentOfDistinctCount, any Number, Currency, String, Boolean, Date, Time or DateTime field will work.

Like the old summary functions, the groupings supplied as arguments must actually exist in the report for the summary function call to succeed.



	
	PercentOfSum
	In the following argument lists for PercentOfSum, fld is a Number or Currency database or formula field that can be evaluated by the function.

condFld is a Date, time, DateTime or Boolean field used to group the values in fld by.

cond is a String indicating the condition of condFld that controls grouping. Valid strings for this argument depend on whether condFld contains Date, Time, DateTime or Boolean values. For more information on the valid strings for this argument, see Conditions for Summary Functions in Online Help.

innerCondFld is a field used to group the values in fld by.

innerCond is a String indicating the type of grouping for innerCondFld. You only specify this argument when innerCondFld is a Date, Time, DateTime or Boolean field. For more information on the valid strings for this argument, see Conditions for Summary Functions in Online Help.
outerCondFld is a field used to group the values in fld by.

outerCond is a String indicating the type of grouping for outerCondFld. You only specify this argument when outerCondFld is a Date, Time, DateTime or Boolean field. For more information on the valid strings for this argument, see Conditions for Summary Functions in Online Help.

PercentOfSum (fld, condFld)

This has the same effect as: 100 * Sum (fld, condFld) / Sum (fld). It expresses the sum of the values of the field fld for the group determined by condFld as a percentage of the grand total sum.

PercentOfSum (fld, condFld, cond)

Same effect as: 100 * Sum (fld, condFld, cond) / Sum (fld).

If the field determining the grouping, condFld, is a Date, Time, DateTime or Boolean field, cond expresses some additional information to precisely specify the grouping e.g. if condFld is a Date field, whether grouping is "daily" or "weekly" or "monthly" etc.

PercentOfSum (fld, innerCondFld, outerCondFld)

Same effect as: 100 * Sum (fld, innerCondFld) / Sum (fld, outerCondFld)

It expresses the sum of the values of the field fld for the group determined by innerCondFld as a percentage of the sum for the group determined by outerCondFld.

PercentOfSum (fld, innerCondFld, innerCond, outerCondFld)
Same effect as: 100 * Sum (fld, innerCondFld, innerCond) / Sum (fld, outerCondFld)

PercentOfSum (fld, innerCondFld, outerCondFld, outerCond)

Same effect as: 100 * Sum (fld, innerCondFld) / Sum (fld, outerCondFld, outerCond)

PercentOfSum (fld, innerCondFld, innerCond, outerCondFld, outerCond)

Same effect as: 100 * Sum (fld, innerCondFld, innerCond) / Sum (fld, outerCondFld, outerCond)



	
	 The other Percentage functions are:

	
	PercentOfAverage
	

	
	PercentOfCount
	

	
	PercentOfDistinctCount
	

	
	PercentOfMaximum
	

	
	PercentOfMinimum
	

	Misc.

Functions
	 The following is for Basic syntax only.

	
	NextValue 
	NextValue (fld)

Returns the next value of the specified field.

	
	PreviousValue
	PreviousValue (fld)

Returns the previous value of the specified field.

	
	
	

	
	
	

	
	
	


New Operators

The following are new operators added to both Basic and Crystal syntaxes unless where indicated.

	Operators
	 The following operators have been added to both syntaxes.

	
	&
	Concatenation. The operands may be strings, numbers, date, time, date-time or Boolean. When applied with two operands that are both strings, ‘&’ and ‘+’ are equivalent and will concatenate the strings.

	
	\
	Integer division.

	
	^
	Exponentiation.

	
	Eqv
	Performs a logical equivalence on two expressions.

	
	Imp
	Performs a logical implication on two expressions.

	
	Mod
	Performs a modulus of two numbers and returns only the remainder.

	
	Xor
	Performs a logical exclusion on two expressions.



	DateTime Literals
	 DateTime literals, as in Visual Basic, are in both syntaxes. 



	
	They cannot be split between lines. For example:

#January 1, 1999#, 

#1 Jan 1999 13:20:19#, 

#1/1/1999#, #10:20 AM# , etc.

DateTime literals always use the "system default locale settings" rather than settings from the locale of the particular computer SCR is running on. Thus, for instance:

In the French/France locale: CDateTime ("22 aout 1997") is #August 22, 1997# , and in the German/Germany locale: CDateTime ("1/11/1997") is #11/1/1997#.



	Array

Operators
	 The following are new array operators that have been added to both syntaxes:

	
	Redim
	This Visual Basic statement is available as an array operator to reallocate storage for an array. For example, in Crystal syntax:

StringVar array x := ["a", "bb", "ccc"];

Redim x [4];     // resize the array to size 4; 

                 // old values ignored.

x [4] := "dddd"; // now x[1], x[2] and x[3] 

                 // are undefined

Unlike Visual Basic, you may not have multiple arrays in one redim statement. Also, in Crystal syntax, you should use square brackets, instead of round brackets as in Basic syntax or in Visual Basic.



	
	Redim Preserve
	Similar to Redim, except that on changing the size of the array, you would like to preserve its contents. For example, in Crystal syntax:

StringVar array x := ["a", "bb", "ccc"];

Redim Preserve x [4];  // resize the array to

                       // size 4 while preserving 

                       // the old values.

x [4] := "dddd";   // now x is

                   // ["a", "bb", "ccc", "dddd"]


	Operators for Unbound Ranges
	 These operators have been added to Basic syntax to describe unbound ranges.

	
	Is >
	Equivalent to existing range operator upFrom_

	
	Is <
	Equivalent to existing range operator upTo_

	
	Is >=
	Equivalent to existing range operator upFrom

	
	Is <=
	Equivalent to existing range operator upTo

	
	 These operators have been added to both syntaxes.

	
	a _To b 
	Left end point excluded range

	
	a To_ b
	Right end point excluded range

	
	a _To_ b 
	Both end points excluded range

	


New Control Structures

Control structures that are very similar to the Visual Basic counterparts have been added to both syntaxes. 

Note that as a safety mechanism to prevent report processing from hanging due to an infinite loop, any one evaluation of a formula can have at most 30,000 loop condition evaluations per formula evaluation.

	‘For’ statement

	Basic Syntax
	Crystal Syntax

	An example in Basic syntax to illustrate:

Dim  i

formula = ""

For i = 0 To 10 Step 5

 formula = formula & ToText (i, 0)

Next i
· The result of this formula is "0510".

· The ‘i’ in Next i is optional.

· If the Step clause can be omitted, a step of 1 is then assumed.
	The same example in Crystal syntax:

NumberVar i;

StringVar x;

for i := 0 to 10 step 5 do
(

  x := x & ToText (i, 0); // the ; 

                     // is optional

);

x; // if this line is omitted, the

   // formula returns "true", the

   // value of the ‘for’ statement 

   // expression.



	Exit For can be used to break out of a ‘For’ loop. For example,

Dim  i

formula = ""

For i = 0 To 20 Step 5

formula = formula & ToText (i, 0)

If Len (formula) >= 5 Then Exit For
Next i

The result is "051015".


	Similarly, exit for can be used in the Crystal syntax.



	‘Do’ and ‘While’ statements

	Basic Syntax
	Crystal Syntax

	The various forms of ‘Do’ statements in Basic syntax are:

Do While .... Loop
Do Until ... Loop
Do ... Loop While
Do ... Loop Until
These can be exited using Exit Do.


	The Crystal syntax has:

while ... do
do .. while 

These can be exited using exit while.



	There is also a Visual Basic style ‘While’ loop:

While ... Wend 

which does not support an exit statement.


	

	‘Select’ statements

	Basic Syntax
	Crystal Syntax

	An example in Basic syntax to illustrate:

Rem Select nested within a Select

Select Case {movie.Nom}

   Case 1

       formula = "one"

   Case 2, 3, 4 To 10

    Select Case {Movie.Nom}

     Case 2, 4, 6, 8

      formula = "even from 2 to 8"

       Case 3, 5, 7, 9

        formula = "odd from 3 to 9"

         Case Else
            formula = "10"

    End Select


   Case Else

    formula = "greater than 10"

End Select
There can be nested Select’s.

Notice that the Basic syntax version does not use colons after the case labels or default. 


	The Crystal syntax ‘Case’ statement works similarly to the Crystal syntax ‘if’ in that it returns the value of the case that is selected.

// Assign a star rating to a movie 

// according to its number of Oscar

// nominations

select {movie.NOM}

   case 1, 2 to 3 :

      "*"

   case 3 to 6 :

      "**"

   case 7 :

      "***"

   default :

      "****";
There can be nested Select’s.

Notice that the Crystal syntax version uses colons after the case labels and after default. 



	The Case Else clause can be omitted, but you have to ensure that Formula is assigned in any case.


	If a default clause is omitted, an appropriate default value will be returned if the test expression does not match any of the case clauses (for example, for strings, the empty string is returned).



	Another example that conditionally formats the color of the current field according to the value of the field:

Select Case CurrentFieldValue

Case Is < 100

    formula = crRed

Case Is > 100, Is < 500

    formula = crYellow

Case Is > 500, Is < 1000

    formula = crGreen

Case Is > 1000, Is < 2000

    formula = crBlue

Case Else 

    formula = crBlack

End Select


	

	


Some Limits

Here are some of the limiting constants in the formula language:

· The maximum number of bytes in a string constant or string variable is 254.

· The maximum size of an array is 1000.

· The maximum number of arguments of a function is 1000.

· Functions derived from Visual Basic accept dates from year 100 to year 9999. Traditional Crystal syntax functions accept dates from year 1 to year 9999.

· The maximum number of loop condition evaluations per evaluation of a formula is 30,000 (see above for what this means precisely).

· Maximum length of a formula is 64K.

Optimization of Constant and ParameterSubexpressions in Formulas

Most constant and parameter subexpressions in formulas are now evaluated at formula compilation time rather than formula evaluation time. (‘Evaluation time’ refers to the stage where the formula engine resorts to the database.‘Compilation’ time thus refers to all other times other than evaluation time.)

Here are some examples written in Crystal syntax:

{?give me a number} + 1 // expression can involve parameter fields

Year ({?run date}) 
// a function applied to a parameter field

CurrentDate + 3 

// can involve functions without arguments

DateAdd (3, "m", CurrentDateTime) // functions with constant arguments

DateDiff ("q", CurrentDate, CDate ("Jan 1 1996")) 

"hello " & "bye" + " zap" 
// strings

true or false 


// booleans

["a", "b" to "c", "e"] 

// array creation

2 + $3 



// type coercions
The most important benefit of doing this is that more types of record selection formulas simplify enough so that they can be pushed down to the server. This can greatly increase the speed of report processing for data intensive reports. For example, now the following record selection formulas can be pushed down:

{date field} > CurrentDate - 3

{date field} in Date(Year ({?run date}), 6, 1) to Date (Year ({?run date}), 9, 30)

The second benefit is speeding up of formula evaluation, since constant expressions within a formula only need to be evaluated once.

Finally, more accurate error messages can be given in certain cases. This is because compile time errors can specify the location (or at least the general location) in the formula where the error occurs. Evaluation time errors can't specify this information since they work off byte code rather than the original text of the formula.

Note that a formula can contain several constant subexpressions:

NumberVar x;

x := {?Enter a Number} + 10;

StringVar y;

y := "Hello " & {?Enter a String} ;

x & y;

Then both subexpressions in red are simplified at compile time.

This change also works with Basic syntax formulas.

Finally, a limitation is that parameter fields are not simplified in subreports. Work is under progress though for parameter fields occurring in constant subexpressions in subreport record selection formulas to be simplified. 

Appendix B: Changes to Crystal Report Print Engine API (CRPE API)

New Error Codes

#define PE_ERR_NOTEXTERNALSUBREPORT         680 // subreport is not imported.

#define PE_ERR_INVALIDPARAMETERVALUE        687

#define PE_ERR_INVALIDFORMULASYNTAXTYPE     688 // specified formula syntax not 

 // in PE_FST_*

#define PE_ERR_INVALIDCROPVALUE             689

#define PE_ERR_INVALIDCOLLATIONVALUE        690

#define PE_ERR_STARTPAGEGREATERSTOPPAGE     691

#define PE_ERR_INVALIDEXPORTFORMAT
    692
Report Options

//Following are the valid values for promptMode

#define PE_RPTOPT_PROMPT_NONE 0

#define PE_RPTOPT_PROMPT_NORMAL 1

#define PE_RPTOPT_PROMPT_ALWAYS 2

typedef struct PEReportOptions

{

    WORD StructSize;  // initialize to PE_SIZEOF_REPORT_OPTIONS

    short saveDataWithReport;  // BOOL value, except use PE_UNCHANGED for no change

    short saveSummariesWithReport;  // BOOL value, except use PE_UNCHANGED for no change

    short useIndexForSpeed;    // BOOL value, except use PE_UNCHANGED for no change

    short translateDOSStrings; // BOOL value, except use PE_UNCHANGED for no change

    short translateDOSMemos;   // BOOL value, except use PE_UNCHANGED for no change

    short convertDateTimeType; // a PE_RPTOPT_ value, except use PE_UNCHANGED for no change

    short convertNullFieldToDefault; // BOOL value, except use PE_UNCHANGED for no change

    short morePrintEngineErrorMessages;// BOOL value, except use PE_UNCHANGED for no change

    short caseInsensitiveSQLData; // BOOL value, except use PE_UNCHANGED for no change

    short verifyOnEveryPrint;     // BOOL value, except use PE_UNCHAGED for no change

    short zoomMode;                //  a PE_ZOOM_ constant, except use PE_UNCHANGED for no change

    short hasGroupTree;           // BOOL value, except use PE_UNCHANGED for no change

    short dontGenerateDataForHiddenObjects; // BOOL value, except use PE_UNCHANGED for no change

    short performGroupingOnServer;           // BOOL value, except use PE_UNCHANGED for no change

    short doAsyncQuery; // BOOL value, except use PE_UNCHANGED for no change

    short promptMode; // PE_RPTOPT_PROMPT_NONE, PE_RPTOPT_PROMPT_NORMAL, 

//PE_RPTOPT_PROMPT_ALWAYS, PE_UNCHANGED       

    short selectDistinctRecords; // BOOL value, except use PE_UNCHANGED for no 

// change

}PEReportOptions;

#define PE_SIZEOF_REPORT_OPTIONS (sizeof(PEReportOptions))

BOOL CRPE_API PEGetReportOptions (short printJob,

                                  PEReportOptions FAR * reportOptions);

BOOL CRPE_API PESetReportOptions (short printJob,

                                  PEReportOptions FAR * reportOptions);

PEGroupOptions – new member variables

typedef struct PEGroupOptions

{

    WORD StructSize;

    // when setting, pass a PE_GC_ constant, or PE_UNCHANGED for no change.

    // when getting, use PE_GC_TYPEMASK and PE_GC_CONDITIONMASK to

    // decode the condition.

    short condition;

    char fieldName [PE_FIELD_NAME_LEN]; // formula form, or empty for no change.

    short sortDirection;                // a PE_SF_ const, or PE_UNCHANGED for no change.

    short repeatGroupHeader;            // BOOL value, or PE_UNCHANGED for no change.

    short keepGroupTogether;            // BOOL value, or PE_UNCHANGED for no change.

    short topOrBottomNGroups;           // a PE_GO_TBN_ constant, or PE_UNCHANGED for no change.

    char topOrBottomNSortFieldName [PE_FIELD_NAME_LEN]; // formula form, or empty for no change.

    short nTopOrBottomGroups;           // the number of groups to keep, 0 for all, or PE_UNCHANGED 

    short discardOtherGroups;           // BOOL value, or PE_UNCHANGED for no change.

    short   ignored;                    // for 4 byte alignment. Ignored.
    short   hierarchicalSorting;                  
// Boolean or PE_UNCHANGED

    char    instanceIDField [PE_FIELD_NAME_LEN];
// for hierarchical 

//grouping

    char    parentIDField [PE_FIELD_NAME_LEN];      
// for hierarchical 

//grouping

    long    groupIndent;                            
// twips
}

    PEGroupOptions;

#define PE_SIZEOF_GROUP_OPTIONS (sizeof (PEGroupOptions))

BOOL CRPE_API PEGetGroupOptions(short printJob,

                                short groupN,

                                PEGroupOptions FAR * groupOptions);

BOOL CRPE_API PESetGroupOptions(short printJob,

                                short groupN,

                                PEGroupOptions FAR * groupOptions);

PEGetNSectionsInArea – New Function Call

//Get number of sections

short CRPE_API PEGetNSections (short printJob); // return -1 if failed

short CRPE_API PEGetNSectionsInArea(short printJob, short areaCode); // return 

//-1 if failed

PESectionOptions - New Members

typedef struct PESectionOptions // For area options, too.

{

    WORD StructSize;            // initialize to PE_SIZEOF_SECTION_OPTIONS

    short visible,              // BOOL values, except use PE_UNCHANGED

          newPageBefore,        // to preserve the existing settings

          newPageAfter,

          keepTogether,

          suppressBlankSection,

          resetPageNAfter,

          printAtBottomOfPage;

    COLORREF backgroundColor;   // Use PE_UNCHANGED_COLOR to preserve the

                                // existing color. only for section format

    short underlaySection;      // BOOL values, except use PE_UNCHANGED

    short showArea;             // to preserve the existing settings

    short freeFormPlacement;

    short reserveMinimumPageFooter;   // choose the maximum visible page footer 

// section as reserve.

}PESectionOptions;

#define PE_SIZEOF_SECTION_OPTIONS (sizeof (PESectionOptions))

BOOL CRPE_API PESetSectionFormat (short printJob,

                                  short sectionCode,

                                  PESectionOptions FAR *options);

BOOL CRPE_API PEGetSectionFormat (short printJob,

                                  short sectionCode,

                                  PESectionOptions FAR *options);

PESubreportInfo – new options & members

// PE_SRI_ONOPENJOB: Reimport the subreport when opening the main report.

// PE_SRI_ONFUNCTIONCALL: Reimport the subreport when the api is called.

#define PE_SRI_UNDEFINED     -1

#define PE_SRI_ONOPENJOB      0

#define PE_SRI_ONFUNCTIONCALL 1

typedef struct PESubreportInfo

{

    WORD StructSize;            // Initialize to PE_SIZEOF_SUBREPORT_INFO.

    // Strings are null-terminated.

    char name [PE_SUBREPORT_NAME_LEN];

    // number of links

    short NLinks;

    // subreport placement.

    short isOnDemand;    // TRUE if the subreport is on-demand subreport.

    short external;         // 1: the subreport is imported; 0: otherwise.

    short reimportOption;   // PE_SRI_ONOPENJOB or PE_SRI_ONFUNCTIONCALL

}PESubreportInfo;

#define PE_SIZEOF_SUBREPORT_INFO (sizeof (PESubreportInfo))

BOOL CRPE_API PEGetSubreportInfo (short printJob,

                                  DWORD subreportHandle,

                                  PESubreportInfo FAR *subreportInfo);

BOOL CRPE_API PEReimportSubreport(short printJob,

                                  DWORD subreportHandle,

                                  BOOL FAR * linkChanged,






BOOL FAR * reimported);

PEFontColorInfo

typedef struct PEFontColorInfo

{

    WORD StructSize;

    char faceName[PE_FACE_NAME_LEN]; // empty string for no change

    short fontFamily; // FF_DONTCARE for no change

    short fontPitch;  // DEFAULT_PITCH for no change

    short charSet;   // DEFAULT_CHARSET for no change

    short pointSize;  // 0 for no change

    short isItalic;   // BOOL value, except use PE_UNCHANGED for no change.

    short isUnderlined; // BOOL value, except use PE_UNCHANGED for no change.

    short isStruckOut;  // BOOL value, except use PE_UNCHANGED for no change.

    short weight;       // 0 for no change

    COLORREF color;     // PE_UNCHANGED_COLOR for no change.

   short twipSize;    
// Font size in twips, 0 for no change.

                      
// Use one of pointSize or twipSize. If both 

// pointSize and twipSize

                        // are non-zero, twipSize will be used and 

//pointSize will be ignored.

}PEFontColorInfo;

#define PE_SIZEOF_FONT_COLOR_INFO (sizeof(PEFontColorInfo))
PEGet/SetGraphTextDefaultOption – New Calls

//enable/disable graph default titles

BOOL CRPE_API PESetGraphTextDefaultOption (short printJob,

                                    short sectionN, 

                                    short graphN, 

                                    WORD titleType,     //PE_GTT_*

                                    BOOL useDefault);

BOOL CRPE_API PEGetGraphTextDefaultOption (short printJob,

                                    short sectionN, 

                                    short graphN, 

                                    WORD titleType,     //PE_GTT_*

                                    BOOL FAR * useDefault);

PEGraphOptionInfo – Legend Layout Changes

//legend layout

#define PE_GLL_PERCENTAGE           0

#define PE_GLL_AMOUNT               1

#define PE_GLL_CUSTOM               2
// for PEGetGraphOptionInfo, 

// do not use                                      // in PESetGraphOptionInfo.

typedef struct PEGraphOptionInfo

{

    WORD StructSize;

    short graphColour; // PE_GCR_*, PE_UNCHANGED for no change

    short showLegend; //BOOL, PE_UNCHANGED for no change

    short legendPosition; //PE_GLP_*, if showLegend == 0, means no legend 

// pie charts and doughut charts

    short pieSize; // PE_GPS_*, PE_UNCHANGED for no change

    short detachedPieSlice; // PE_GDPS_*, PE_UNCHANGED for no change

// bar chart

    short barSize; // PE_GBS_*, PE_UNCHANGED for no change

    short verticalBars; //BOOL, PE_UNCHANGED for no change

// markers (used for line and bar charts)

    short markerSize; // PE_GMS_*, PE_UNCHANGED for no change

    short markerShape; // PE_GMSP_*, PE_UNCHANGED for no change

//data points

    short dataPoints; // PE_GDP_*, PE_UNCHANGED for no change    

    short dataValueNumberFormat; //PE_GNF_*, PE_UNCHANGED for no change

// 3d

    short viewingAngle; //PE_GVA_*, PE_UNCHANGED for no change

    short legendLayout;     //PE_GLL_*

} PEGraphOptionInfo;

PEGraphAxisInfo – Autoscale Options Added

typedef struct PEGraphAxisInfo

{

    WORD StructSize;

    short groupAxisGridLine; // PE_GGT_*, PE_UNCHANGED for no change

    short dataAxisYGridLine; // PE_GGT_*, PE_UNCHANGED for no change

    short dataAxisY2GridLine; // PE_GGT_*, PE_UNCHANGED for no change

    short seriesAxisGridline; // PE_GGT_*, PE_UNCHANGED for no change

    double dataAxisYMinValue;

    double dataAxisYMaxValue;

    double dataAxisY2MinValue;

    double dataAxisY2MaxValue;

    double seriesAxisMinValue;

    double seriesAxisMaxValue;

    short dataAxisYNumberFormat; //PE_GNF_*, PE_UNCHANGED for no change

    short dataAxisY2NumberFormat; //PE_GNF_*, PE_UNCHANGED for no change

    short seriesAxisNumberFormat; //PE_GNF_*, PE_UNCHANGED for no change

    short dataAxisYAutoRange; // BOOL, PE_UNCHANGED for no change

    short dataAxisY2AutoRange; //BOOL, PE_UNCHANGED for no change

    short seriesAxisAutoRange; //BOOL, PE_UNCHANGED for no change

    short dataAxisYAutomaticDivision; // PE_ADM_* or PE_UNCHANGED for no change

    short dataAxisY2AutomaticDivision; // PE_ADM_* or PE_UNCHANED for no change

    short seriesAxisAutomaticDivision; // PE_ADM_* or PE_UNCHANED for no change

    long dataAxisYManualDivision;  
//if dataAxisYAutomaticDivision is PE_ADM_AUTOMATIC,

//this field is ignored

    long dataAxisY2ManualDivision; 
//if dataAxisY2AutomaticDivision is 

//PE_ADM_AUTOMATIC, this field is ignored

    long seriesAxisManualDivision; 
//if seriesAxisAutomaticDivision is 

//PE_ADM_AUTOMATIC, this field is ignored

    short dataAxisYAutoScale;       //BOOL, PE_UNCHANGED for no change

    short dataAxisY2AutoScale;      //BOOL, PE_UNCHANGED for no change

    short seriesAxisAutoScale;      //BOOL, PE_UNCHANGED for no change

}  PEGraphAxisInfo;
Documentation Changes for Parameter Fields Calls

PEParameterFieldInfo

typedef struct PEParameterFieldInfo

{

    // Initialize to PE_SIZEOF_PARAMETER_FIELD_INFO.

    WORD StructSize;

    // PE_PF_ constant

    WORD ValueType;

    // Indicate the default value is set in PEParameterFieldInfo.

    WORD DefaultValueSet;

    // Indicate the current value is set in PEParameterFieldInfo.

    WORD CurrentValueSet;

    // All strings are null-terminated.

    char Name [PE_PF_NAME_LEN];

    char Prompt [PE_PF_PROMPT_LEN];

    // Could be Number, Currency, Boolean, Date, DateTime, Time, or String

    char DefaultValue [PE_PF_VALUE_LEN];

    char CurrentValue [PE_PF_VALUE_LEN];

    // name of report where the field belongs, only used in

    // PEGetNthParameterField and PENewParameterField

    char ReportName [PE_PF_REPORT_NAME_LEN];

    // returns false if parameter is linked, not in use, or has current value set

    WORD needsCurrentValue; 

    //for String values this will be TRUE if the string is limited on length, for 

    //other types it will be TRUE if the parameter is limited by a range

    WORD isLimited;

    //For string fields, these are the minimum/maximum length of the string.

    //For numeric fields, they are the minimum/maximum numeric value.

    //For other fields, use PEGetParameterMinMaxValue

    double MinSize;

    double MaxSize;

    //An edit mask that restricts what may be entered for string parameters.

    char EditMask [PE_PF_EDITMASK_LEN];

    //  return true if it is essbase sub var

    WORD isHidden;

}PEParameterFieldInfo;

PEGetNParameterDefaultValues

// If return value is -1 then an error has occurred.

short CRPE_API PEGetNParameterDefaultValues (short printJob, 

const char FAR * parameterFieldName, 

                              const char FAR * reportName);

PEGetNParameterCurrentValues

// If return value is -1 then an error has occurred.

short CRPE_API PEGetNParameterCurrentValues (short printJob, 

const char FAR * parameterFieldName, 

                                      const char FAR * reportName);

PEGetNParameterCurrentRanges

// If return value is -1 then an error has occurred.

short CRPE_API PEGetNParameterCurrentRanges (short printJob, 

const char FAR * parameterFieldName, 

                                      const char FAR * reportName);

Print Window Options

typedef struct PEWindowOptions

{

    WORD StructSize;                // initialize to PE_SIZEOF_WINDOW_OPTIONS

    short hasGroupTree;             // BOOL value, except use PE_UNCHANGED for no change

    short canDrillDown;             // BOOL value, except use PE_UNCHANGED for no change

    short hasNavigationControls;    // BOOL value, except use PE_UNCHANGED for no change

    short hasCancelButton;          // BOOL value, except use PE_UNCHANGED for no change

    short hasPrintButton;           // BOOL value, except use PE_UNCHANGED for no change

    short hasExportButton;          // BOOL value, except use PE_UNCHANGED for no change

    short hasZoomControl;           // BOOL value, except use PE_UNCHANGED for no change

    short hasCloseButton;           // BOOL value, except use PE_UNCHANGED for no change

    short hasProgressControls;      // BOOL value, except use PE_UNCHANGED for no change

    short hasSearchButton;          // BOOL value, except use PE_UNCHANGED for no change

    short hasPrintSetupButton;      // BOOL value, except use PE_UNCHANGED for no change

    short hasRefreshButton;         // BOOL value, except use PE_UNCHANGED for no change

    short showToolbarTips;          // BOOL value, except use PE_UNCHANGED for no change

                                    //      default is TRUE (*Show* tooltips on toolbar)

    short showDocumentTips;         // BOOL value, except use PE_UNCHANGED for no change

                                    // default is FALSE (*Hide* tooltips on document)

    short hasLaunchButton;      // Launch Seagate Analysis button on toolbar.

                                // BOOL value, except use PE_UNCHANGED for no 

                                // change; default is FALSE

} PEWindowOptions;

PEFreeDevMode – New Call for Printing

/********************************/

// Changing printer selection

/********************************/

// CRPE does not support unicode. For 32bit,

// Windows API has different DEVMODE structure definitions.

// If UNICODE is defined, DEVMODEA is used.

BOOL CRPE_API PESelectPrinter (short printJob,

                               const char FAR *driverName,

                               const char FAR *printerName,

                               const char FAR *portName,

#if defined (WIN32)

                               DEVMODEA FAR *mode

#else

                               DEVMODE FAR *mode

#endif

                               );

BOOL CRPE_API PEGetSelectedPrinter (short printJob,

                                    HANDLE  FAR *driverHandle,

                                    short   FAR *driverLength,

                                    HANDLE  FAR *printerHandle,

                                    short   FAR *printerLength,

                                    HANDLE  FAR *portHandle,

                                    short   FAR *portLength,

#if defined (WIN32)

                                    DEVMODEA FAR * FAR *mode

#else

                                    DEVMODE FAR * FAR *mode

#endif

                                    );

BOOL CRPE_API PEFreeDevMode (short printJob, DEVMODEA FAR * mode);

Report Summary Info

typedef struct PEReportSummaryInfo

{

    WORD StructSize;

    char applicationName[PE_SI_APPLICATION_NAME_LEN]; // read only.

    char title[PE_SI_TITLE_LEN];

    char subject[PE_SI_SUBJECT_LEN];

    char author[PE_SI_AUTHOR_LEN];

    char keywords[PE_SI_KEYWORDS_LEN];

    char comments[PE_SI_COMMENTS_LEN];

    char reportTemplate[PE_SI_REPORT_TEMPLATE_LEN];

    short savePreviewPicture; // BOOL PE_UNCHANGED for no change

} PEReportSummaryInfo;

#define PE_SIZEOF_REPORT_SUMMARY_INFO (sizeof(PEReportSummaryInfo))

BOOL CRPE_API PEGetReportSummaryInfo(short printJob, PEReportSummaryInfo FAR * summaryInfo);

BOOL CRPE_API PESetReportSummaryInfo(short printJob, PEReportSummaryInfo FAR * summaryInfo);

New Events – Hyperlink and Launch Seagate Analysis

#define PE_DRILL_ON_HYPERLINK_EVENT           27

#define PE_LAUNCH_SEAGATE_ANALYSIS_EVENT      28

typedef struct PEHyperlinkEventInfo

{

    WORD StructSize;

    WORD ignored;               // for 4 byte alignment. ignore.

    long windowHandle;          // HWND

    char FAR *hyperlinkText;    // points to the hyperlink text associated with 

     // the object.

                                // memory pointed by hyperlinkText is freed 

     // after calling the callback function.

} PEHyperlinkEventInfo;

#define PE_SIZEOF_HYPERLINK_EVENT_INFO (sizeof (PEHyperlinkEventInfo))

typedef struct PELaunchSeagateAnalysisEventInfo

{

    WORD StructSize;

    WORD ignored;               
// for 4 byte alignment. ignore.

    long windowHandle;          
// HWND

    char FAR *pathFile;        
// points to the path and filename of the 

// temporary report.

                                
// memory pointed by pathFile is freed after 

// calling the callback function.

} PELaunchSeagateAnalysisEventInfo;

// All events are disabled by default

// use PEEnableEvent to enable events.

typedef struct PEEnableEventInfo

{

    WORD StructSize;

    short startStopEvent; // BOOL value, PE_UNCHANGED for no change

    short readingRecordEvent; // BOOL value, PE_UNCHANGED for no change

    short printWindowButtonEvent; // BOOL value, PE_UNCHANGED for no change

    short drillEvent; // BOOL value, PE_UNCHANGED for no change

    short closePrintWindowEvent; // BOOL value, PE_UNCHANGED for no change

    short activatePrintWindowEvent; // BOOL value, PE_UNCHANGED for no change

    short fieldMappingEvent; // BOOL value, PE_UNCHANGED for no change.

    short mouseClickEvent; // BOOL value, PE_UNCHANGED for no change.

    short hyperlinkEvent;   // BOOL value, PE_UNCHANGED for no change.

    short launchSeagateAnalysisEvent;   // BOOL value, PE_UNCHANGED for no change.

} PEEnableEventInfo;

#define PE_SIZEOF_ENABLE_EVENT_INFO (sizeof(PEEnableEventInfo))

BOOL CRPE_API PEEnableEvent(short printJob, PEEnableEventInfo FAR * enableEventInfo);

BOOL CRPE_API PEGetEnableEventInfo(short printJob, 

PEEnableEventInfo FAR * enableEventInfo);

CRPE Preview Window Cursors 

// CRPE specific cusors

#define PE_TC_BACKGROUND_PROCESS_CURSOR 94

#define PE_TC_GRAB_HAND_CURSOR          95

#define PE_TC_ZOOM_IN_CURSOR            96

#define PE_TC_REPORT_SECTION_CURSOR     97

#define PE_TC_HAND_CURSOR               98

#define PE_TC_MAGNIFY_CURSOR            99

typedef struct PETrackCursorInfo

{

        WORD StructSize;

        short groupAreaCursor; 
// a PE_TC constant. PE_UNCHANGED for no change.

        short groupAreaFieldCursor; 
// a PE_TC constant. PE_UNCHAGNED for no change.

        short detailAreaCursor;  
// a PE_TC constant. PE_UNCHANGED for no change

        short detailAreaFieldCursor; 
// a PE_TC constant. PE_UNCHANGED for no change

        short graphCursor;           
// a PE_TC constant. PE_UNCHANGED for no change.

        long groupAreaCursorHandle; 
// reserved

        long groupAreaFieldCursorHandle; // reserved

        long detailAreaCursorHandle;
// reserved

        long detailAreaFieldCursorHandle; // reserved

        long graphCursorHandle; // reserved

        short ondemandSubreportCursor;  // Cursor to show over on-demand 

// subreports when

                                        // drilldown for the window is enabled;

                                        // default is PE_TC_MAGNIFY_CURSOR.

        short hyperlinkCursor;          // Cursor to show over report object 

// that has hyperlink text;

                                        // default is PE_TC_HAND_CURSOR.

} PETrackCursorInfo;

#define PE_SIZEOF_TRACK_CURSOR_INFO  (sizeof(PETrackCursorInfo))

// set tracking cursor

BOOL CRPE_API PESetTrackCursorInfo(short printJob,

                                   PETrackCursorInfo FAR * cursorInfo);

BOOL CRPE_API PEGetTrackCursorInfo(short printJob,

                                   PETrackCursorInfo FAR * cursorInfo);

Formula Syntax – New Feature

//Formula Syntax

#define PE_FS_SIZE      2

#define PE_FST_CRYSTAL  0

#define PE_FST_BASIC    1

typedef struct PEFormulaSyntax

{

    WORD StructSize;

    short formulaSyntax [PE_FS_SIZE];           // PE_FST_* or PE_UNCHANGED.

} PEFormulaSyntax;

#define PE_SIZEOF_FORMULA_SYNTAX (sizeof (PEFormulaSyntax))

// PESetFormulaSyntax

// Use this API to set the syntax to use in the next (and all successive)

// formula API call(s).

// Set one of PE_FST_* into formulaSyntax[0];

// formulaSyntax[1] is reserved for internal use.

// ***Default Behaviour: If any Formula API is called before calling

//                       PESetFormulaSyntax then PE_FST_CRYSTAL is assumed.

BOOL CRPE_API PESetFormulaSyntax (short printJob, 

PEFormulaSyntax FAR *formulaSyntax);

// PEGetFormulaSyntax

// Indicates the syntax used by the formula addressed in the last formula API // call. 

// The syntax type is returned in formulaSyntax[0];

// formulaSyntax[1] is reserved for internal use.

// ***Default Behaviour: If this API is called before any Formula API is called

//                       then the values returned will be PE_UNCHANGED.

BOOL CRPE_API PEGetFormulaSyntax (short printJob, 

PEFormulaSyntax FAR *formulaSyntax);
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